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STEP Flatplanner

STEP Flatplanner helps companies make more educated product choices and produce 'intelligent catalogs' that
improve sales. The visual page briefing tools of Flatplanner replace 'lick and sticker' paper briefing.

Flatplanner includes tools that enable advanced collaboration, automation, and analysis, which make selecting
products for publications easier and more efficient.

In addition, Flatplanner provides a single interface for business users to plan, review, and analyze publications.
Creative users can access the publication plan from within Adobe InDesign by using the STEP Publisher plugins
("STEP’n’design'). Merchandisers can review and approve artwork at any time through STEP Flatplanner.

Note: Supported versions of Adobe InDesign are CC 2015 (CC11), CC 2017 (CC12),and CC 2018 (CC13).

Flatplanner License Requirements

To use the Flatplanner component, the STEP Publisher component is required in addition to STEP. Touse a
Flatplanner workflow, the STEP Workflow component is required. Other licenses may be required for specific
features.

Prerequisites

This documentation section / user guide assumes the following:

« That users have a working knowledge of STEP
« That users have a working knowledge of InDesign
« That publications have already been created in STEP

« That product templates and a publication template have been created in InDesign and assigned to the
relevant publications in STEP

The guide only contains information about STEP Flatplanner. For more information about STEP and publication
creation, see the Getting Started / User Guide documentation.

For more information about DTP integration, see the STEP Publisher / STEP'n'design documentation.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 8
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Overview of the Flatplanner User Interface

The Flatplanner consists of two main tabs: the Plan tab and the Publication Planner tab.

Plan Tab

The Plan tab is available when a publication, section, or spread is selected in the Tree.
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1. Publication hierarchy. Your starting point.

2. Basket and Flatplanner view. If you have selected your planned pages, you can choose between Basket and
Plan view and Plan view only. The Basket and Plan view is shown.

3. Plan tab. If you have selected a publication, section, or spread, you can select Plan view.

4a. Spreads displayed under Section are Planned Pages.

4b. Flatplanner. The Flatplanner is a visual-oriented page planning tool. When you drag a product from the

basket or Tree and drop it on a Flatplan in an area identified for products, it will be placed / added to the products in
that frame.

5b. Basket. In your Basket you can see your products and a thumbnail of each of your products.

5c. Financial Summary. You can also view data on the Financial Summary tab.

Publication Planner Tab

The Publication Planner tab is available when a publication or section is selected.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 10
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1. Publication Planner. The Publication Planner is a monitoring tool. Clicking the Publication Planner tab
instead of the Plan tab gives you a different view on the same Publication. You can see the name and page
numbers of the pages in the Section and the status of each page or Spread.

shown.

Assignee. The Assignee field displays a list of stakeholders that you can assign to the page.
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Status. You can follow the lifecycle of the page in the status column.

Thumbnail. When a page has been finalized in InDesign and saved back to STEP, a thumbnail of the page is
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Flatplanner Components

STEP Flatplanner consists of the following components:

« Publication Planner

« Flatplanner

Publication Planner

The Publication Planner allows you to plan the rough layout of a catalog in sections and spreads or individual
pages, and assign page templates that decide the overall layout.

You can assign owners to individual spreads or pages.

Flatplanner

The Flatplanner is a page planning and briefing tool that allows you to plan the position, size and layout of products
on pages. The Flatplanner consists of a basket area and a spread or page planning area.

Yous can pick product offers from a collection or from the tree and add them to the basket for a section or a spread.

Basket View

The basket provides decision support by displaying product attribute information. Filtering and sorting features
help you select the right products to be placed in a particular position on the page.

Collections are sometimes used to gather products that should be linked into a basket. Each publication can
include products from several collections.

Collection examples:

Collection Criteria

Acme Pens Spring Catalog | Include Products with Attribute “Brand Name” = “Acme”

Exclude uploaded file with Product IDs

Zeta Pens Spring Catalog | Include uploaded file with Product IDs

For more information about working with Collections, see the Collections topic within the User Guide / Getting
Started documentation.

Sticker Book View
Turn on sticker book view in the Flatplanner to show additional data about the product.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 12
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Use the sticker book view to further inspect if the right products have been selected and if they have been placed in
the right location on the page and allocated enough space.

Turn on page preview to view the product in a layout that corresponds to the selected product template. You can
also view it in a layout picked up from another catalog.

When the planned spread or page is completed, it can be forwarded to a DTP Designer who can adjust the layout
in InDesign.

The result of this can be saved back to STEP, and the mounted page can be viewed in the Flatplanner.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 13
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Publication Related Elements

The following is a list of the publication related elements in the STEP Flatplanner.

Publication Group

A publication group is a collection of different publications.

Publication

A publication is a collection of the different sections and commercial data lists. For more information about creating
a publication, see the Overview of Publication Maintenance section of the Getting Started / STEP User
Guide documentation.

Version

A publication version holds the different variants of the same publication. A publication can have a number of
different versions that each point to a commercial list, a context and a workspace.

This is useful, for example, if a publication is released in several languages. Then it is possible to create a version
for each language.

Section

A section is an object that is used to store actual (mounted) pages within the publication

Spread

A spread consists of two adjacent, facing pages in a publication with conjoined or connected content.

Basket

A basket is a container for temporarily storing and displaying products, classifications, and assets before they are
used on a planned page. Products, classifications, and assets can be retrieved from the STEP database or
collection lists and dragged into baskets that are tied to the publication, section, or an individual spread.
Alternately, objects can be imported into the basket by the import of a Flatplan Excel, Publication Excel,
STEPXML, or even a plain .txt file or .csv file.

For more information about collection lists, see the Collections section of the Getting Started / STEP User
Guide documentation.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 14
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Element Icon Status
Publication Group | &¢ Publication group folder
Publication Publication folder
& Commercial data folder (automatically generated when creating a publication)
& Commercial list
= Types of commercial lists that are not price
Section = Section folder
(2121 | Planned Pages (a Spread)
DTP Documents (including finalized pages that have been saved back to STEP)
B Finalized DTP page the has been saved back to STEP
Spread (251 | A spread
Basket Jie Thumb pin, locked position
= Thumb pin, unlocked position

© Stibo Systems - Confidential - STEP Trailblazer 8.3 15
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Using Templates With Flatplanner

To plan and design a catalog in STEP Flatplanner, you will use a publication template, page templates, and
product templates.

You can design page templates directly in STEP. However, before you start using Flatplanner, the publication
template and product template(s) must be created in InDesign and stored in STEP. For more information, see the
STEP'n'design User Guide.

The following is a brief description of the different types of templates.

Page Templates

A page template allows you to define the layout of a page such as defining where you are allowed to place a
product and the related product template. For more information, see the Creating Page Templates topic.

Product Templates

A product template enables you to mount fully formatted product presentations directly to the page. The product
template controls the following:

« Which attributes are part of the product presentation

« The formatting of the product presentation such as fonts, styles, and so on

« The position of the individual elements

Publication Templates

A publication template defines the document size and margins and contains information about static elements
such as page tabs. It also contains definitions of all paragraph and character styles to be used from the product
templates.

A publication template is used to create the PDF files of your pages, to create a preview of your pages, and it is
also used when mounting the pages in InDesign.

For more information about creating product templates and publication templates, see the following sections of the
STEP'n'design documentation:

« Publication Templates

o Product Templates

© Stibo Systems - Confidential - STEP Trailblazer 8.3 16



StiboSystems

Creating Page Templates

The Create Page Template wizard helps you create a page template with the measures you prefer.

« Tostartthe Create Page Template Wizard, right-click a Publication Group, and then select New Page
Template. The Create Page Template wizard appears.

The wizard walks you through four steps.

The Create Template Wizard

Step 1 - Set Page Template

On the first screen of the Create Template wizard, you specify the name of the template. Enter the ID and Name of
the new page template, and then click Next.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 17
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r Create Page Template — u

Steps Set Page Template Name

1. Set Page Template Name

2. Choose Publication Template to base on
3. Select Spread

4, Confirm Page Dimensions

ID: |NewTempIate| |

Mame; |NewTempIate |

Back Finish Cancel

Step 2 - Choose Publication Template

In the next step, you choose the publication template that you want to base the page template on. Expand the
Publication hierarchy to locate the preferred template. Alternatively, use search to find the preferred template.
Click Next.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 18
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r - 1
ﬁﬁeate Page Template - l

| |
Steps Choose Publication Template to base on

1, Set Page Template Mame m

2. Choose Publication Template to base on
3. Select Spread - Publications
4, Confirm Page Dimensions

——
[
—

@Dewls

[back ][ Next ][ Fneh || concd ]

Step 3 - Select Spread

On this screen, you select the relevant spread in the publication template, from which you want to inherit the page
size and margins. A thumbnail of each available spreads is displayed. Click Next.
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-
Create Page Template - u
Steps Select Spread
1. Set Page Template Mame Spread number = |Thumbnail Page ™ | Thumbnail Page >
2. Choose Publication Template to base on
3. Select Spread
4, Confirm Page Dimensions
1
|
2
!
|
I
[ Back ][ Next ][ Finish ][ Cancel ]

Step 4 - Confirm Page Dimensions

The final step of the Create Template wizard provides an overview of the page size and margins of the new page
template. You can change any of the measures.

Click Finish to create the new page template. The new page template is placed in the Tree below the publication
group you initially selected.
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-

Create Page Template — ﬁ
Steps Confirm Page Dimensions
1. Set Page Template Mame Name ~| yalue -
2. Choose Publication Template to baseon |y 3.27 inches
3. Select Spread . Height 11.69 inches
4. Confirm Page Dimensions Left Inside Margin 0.98 inches
Left Qutside Margin 0,98 inches
Left Top Margin 0,59 inches
Left Bottom Margin 0.67 inches
Right Inside Margin 0.98 inches
Right Qutside Margin 0,98 inches
Right Top Margin 0,59 inches
Right Bottom Margin 0.67 inches

text | | Fnish || Cancel |

ke L

Note: You can change the margins of the page template later, but you cannot change the page size of the page

template once the page template has been created.

© Stibo Systems - Confidential - STEP Trailblazer 8.3

21



StiboSystems

Designing Frames for Page Templates

Frames are used to place product presentations and images in Flatplanner. You use the Designer tool bar on the
Designer tab to add and position frames on the page template.

Designer Toolbar

To access the Designer toolbar, click a page template in the Tree, and then click the Designer tab.

i e o] Description

Used to save all changes

Save

E Used to select and move frames and content on the page by dragging them.

Select

E Used to add new frames by clicking and dragging the mouse.

Add frame

s Used to delete a frame. Delete is only enabled when one or more frames are selected.
Delete

B

Used to insert multiple frames in a grid on the page.

Insert frames on

agrid

© Used to undo your last action.
Undo

=T Used to redo your last action.
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Tool Description

Redo
Tl Used to enable or disable snapping of frames when they are moved or re-sized.
Snap positioning
toggle button
¥ Poss Shows the horizontal position of a selected frame. If more frames are selected, the
horizontal position is only displayed if it is the same for all selected frames.
XPos To change the horizontal position of a frame, enter a new value in the X position field.
¥ Pos: Shows the vertical position of a selected frame. If more frames are selected, the vertical
position is only displayed if it is the same for all selected frames.
Y Pos To change the vertical position of a frame, enter a new value in the Y position field.
Width: Shows the width of a selected frame. If more frames are selected, the width is only
displayed if it is the same for all selected frames.
Width To change the width of a frame, enter a new value in the Height field.
Height: Shows the height of a selected frame. If more frames are selected, the height is only
displayed if it is the same for all selected frames.
Height To change the height of a frame, enter a new value in the Height field.
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Working with Frames in Page Templates

To Add a Frame

« Toadd aframe to a page, select the Add Frame tool in the tool bar. Drag an outline of the frame with the
cursor while holding down the left mouse button, and then release the mouse button.

To Insert Frames on a Grid

1. To quickly create many frames in a grid, select a page, then click Insert frames on a Grid in the tool bar. A
dialog box appears:

Inthe Across field, enter the number of rows of frames you want to be inserted.
In the Down field, enter the number of columns of frames you want to be inserted.
In the Vertical Gap field, enter the distance between the rows of frames.

In the Horizontal Gap field, enter the distance between the columns of frames.

o g k& w N

Click Enter. The frame grid is inserted on the selected page.

To Select Frames

« To select aframe, click the Select tool in the tool bar and click a frame.

« To select multiple frames click the frames while holding down the shift key.

To Delete Frames
« Todelete aframe, select the frame with the Select tool and then click the Delete frame button in the tool
bar. You can also select multiple frames and delete these frames the same way.
To Move Frames

« Tomove a frame, choose the Select tool in the tool bar, and then drag and drop the frame. You can also set
the X and Y position of one or more selected frames by entering a new value in the X Position field and Y
Position field.

To Resize Frames

» Toresize aframe, choose the Select tool in the tool bar, select the frame, and then drag the handles on the
frame border. Alternatively, enter a new value for one or more selected frames in the Width and Height
fields in the tool bar.

To Enable Snap Positioning

When you move frames on the page using drag and drop, it can be useful to enable Snap Positioning. This makes
the moved frame snap to a position when you release the mouse button. This way you can easily place frames in
the same X and Y positions on the page. The snap positions are :
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« Margin borders: Upper and right hand side border

« Frame borders: All borders

Note: Only the upper frame border and the left hand frame border of the frame that is being moved snaps.

To Change the Order of Frames
Frames are placed on the page in a specific order relative to each other. Adding a new frame places that frame on
top of other frames. This is only noticeable if frames overlap each other.

If you want to change the ordering of frame layers, right-click the frame, select Layers, and select one of the four
options:

« Bring to front: Brings the selected frame to front.

« Send to back: Sends the selected frame to the back.

» Bring forward: Brings the selected frame one level forward.

« Send backward: Sends the selected frame one level backward.

Note: Moving a frame from one page to another brings the frame layer to a front position.

To Change Frame Properties
To view and maintain details of a frame, select the frame, right-click and select Frame Properties. A dialog box
appears with the following options.

« Frame ID: Editable field that shows the ID of the selected frame.

« X Position: Editable field that shows the horizontal position of the selected frame.

« Y Position: Editable field that shows the vertical position of the selected frame.

« Width: Editable field that shows the width of the selected frame.

« Height: Editable field that shows the height of the selected frame.

« Layer: Editable list that defines the frames order relative to other frames on the page. '0' means that the
frame is in the back.

To View Frame IDs

Each frame on a page template has an ID.

« Toview the ID of the frames on a page, right-click the page and select Show Frame IDs. A small box
containing the IDs appears in all the frames on the spread.

To Change Frame IDs

« Tochange the ID of a frame, right-click the frame and select Frame Properties. A dialog box appears
where you can change the ID.
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To Change Margins

« Tochange the margins of a page template, right-click the white area on the page and select Margins. A
dialog box appears where you can set the margins. You can choose if the changes should apply to the whole
spread or only to the selected page.

« Toapply the changes to the selected page, click Left if you have selected a left-hand page or Right if you
have selected a right-hand page.. To apply the changes to both the left-hand and the right-hand page, click
Spread.

If you want to enter the same values for Top/Bottom/ Inside/Outside margins,make sure the padlock button is
enabled (locked).

To Zoom In and Out

« Tozoomiin, right-click the page and select Zoom In.

« Tozoom out, right-click the page and select Zoom Out.

To Copy and Paste Pages
Itis possible to copy and paste a page including frames:

1. Right-click the page you want to copy and select Copy Page.
2. Right-click the page you want to paste the copied page to and select Paste Page.

The copied page including frames is pasted.

Note: A warning appears if you try to paste a left-hand page to a right-hand page and vice versa.
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Creating Page Templates in InDesign

This section describes how to create a page template in InDesign, apply layout styles to a page, and how to store
the page template locally and/or in STEP. Page templates are only used in conjunction with STEP Flatplanner.

A page template allows you to define the layout style of a page. It defines:

« Where you are allowed to place a product with its product template.
« How many products you are allowed to place.

« Where you can place images.

o Where you can place free text.

Though it is strongly recommended to create page templates directly in the Page Template Designer tool in the
STEP Workbench, there are certain exceptions where the page template must be created in InDesign:

« Galley page templates must be created in InDesign

« Page templates where styling is needed in the Flatplanner frames must be created in InDesign, though this
is uncommon. Typically, all styling is handled on product templates and publication templates / mounting
pages.

« Layouts where Flatplanner frames must be very precisely aligned against each other with no or extremely
little space in between (also uncommon, but may be helpful for layouts such as coupon flyers). Using
InDesign to create these types of page templates will give a more precise level of control over frame
alignment than what is available in the Flatplanner.

Note: Before you can use InDesign-created page templates with STEP Flatplanner, the templates must first be
saved back to STEP and assigned to a publication.

Creating a Page Template in InDesign

To create a page template in InDesign:

1. Create a new InDesign document that has the same page size and margins as the publication template being
used in the publication. This document must be a two-page spread with facing pages.

2. Navigate to STEP > Template Type and choose Page Template.
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Applying Frames to the Page Template

To complete the page template, frames must be added to it. Frames are added from the STEP Template Frame
palette.

1. Openthe STEP Template Frame palette by navigating to Window > STEP Template Frame.

2. Draw either a text frame using the Type tool (T) or an image frame using the Rectangle Frame tool (F).

3. With the frame selected, choose the desired frame type from the Frame Type dropdown list. The following
screenshots show the available options for image frames (L) and text frames (R).

¢ STEP Template Frame ¢ STEP Template Frame E

Frame Type |Product K2 Frame Type |Galley Key Latter |v][1 ]
Frame D | | [ Frame ID | |

Context | | v]

Asset Content | | v]

Asset Sizing |Scale Asset to Frame |v]

Maxscse [ |+
(] Size Frame to Asset
Asset Alignment |Left | v]
Page Template Page Template

4. Repeat step 2 - 3 for each element you want to allow on the pages in your publication.

When the pages with the different frame types are viewed in the Flatplanner Plan view, each frame type is
represented by a colored square. For more information about the Flatplanner and the colored squares, see STEP
Flatplanner User Guide.
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For more detailed information about the different frame types, see the Galley Templates section of the
Flatplanner documentation.

Storing the Page Template

Once you have created a page template, it must be saved to STEP in order to use it in conjunction with
Flatplanner, as well as to make it available to other STEP users.

To store the template in STEP:

1. Save the InDesign document on your local hard drive as a standard InDesign file (suffix .indd).
2. Inthe STEP menu, click 'Save Document to DB.' A Save Document to STEP Database dialog box appears.

Save Document to STEP Database

Structure Point

k[ lUNSPSCi4C
b [ JUNSPSCIF
b [ |UNSPSC1E
b [TEntity Root
» ) Gosn
b ) GOSN Receiver
» ) GDSN Receiver Root
2 _fIPruru:ﬁms
- apuhidims
- @TE‘I‘FHE
¥ B publicabon Temphies
2 @MU&TE‘I‘FHE
3 @Page Templates
| 3 @ﬂanda-d Publications
bk ﬁmuﬁge Publications
3 @Flaiph'lna' Publications
bk ﬁwd:umuhicaﬁmwps
3 @Tarpwd:umubsmﬁms I

|Save As Page Template ||

[l Close document and delete local copy

| Ok | | cancel |

3. Select the publication group you want to save the document to, then select Save as Page Template from the
dropdown list.

4. Click OK.
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Galley Templates

The 'galley' format is a common layout style for retail catalogs. Galley layouts incorporate the use of Key Letters,
which connect product images with the text that describes the product. To build a Galley Page layout in STEP,
Galley Page Templates are used in conjunction with Galley Product Templates. Both types of Galley Templates
are supported by Flatplanner publications only.

The following is an example of a Galley Page created from STEP. Notice how images are separate from the text,
which appears at either the bottom or the side of the page. Each image is identified by a Key Letter (A, B, C, etc.)
that correlates it to the corresponding text across the bottom or the side of the page.
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Galley Page Templates

Unlike standard page templates, which are typically created in the workbench, Galley page templates are created
in InDesign.

Galley page templates use key letters, which must be designated in the page template in InDesign.

The following types of frames are used in Galley page templates:

1. Galley key letter
2. Image frame
3. Galley text frames

Optionally, Galley page templates can also contain the following additional frame types:

« Textframes containing attribute references
» Standalone image frames that are not connected with key letters

« Standalone product frames that are not connected with key letters and can be linked to non-Galley product
templates

For more information on these optional frame configurations, see the Advanced Galley Page Template Frame
Options section of the Galley Templates documentation.
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Grouping and Configuration of Key Letters and Image Frames

Galley page templates typically use three types of frames: image, Galley key letter, and Galley text.

Image Frames

Image frames should be configured in the STEP Template Palette to call out an image reference type. This is
nearly identical to product template functionality. A frame type is not assigned to the image frame. (The only time a
frame needs to be designated as an 'image' is if an image asset will be dragged directly into that square in the
Flatplan.) Best practice for images on Galley pages is to only use one image per reference type. Note that Frame
IDs are automatically generated, as they must always be unique.

[ 'n! 1 ﬂ'ﬂ’ﬁ % STEP Template Palette | STEF|

rimaryProductimage Iy
Template Type  Page Template

[» £ Atibute Groups
= [£] Reference Types
= [£2] Asset References
[ Elf/ BrandNamelogo
E../ Tlhestration

E/Ir'stalla‘ﬁonl'ﬂamal

E/Dwnaﬁl'ﬂamal

[
[+
[ S«'MsDS
[+
b
[+

E/Prcdx:r.lmage
[ E/'u"lden
[+ 5] Product References

[ == T S o

[] Keep With Next

Contest:

Frame Type:

Pn@r}ﬁk’roductlmage Frame ID | B477-1

Galley Key Letter Frames

The Galley key letter frame should be a standard text box with the letter / number manually entered inside. This
frame must be designated as a Galley Key Letter. The number indicates the order in which products should
appear on the page. For this example, box A will be 1, box B will be 2, and so forth.
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% STEP Template Palette

Template Type  Page Template -

| =3
[ £03 Attribute Groups -
= [ Referance Types
7 (25) Asset References
[» & BrandNamelogo
[» & Ihstration
[» & InstallztionManuzl
[» §MsDS
[
I

rimaryFroductlmage riiry

m

5" OwnersManuzl
[» & Productimage \\
[ B Video
[» £5) Product References
[ = T o
[ Keep With Mest
Context! -
Frame Type:  Galley Key Letter 4 u

| w—:. |

The image and Galley key letter frame must next be grouped together. A frame type does not need to be assigned
to the grouped frames.

% STEP Template Palette

Template Type  Page Template -
| jE==N
[ 5] Artribute Groups -

[+ (2] Reference Types

[] Keep With Next
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Galley Text Frame

In this example, the text frame is a single text frame across the left-side of the page. It will be designated as a
Galley Text frame. Since text from all products will go into this single frame, it does not need a number
designation.

[ 3 Atribute Groups -
[+ ) Reference Types

71/ [] Keep With Next

& Context: -
Frame Type:  Galley Tet - |0

Frame Il | €552

AR

Saving the Galley Page Template to STEP

The Galley page template will be saved to STEP from within InDesign. It will be saved as a page template to a
publication group folder. See the Page Template section of the STEP'n'design documentation for more
information on saving page templates to STEP.
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[ ljSl.lppﬁElE
[+ [|Templstes
[+ []web Sites
= [Ell Publications
~ ﬁTempla‘lE
[» (& Publication Templates
[ B0 Product Templates
[» [0 Standand Publications
[ &0 Autopage Publications
[ ﬁ Flatplanner Publications
[ &0 webUIPublicationTypes
[» [l TempWebUIPublications
[+ [T Primany Product Hierarchy

m

1

Save As Page Template -

[ Close document and delete local copy

| oK | | Cancel |
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Galley product templates differ from standard product templates in that image frames are not included on Galley
product templates. Images for Galley pages are handled by Galley page templates instead.

Key Letter and attribute (i.e., textual) content is all that appears in Galley product templates. All content is placed

inside a single text frame.

To add the Key Letter tag to the product template, navigate to Object Properties > Keyletter in the STEP
Template Palette in InDesign. Then, drag the Keyletter 'attribute’ onto the page. Other attributes will be added into

the text frame as per standard product template procedure.

For more information on building standard product templates, see the Product Templates section of the

STEP'n'design documentation.

<STEPREF A="stibo.
pseudoKeyletter" />.
<STEPREF A="Productijame"
/> <STEPREF A="NewProduct
DB="1" TN="NewProductYN" />y
<STEPREF
A="ShortltemDescription"
DA="1"/>

<STEPREF
A="LongltemDescription”
DA="1"/>1

<STEPREF A="Exclusive” DA="1"
TN="ExclusiveYN" />

<STEPREF A="Price" DA="1"
PN="1"TP="1" /> / <STEPREF
A="BaseUnitOfMeasure"

L?A="1 "TN="UOMPrint" />
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Working With Galley Page Templates in STEP

The following screenshot shows what a Galley page template looks like on the page template Designer tab. The
green frames indicate Galley Text frames. Note that no image frames display on the page.

Unlike the frames contained in standard page templates created in the workbench, green Galley text frames
cannot be manipulated in the page template designer.

This section will explain the special handling involved in linking product objects to planned pages that use a Galley
page template to drive the layout.
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Doc-Dev_PAGE Template_GALLEY - Designer

References || Status

ru | Ef ‘x Pos: |5.95 inches | Y Pos: ‘1.?9 inches | |'|I'l.|'idth: ‘1.1[] inches ‘ Height: |1.4B inches

Linking Products to Galley Text Frames

Unlike standard Flatplanner planned pages, there is not a 1-to-1 relationship between product objects and
Flatplanner frames when using Galley layouts. All products that should display on a page are linked into a single
green Galley text frame. In other words, there is a 1-to-many relationship between Galley frames and product

objects.
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In the Plan view, product objects should be dragged into Galley frames in the order that they should display on the
planned page. In the example below, there are three products inside a single frame. The product on the top will be
the first product, i.e., Galley key letter A. The second product will be Galley key letter B, and so on.

Note: Ordering product objects in Galley frames may involve some removal and re-adding, as the products
cannot be rearranged once placed into the frame. One way to ensure that your product objects display in the
correct order is to arrange them in the Flatplanner basket first, then multi-select them and drag them onto the

frame together.
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Assigning Galley Product Templates to Products in a Galley Frame

1. Right-click in a white area on the planned page and select View > Show Product Templates.

2. Left-click in the white product template box on the frame and choose the Galley product template that you
would like to use in the Choose a Product Template dialog.

Galley Page
4  Doc-Dev_PAGE Template_GALLEY Doc-Dev_PAGE Template_GALLEY 5

|
E] Choose a Product Template @

i =

Select Template

Doc-Dev_PRODUCT Template_GALLEY
Main Product Templ

Preview [

[Pink & Green Party Hat

[T : DocDev_PRODUCT Te

[T : DocDev_PRODUCT Template_GALLEY |

[ oK H Cancel ]

[Dog Pary Hats Assortment]
[T : DocDev_PRODUCT Template_GALLEY |

Galley product templates may also be pre-assigned to product objects through Flatplanner pagination rules. The
following screenshot shows an example of a rule that has been set to use a Galley product template as the default
layout. For more information on Flatplanner pagination rules, see Pagination Rules for Flatplanner in the
Flatplanner documentation.
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Acme Party Supplies - Pagination Rules

Financial Summary || AutoPage Publication Planner |BUGEIGUITINHATEM | Page Inspector || Status || StateLog || Tasks
Publication " Plan " Version Pages Publication Planner ” Plan Motes l
© Object Layout
Condition » {Action » Defined At >
X Default condition IUse product template Doc-Dev PRODUCT Acme Party Supplies
Template GALLEY
Add Rule

Mounting the Galley Page

Galley pages are mounted like any other Flatplanner page in InDesign. For more information, see Finalizing
Pages in InDesign in the Flatplanner documentation.
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Advanced Galley Page Template Frame Options

Text frames containing attribute references, as well as additional image frames containing product or asset
references, may be grouped together with the image frame and Galley key letter frame. In addition, any frame
appearing on a Galley page template may be styled with background shading, borders, and so forth. This allows
more flexibility in the layout of Galley pages, since Galley product templates may only contain text. (See the Galley
Product Templates documentation for Galley product template configuration instructions.)

The following screenshots show a 'before’ and 'after' of a more advanced setup. The first screenshot shows the
stylized page template, and the second screenshot shows the mounted page in InDesign:

E { STEP Template Palette E

Template Type  Page Template b

| JE==N
[ ﬂi Exclusive? -

[+ (| Family Desiption

[+ [ Long Item Description

[ DI Mew Product

b || Product Name

[+ [|3 Short Ttem Description

b (1T SpecCaption

[+ EZjTtem Purchasing Information

“Flas m""}rPT‘ﬁr‘i netlrmaoes
I | <STEPREF A="ProductName”

DA=ll lll.DE=,ll l"-;}#'

oductlma

(4

<ETEPREF A="SpecCaption” IA="1"DB="1" f=

ink & Green Party Hat

ebrate any occasion with Pink & Green Party Hat
his pink and green party hat}

Ering the WA
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Image and Product Frames Without Key Letters

In addition to the frame types required for Galley layouts, other frame types may be 'nested' within the page to
allow expanded layout flexibility.

The following Galley template example shows three additional frame types:

1. Static
2. Image (no Key Letter)
3. Product

FET odiact [Toage

FET odiact Mriage

Static Frames
Static Frames are used for content that should never be manipulated in the workbench Plan view. They typically
contain logos or brand images.
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>

Templste Type  Page Template

[ £5] Attribute Groups
[» ) Reference Types

[] Keep With Next

Frame Type:  Static

Frame ID

Image Frames
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Image Frames are not connected to Key Letters and are intended to contain image assets only.

E { STEP Template Palette i

Templste Type  Page Template

-,

Product Frames

Product frames allow 'nesting' of content on a page, allowing a different, non-Galley product template to be linked

to the frame.

[» 5] Artribute Groups
[» 5 Referance Types

[ Keep With Mext

Coinbent:

Frame Type:  Image

Frame ID | 10E813-1
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E  STEP Template Palette E

Template Type  Page Template

[+ 5] Artribute Groups
[* (2 Referemce Types

\ [] Keep With Next
Content:

IFrameTﬁ_.-pe: Product I

Frame ID |1mz?

Working With Optional Galley Page Template Frame Types in the
Workbench

To prevent manipulation by users in the workbench, Static Frames do not appear in the Plan view. Numbers 2
and 3 on the below screenshot show the product and image frames from the previous example.
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[M i Mo termplate assigned |

[M i Mo ternplate assigred

The following screenshot shows the Plan with an image object linked to the Image Frame and a product object
linked to the Product Frame. Note that the product template applied to the product frame is a non-Galley
template.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 49



StiboSystems

9 Pink & Green Pom-Pom Hat

‘_ |
Mt Mo ternplate assigned

[vellow & Pink Party Hat
Fli.xr

[T : Party Product Template

[Pink: & Green Pary Hatl

i

|T 1 Doc-Dev_PRODUCT Template_GALLEY

T i Doc-Dev_PRODUCT Template_GALLEY

The document described in this example will appear as follows when mounted in InDesign:
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Note: To apply more advanced product template-style parameters to image and text frames on Galley page
templates (e.g., image alignment settings and Delete Before / Delete After text options), you can temporarily
change the Template Type to 'Product Template' in the STEP Template Palette. Once your template is complete,
you must change the Template Type back to 'Page Template' before saving it back to STEP.
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Pagination Rules for Flatplanner

A pagination rule is a rule that controls how, when, and where product presentations are added to a page.

A pagination rule consists of one or more conditions and an action that takes place if the condition is met. You also
have to specify detailed criteria for some of the conditions and actions.

Pagination Rule Groups

Two pagination rule groups are available in Flatplanner:

« Object layout

« Set publication template spread index

Pagination Tab

You add pagination rules on the Pagination tab, which is available when you select a publication, section, or
subsection in the tree.

On the Pagination tab, there is a table which displays all rules that are applied to a publication. You get an
overview of all conditions and actions, and you can see where in the publication structure the rules are defined.

If there all rules with in a rule group are overridden, they are displayed in green. If you have edited the action of an
inherited rule, it is displayed in red.

Pagination Rule Inheritance

Pagination rules are inherited from higher levels to lower levels. Rules that are applied at lower levels take
precedence over rules applied at higher levels. So if you have applied a rule at publication level it is inherited to
sections and subsections, but rules applied at section or subsection level takes precedence over the inherited rule.

Important: All rules within a pagination rule group are effected when your create a local rule. Therefore, if you
make changes at publication level, the changes are not inherited by lower level sections and subsections.

Pagination Rule Evaluation

Pagination rules are evaluated one by one in the list from top to bottom. When the condition of a rule evaluates to
True, the associated action is then evaluated. The layout of a page is decided by the sum of all conditions with
actions that evaluate to true.

Note: The order of evaluation means that one action can override an action associated with a rule further down in
the list. Therefore, you should always specify the rule with the more general rule first and the most specific rule
last.
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To Change the Evaluation Order of Pagination Rules

« You can change the order of evaluation by clicking the rule you want to move, and then drag and drop it to its
new position in the list.
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Adding Pagination Rules in Flatplanner

To add a pagination rule, use the following steps.

To Add a Pagination Rule

1. Inthe Tree, expand the publication hierarchy, and then click the publication that you want to add a pagination
rule to.

2. Click the Pagination Rules tab.

3. Click Add Rule Group. The Configure Rules dialog appears where you can define the rules.

3% Configure Rules

Set Condition
| Condition »

Add Condition

Set Action
[ Action >
Add Action

Ok Cancel

4. Fromthe Action Group list, select the rule group that you want to apply.
5. Inthe Set Condition Area, click Add Condition. The Rule Condition dialog appears.

B cConfigure Rules >

Action Group Object Layout
Set Condition
[ [Condition
Add Condition

22 Rule Condition

Select Condition

Default condition

Set Action
[ laction
Add Action

Ok Cancel

6. Inthe Select Condition list, select the relevant condition, and then click OK.
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Some conditions can be limited further. Click the blue, underlined text to enter the criteria that determine when
the condition should be applied.

3% Configure Rules

Action Group|Dbject Layout Y
Set Condition
Condition »

W

If placement is on a left page

Add Condition

Set Action 32 Placement on page
[ Taction

Add Action Choose the placement

n a right page
op of a column

op of a page

ot at top of a column
ot at top of a page

Use Cancel

7. Inthe Set Action area, click Add Action. The Rule Action dialog appears.

B configure Rules .
Action Group Object Layout e

Set Condition

(Condition
» If placement is 82 Rule Action
Add Condition Select Action
Set Action Use product template L
ction L
7 Ok Cancel
Add Action -
|
Ok Cancel

8. Inthe Select Action list, select the relevant action, and then click OK.

Some actions can be limited further. Click the blue, underlined text to enter the criteria that further defines the
action.
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¥ Configure Rules

Action Group| Object Layout $2 Select product template

Set Condition
Condition Select template >

W

If placement is on a left page | Wome Product Template

Add Condition

Sat Action Use Cancel
Action >
IIse product template product template

W

Add Action

Cancel

To Add Local Pagination Rules
Itis possible to add local rules to a rule group at a lower level in the tree.

« if you add a rule to a group with inherited rules, a message is displayed asking if you want all rules in that
group to become local. Click Yes to make all rules local.

Allrules in the rule group are then displayed in green in the list. As a result, the rules will no longer inherit changes
made to the rules at a higher level.

To remove local rules, remove all the rules in a group one by one. The rule group reverts back to the inherited
rules.
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Editing Flatplanner Pagination Rules

You can edit both local and inherited pagination rules. On local rules, you can change both conditions and actions,
but on inherited rules you can only change the actions.

To Edit Pagination Rules
1. Inthe Tree, click the publication, section or subsection whose rule you want to edit.

2. Onthe Pagination Rules tab, click the arrow icon next to the rule you want to edit, right-click, and then select
Edit Pagination Rule. The Configure Rules dialog is displayed.

3. Make the desired changes, and then click OK.

If you have changed the action on an inherited rule, it is now displayed in red in the list on the Pagination Rules tab.

Note: You can not edit or add or delete conditions on inherited rules. Also, you can not add or remove actions
from inherited rules.

To Override Inherited Rules

To make all rules within a rule group local, you can override inherited rules. If local inherited rules are overridden,
changes made at higher levels are not inherited to the level where the rules have been overridden.

1. Inthe Tree, click the publication, section or subsection whose rules you want to override.

2. Onthe Pagination Rules tab, click the arrow icon next to the rule you want to edit, right-click, and then select
Override Rules.

The rules are overridden and displayed in green in the list. You can now edit the actions and conditions on the
rules and you can edit and remove rules from the rule group.

To Remove a Pagination Rule
1. Inthe Tree, click the publication, section or subsection that you want to delete a rule from.

2. Onthe Pagination Rules tab, click the arrow icon next to the rule you want to edit, right-click, and then select
Remove Pagination Rules.

To Copy Pagination Rules

It is possible to copy a rule from one rule group to another. Rules can be copied to and from publications, sections
and subsections. The paste destination does not have to be of the same type as the source.

1. Inthe Tree, click the publication, section or subsection that holds the rule you want to copy.

2. Onthe Pagination Rules tab, click the arrow icon next to the rule you want to copy, right-click, and then select
Copy Pagination Rules.

3. Omthe Tree, click the destination publication, section or subsection.
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4. Onthe Pagination Rules tab, click the arrow icon of an existing rule, right-click, and then select Paste
Pagination Rules.

Note: If you paste a local rule into a group with inherited rules all rules in the group become local.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 58



StiboSystems

Flatplanner Pagination Rule Actions

For each rule group, a number of actions are available.

Object Layout Actions

Action Description

Keep user assigned template Uses the already assigned template.

Pickup document Uses a product layout from a publication that you select.

Use default product Uses the default product presentation that has been assigned to the product.

presentation

Use product template Uses a specific product template that you select from a list of available
templates.

Set Publication Template Spread Index Actions

Action Description

Set publication template spread index | Defines which spread within a publication template to use.
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Flatplanner Pagination Rule Conditions

The following table describes the pagination rule conditions that are available in Flatplanner.

Condition Description

Default condition

The rule is always applied. There are no specific conditions that
must be met.

If first in section

The rule is applied if the object is the first object in the section
specified in the condition.

If frame dimensions fit product template
min/max dimensions

The rule is applied if the width or the height of the frame meets the
conditions you specify.

If the object type is

The rule is applied if the object is of the same object type as
specified in the condition.

If the objectis

The rule is applied if the object is the same as the object specified
in the condition.

If the product attribute value equals

The rule is applied if the product attribute value is the same as the
value specified in the condition.
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Flatplanner Pagination Rule Groups

There are two pagination rule groups that you can apply in Flatplanner. For each group, there are a number of
actions available. For more information about actions, see the Flatplanner Pagination Rule Actions topic.

Object Layout

Use the object layout rule to specify the layout of an object on a page.

The following conditions are available.

« Default conditions

« Iffirstin section

« Ifframe dimensions fit product template min/max dimensions
« Ifthe objecttypeis

« Ifthe objectis

« Ifthe product attribute value equals

Set Publication Template Spread Index

Use the set publication template spread index to specify which publication template spread number to use in the
mount process.

The following conditions are available.

« Default conditions
« Ifobjecttypeis

« Ifthe product attribute value equals
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Flatplanner Baskets

Flatplanner baskets are a way to store and organize products and images (and less commonly, classifications)
that will be linked to frames on Flatplanner planned pages throughout a publication. Baskets can be accessed at
the publication, section, and spread level of publications.

The most common use for Flatplanner baskets is the ability to view the assortment of products that have been
selected for your spread, section, or publication, then drag these objects from the basket onto the frames on your
Flatplanner planned pages.

Baskets are optional, as objects may be linked directly to planned page frames by a number of different methods:
directly from the Tree, from a listing of search results, from the contents of a collection, and through a Flatplanner
Excel or Publication Excel import. However, Flatplanner baskets are a convenient visual tool for users who plan
pagesin STEP, as basket views can be configured to display image thumbnails, attribute values, commercial data
(such as pricing), and other useful information about the product selection.

Objects linked to baskets at higher levels in the publication hierarchy are inherited by the baskets of child sections
and spreads, following the same manner of inheritance as that of other hierarchies in STEP (for example, how
attributes and references that are linked to higher levels in the product hierarchy are inherited by child products).

Viewing a Basket

Baskets are viewed from the Plan tab on publications, sections, and spreads.
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Party Hats - Plan -~
AutoPage Publication Planner || Pagination Rules || Page Inspector || Status || State Log || Tasks
‘ Publication Section l I Publication Planner Plan Motes ” Financial Summary I
Basket at:Acme Party Supplies
Column View: | Default - Public hd View Options
D * Mame * PrimaryProductImage *|0n Pages  * Brand Name * |SalesPrices
Acme -
121171 I Pink & Green Party Hat & 2,4 2.49 D
Parties Galore
121178 {8 Purple & White Party Hat 3,7 3.99
P Acme
121177 N Cosmic Party Hat / '-ﬁ_ 2,4 3.49
. Acme
121184 M Christmas Party Hat @% 7.49 -
| I | r
Flatplanner
'.. [ &8 | E”X: Y: |W: H: ‘Uiew:Plan v: — U s e
" Party Hats Galley Page 3
T 1% 313 45
=
grE Fink & Gresn
Purple & Whit
Pink & Green Party Hal [vellow & Pink Pink & Green Party Azl
[Cosmic Party Hay [Cosmic P2ty Had
[Dog Pary Hats Assortmend [Dog Party Hats Assortment]
5\ J

« Toopen the basket, click Show basket in the upper right corner of the basket window.
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« To hide the basket, click Hide in the upper right corner of the basket window (visible in the first screenshot in

this topic).
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Adding Objects Manually to Baskets

Products, assets, and classifications can be added to Flatplanner baskets through both manual and automated
methods. The following instructions outline how to add objects to Flatplanner baskets manually: from the Tree,
from search results, and from collections.

For all of the following methods, the relevant basket must be open (unhidden) and the Plan editor must be pinned
to the window by clicking the thumb pinicon in the upper left corner. ﬂ

To Add Objects From the Tree

1. Inthe Tree, locate the relevant publication, and then navigate to the level of the publication that contains the
basket to which you would like to add objects. This is typically a section or spread, but could also be at the top
publication level.

Click the Plan tab.
Click Show basket to make the basket available.
Ensure that the editor is locked by clicking the thumb pin icon in the upper right corner of the Plan window.

Inthe Tree, navigate to the object(s) that you want in your basket.

© o &~ w D

Select one or more objects, then hold down the left mouse key and drag the object(s) into the basket. To select
multiple objects, press Ctrl or Shift while making selections.

To Add Objects from a Search Result

1. Follow steps 1-4 from the previous section to locate, open, and pin the relevant basket.

2. Click on the Search tab, make your selections, and then click Search.

3. Select one or more objects, then hold down the left mouse key and drag the object(s) into the basket. To select
multiple objects, press Ctrl or Shift while making selections.

4 Party Hats - Plan

a | Search Below = Primary Product Hierarchy ||| AutoPage Publication Planner || Pagination Rules || Page Inspector
(S - | Publication Section l [ Publication Planner H Flant
*

= Hat Basket at:Acme Party Supplies

g @ advanced . _

[ Column View: | Default - Public hd
B [ Reset “ Search ] - )

5| Displaying 22 of 22 results Show Details D * Name * |PrimaryProduct.2.On Pages

a || [Name

& 121171 Pink & Gree... 2, 4

i || >\ 1st Birthday Hat D = 134420 h &

S | > ¥ Baseball Hat D = 20805 — =

ol e

w ||~ L Black Top Hat D = 137730 121178 8 Purple & w... 3,7
“ | > \PBlue & Pink Owl Party Hat D = 132494

3_ * i Blue & Yellow Balloon Hat D = 121180 i

5 ||> Lu/Blue Top Hat I = 132485 4| il
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For more information on how to conduct searches in the STEP Workbench, see the Search Overview section of
the STEP User Guide / Getting Started documentation.

To Add Objects from a Collection List

1. Follow steps 1-4 from the 'To Add Objects From the Tree' section above to locate, open, and pin the relevant
basket.

2. Inthe Tree, navigate to the relevant collection and expand it to view its contents.

3. Select one or more objects, then hold down the left mouse key and drag the object(s) into the basket. To select
multiple objects, press Ctrl or Shift while making selections.

Tree < Party Hats - Plan
& Primary Product Hierarchy (Pro » ||| page Inspector || Status || State Log || Tasks

E"' %UIIEec'éiuns AutoPage Publication Planner Il Pz

- eds

" 5 Copy Writing State Publication Section ]ml Publication Planner H Plan Notes l

- [J Data Quality Collection Basket at:Acme Party Supplies

- [ Digital Asset Review State . .

El [ Hats Column View: | Dpefault - Public -
- g 109308 (109308) :

~Qw 1112121-1 (17739 (| * [Name

-\ 12-GGK79 (100703)

L. 18207-011 (18202 12171 ¥ Fink & Gree... & 2,4

- 18210 M B (18210) c

- 18212 L B (18212) ]

| 18213 M O (18213) 121178 | Purple & W... 3,7

- 18214-012 (18214)

Nl 18215-012 (18215) i

- 18216 L O (18216) | il |

W

PrimaryProductiImage  * |On Pages

For more information on how to create and work with collections, see the Collections section of the STEP User
Guide / Getting Started documentation.

Removing Objects from Baskets

1. Select the row(s) containing the products that you would like to remove by clicking the cells under the ID
column. Rows may be multi-selected by holding Shift or Ctrl while making selections. (Note: Cells in any
column may be clicked to select rows, though using the ID column is the most logical, since it is the first column
and also contains no hyperlinks.)

2. Right-click and select Remove.
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Column View: [Default - Public v] View Options
D o * Name * [PrimaryProductImage * |On Pages * Brand Name
23456-002 I B
34567-003 Filtering enabled

Caps Galore
20805 6, 10

Show in plan

a Remove
‘ ‘: Import File :l b
|

Copy table to clipboard for Excel
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Importing Objects Into Baskets

Objects can be imported into Flatplanner baskets using the following file formats:

. CSV

« Plain text (.txt)

« Publication Excel
o STEPXML

The following sections outline the steps for each method. This topic assumes that you have already navigated to
the relevant basket in your publication and have the basket open.

CSV

Two methods exist for importing objects to Flatplanner baskets using CSV files. The first is for loading a sheet
containing objects that are all of the same 'super type'—product, asset, or classification. The second is for loading
a sheet that contains an assortment of super types.

Objects of the Same Super Type

To load a CSV file composed of objects of the same super type, a one-column CSYV file containing a list of object
IDs is used.

A
1 20805
2 114509
3 181198
4 20803
5 179857
6 179858
7 134420
3 121177
9 121171
10 121192
11 138925

To load this file, follow these steps:

1. Right-click anywhere inside of the basket and select Import File.
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Publication Section ]m[ Publication Planner H Plan Notes H Financial Summary l

Basket maintained locally

Column View: | pefault - Public

- View Options

D

Mame

W

PrimaryProductImage > |On Pages * |Brand Name

23456-002

1

34567-003

20805

4

I8
Filtering enabled

Show in plan
Remove

Import File e

Copy table to clipboard for Excel

Caps Galore

4

2. Inthe Select File dialog, click the ellipsis button (...).

File:

£+q Select File

Object type selection

(@) Fixed object type Product -
(") Object type in the first column in the file | <TAB> -
’ OK ] ’ Cancel

X7

R

In the Open dialog, navigate to the relevant CSV file, then click Open.

In the 'Object Type selection’ area of the Select File dialog, choose Fixed object type, then choose the

appropriate super type from the dropdown list (Product, Classification, or Asset).

o o

Click OK. A Status dialog displays.

If the load is successful, a message appears in the Status dialog box with the number of new objects that were

loaded. If the load was unsuccessful, an error message appears instead. (For example, an error may appear if
the 'fixed object type' file contains different super types, or if the system cannot locate an object in the file.)

E] Status

O Imported 11 new objects to basket.

=X

7. Click OK to close the Status dialog. The objects from the imported file are displayed in the basket.
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Objects of Different Super Types

Toload a CSV file composed of objects of different super types, a two-column CSV file is used that contains super
type identifiers in the first column and a list of corresponding object IDs in the second column. The first column
identifies the objects' super type with a value of 'product,' 'asset,' or 'classification.’

A B
1 product 134420
2 | product 20805
3 | product 121177
8 product 121192
9 product 179857
10 product 179858
11 product 138925
12 asset 107625

13 classification 8735

To load this file, follow these steps:

1. Follow steps 1-3 from the previous section on uploading single-column CSV files.

2. Inthe'Object Type selection' area of the Select File dialog, choose Object type in the first column in the
file, then select the appropriate delimiter from the dropdown list. Available delimiters in the 'Object type in the
first column in the file' dropdown list are <TAB>, <SPACE>, comma, semicolon, and pipe.

3. Click OK. A Status dialog displays.

4. Ifthe load is successful, a message appears in the Status dialog box with the number of new objects that were
loaded. If the load was unsuccessful, an error message will appear instead. (For example, an error may appear
if no super types are listed in the first column, or if the system cannot locate an object in the file.)

5. Click OK to close the Status dialog. The objects from the imported file are displayed in the basket.

Plain text (.txt)

The steps for loading plain text files to baskets are nearly identical to those of uploading CSV files.

Note: Imported text files must be true plain text. The import will not work with document types that contain rich
text elements (for example, Microsoft Word documents).

Objects of the Same Super Type

To load a list of objects of the same super type (for example, an assortment of products), a plain text file containing
alist of object IDs is used.
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7829 p
20682

6806

8108

20674

101118|

To load this file:
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1. Follow steps 1-3 from the previous section on uploading single-column CSV files, except you will open a .txt file

instead of a CSV file in step 3.

2. Inthe'Object Type selection' area of the Select File dialog, choose Fixed object type, then click OK.

3. The Status dialog displays with the number of new objects that were loaded to the basket. (If the load was

unsuccessful, an error message appears.)

4. Click OK to close the Status dialog. The objects from the imported file are displayed in the basket.

Objects of Different Super Types

To load a list of objects of different super types, a plain text file containing a list of super types and object IDs is
used. The super type and ID are separated by a delimiter (for example, a tab or comma).

" TXT_CommaSeps.txt - Notepad E@

File Edit Format View Help

product,134420 »
product, 20805

product,121177

product,114509

product, 20803

product,181198

product,121171

product,121192

product,179857

product,179858

product,138925

asset,107625

classification,8735 i

To load this file:

1. Follow steps 1-3 from the previous section on uploading single-column CSV files, except you will open a .txt file

instead of a CSV file in step 3.

2. Inthe'Object Type selection' area of the Select File dialog, choose Object type in the first column in the

file, then select the relevant delimiter from the dropdown list and click OK.
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3. The Status dialog displays with the number of new objects that were loaded to the basket. (If the load was
unsuccessful, an error message appears.)

4. Click OK to close the Status dialog. The objects from the imported file are displayed in the basket.

Publication Excel

A Publication Excel sheet may also be used to load objects into the baskets of an existing publication. The sheet
needs the following columns, at minimum, to successfully import objects: PublicationID, SectionID,
BasketObjectlD, and BasketObjectType.

A B C D
1 PublicationlD SectionlD BasketObjectlD BasketObjectType
2 M10642

3 M24278

4 "09308 Product

5 R7739 Product

B Hg212 Product

7 M8213 Product

8 Tire Kit12 Asset

9 lcons Classification
10 "10016

11 20805 Product

12 "34420 Product

13 R21177 Product

14 R21171 Product

15 M21192 Product

16 35925 Product

To load the file, right-click on a publication group and select Import Publication.... Alternately, you may select
File > Import > Data. The ensuing steps will be the same as those for uploading any Publication Excel document.

For complete instructions on loading Publication Excel files, as well as additional information about how to use
them (for example, how to create new publications), see the Importing Flatplanner Publications in Excel
section of the Flatplanner documentation and the Importing a Publication Excel Sheet section of the
STEP'n'design documentation.

STEPXML

Typically, users will not manually create a STEPXML file for the sole purpose of importing objects into Flatplanner
baskets. STEPXML files are most commonly used for the export / import of entire publications. However, objects
can be loaded to baskets in pre-existing publications through a STEPXML import as long as the IDs for the existing
publication (and sections, if section-level baskets are being loaded), are present in the file.

For a STEPXML example, see the online version of this topic.

For more information on importing STEPXML files for Flatplanner publications, see the Exporting and
Importing Flatplanner Publications in STEPXML topic.
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Editing Data in Baskets

It is possible to edit attribute values and commercial data directly in a basket. Attributes are only editable if the
attributes are valid for the product. Commercial data is only editable if the relevant commercial list is valid for the
publication and has been mapped to the publication version that you are working in. As with editing values in any
other location in the workbench, you must have the appropriate user permissions in order to edit values in the
basket.

Publication Section ]m[ Publication Planner ” Plan Motes ” Financial Summary ” AutoPage Publication Planner ” Pagin

Basket at:Acme Party Supplies

Column View: | Default - Public

W

ID * |Name PrimaryProductImage * |0On Pages * Brand Mame * |SalesPrices
Acme

2,4 2.49

121171 ﬁ Pink & Green Party Hat

By Parties Galore
121178 F Purple & White Party Hat 3, 7 3.99

Inthe Tree, expand the publication hierarchy.

Click the relevant publication and expand the hierarchy.
Click a publication, section, or a spread.

Select the Plan tab.

Click Show Basket to make the basket available.

Click the field in which you want to add or change the value.

Enter the new value.

© N o o b~ DN =

Click outside of the field. The value is saved.
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Working with Flatplanner Page Frames

You can edit and add frames and content.

« Toeditframes, in the Tree, select the preferred publication, section, or spread, and then click the Plan tab.

To Add a Frame

« Toadd aframe to a page, select the Add Frame tool in the tool bar. Drag an outline of the frame with the
cursor while holding down the left mouse button, and then release the mouse button.

To Insert Frames on a Grid

1. Toquickly create many frames in a grid, select a page, then click Insert frames on a Grid in the tool bar. A
dialog box appears:

In the Across field, enter the number of rows of frames you want to be inserted.

In the Down field, enter the number of columns of frames you want to be inserted.

In the Vertical Gap field, enter the distance between the rows of frames.

In the Horizontal Gap field, enter the distance between the columns of frames.

© g s~ w D

Click Enter. The frame grid is inserted on the selected page.

To Select Frames

« Toselect aframe, click the Select tool in the tool bar and click a frame.

« To select multiple frames, hold down the Shift key, and click the frames you want to select.

To Delete Frames

« Todelete aframe, select the frame with the Select tool and then click the Delete frame button in the tool
bar. You can also select multiple frames and delete these frames the same way.

To Move Frames

« Tomove a frame, choose the Select tool in the tool bar, and then drag and drop the frame. You can also set
the X and Y position of one or more selected frames by entering a new value in the X Position field and Y
Position field.

To Resize Frames

« Toresize a frame, choose the Select tool in the tool bar, select the frame, and then drag the handles on the
frame border. Alternatively, enter a new value for one or more selected frames in the Width and Height
fields in the tool bar.
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To Enable Snap Positioning

When you move frames on the page using drag and drop, it can be useful to enable Snap Positioning. This makes
the moved frame snap to a position when you release the mouse button. This way you can easily place frames in
the same X and Y positions on the page. The snap positions are :

« Margin borders: Upper and right hand side border
« Frame borders: All borders

Note: Only the upper frame border and the left hand frame border of the frame that is being moved snaps.

To Change the Order of Frames
Frames are placed on the page in a specific order relative to each other. Adding a new frame places that frame on
top of other frames. This is only noticeable if frames overlap each other.

If you want to change the ordering of frame layers, right-click the frame, select Layers, and select one of the four
options:

« Bring to front: Brings the selected frame to front.

« Send to back: Sends the selected frame to the back.

« Bring forward: Brings the selected frame one level forward.

« Send backward: Sends the selected frame one level backward.

Note: Moving a frame from one page to another brings the frame layer to a front position.

To Move Content Between Frames

You can move content such as products and images from one frame to another.

« Select the Select tool, in the preferred frame, click the object you want to move, and then drag and drop the
object to the desired frame.

To Remove Content from a Frame

« Right-click the desired frame, and then click Remove Content.

To Change Frame Properties
To view and maintain details of a frame, select the frame, right-click and select Frame Properties. A dialog box
appears with the following options.

« Frame ID: Editable field that shows the ID of the selected frame.

« X Position: Editable field that shows the horizontal position of the selected frame.

« Y Position: Editable field that shows the vertical position of the selected frame.

« Width: Editable field that shows the width of the selected frame.
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« Height: Editable field that shows the height of the selected frame.

« Layer: Editable list that defines the frames order relative to other frames on the page. '0' means that the
frame is in the back.

To View Frame IDs
Each frame on a page template has an ID.

« Toview the ID of the frames on a page, right-click the page and select Show Frame IDs. A small box
containing the IDs appears in all the frames on the spread.
To Change Frame IDs
« Tochange the ID of a frame, right-click the frame and select Frame Properties. A dialog box appears
where you can change the ID.
To Zoom In and Out
« Tozoomin, right-click the page and select the Zoom in option. To zoom out, right-click the page and select

the Zoom out option.

To Change the Size of a Frame
Itis possible to resize a frame on a spread.

To Copy and Paste Pages
Itis possible to copy and paste a page including frames:

1. Right-click the page you want to copy and select Copy Page.
2. Right-click the page you want to paste the copied page to and select Paste Page.

The copied page including frames is pasted.

Note: A warning appears if you try to paste a left-hand page to a right-hand page and vice versa.
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Designing Flatplanner Page Frames

When you apply a template to a publication in the Flatplanner, it comes with a number of predefined frames.
However, it is possible to add or change frames on a publication, section, or spread. Use the Designer tool bar on
the Plan tab to add and position frames on the page template.

Designer Tool Bar

« Toaccess the Designer tool bar, click a publication, section, or spread in the Tree, and then click the Plan

tab.
Used to save all changes
Save
E Used to select and move frames and content on the page by dragging them.
Select
I Used to add new frames by clicking and dragging the mouse.
Add frame
s Used to delete a frame. Delete is only enabled when one or more frames are selected.
Delete
] Used to insert multiple frames in a grid on the page.
Insert frames on
agrid
=8 Used to undo your last action.
Undo
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Tool Description
Used to redo your last action.

Used to enable or disable snapping of frames when they are moved or re-sized.

]

Snap positioning
toggle button

Shows the horizontal position of a selected frame. If more frames are selected, the
horizontal position is only displayed if it is the same for all selected frames.

% Pos:
X Pos . . : e
To change the horizontal position of a frame, enter a new value in the X position field.
¥ Pos: Shows the vertical position of a selected frame. If more frames are selected, the vertical
position is only displayed if it is the same for all selected frames.
Y Pos To change the vertical position of a frame, enter a new value in the Y position field.
Width: Shows the width of a selected frame. If more frames are selected, the width is only
displayed if it is the same for all selected frames.
Width To change the width of a frame, enter a new value in the Height field.
Height: Shows the height of a selected frame. If more frames are selected, the height is only
displayed if it is the same for all selected frames.
Height To change the height of a frame, enter a new value in the Height field.
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Adding Products and Images to a Page

You drag and drop products, images, and classifications to a page from:

« Basket
e« Tree
« Collection List

o Search Result

This topic describes the manual methods for linking objects to Flatplanner frames through dragging and dropping.
For information on how to link objects to Flatplanner frames through Excel imports, see Exporting and
Importing Flatplanner Publications in Excel in the Flatplanner documentation.

Dragging and Dropping from the Basket

You can drag and drop products and images from the basket to the Flatplanner.

In the Tree, expand the publication hierarchy.

Click the relevant publication and expand the hierarchy.
Click a publication, section, or a spread.

Click the Plan tab.

Click Show basket to make the Basket available.

ok 0N =
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Party Hats - Plan -~
AutoPage Publication Planner || Pagination Rules || Page Inspector || Status || State Log || Tasks

Publication Section l [ Publication Planner Plan Motes

I

Basket at:Acme Party Supplies

I

Financial Summary

Column View:  Default - Public v View Options
D * |Name * PrimaryProductimage *|0n Pages  * Brand Name * |SalesPrices
Acme -
121171 I Pink & Green Party Hat & 2,4 2.49 D
Farties Galore
121178 {8 Purple & White Party Hat 3,7 3.99
b Acme
121177 N8 Cosmic Party Hat ,. '-‘_t 2,4 3.49
. Acme
121184 @ Christmas Party Hat @% 7.49 -
< I | }
Flatplanner
... [ B |E”X: Y: |W: H: |‘I.Fiew:PIan v: —uy s e
" Party Hats Galley Page A
2% 313 45
=
& P e Geen
Purpke & Whit
Pink & Green Party Hal [rellow & Pink Pink & Green Party Hal
[Cosmic Pary Hzf [Cosmic Pary Hzf
[Dog Pamy Hats Assortmend [Dog Pary Hats Assortmend
5 /

6. Drag and drop the relevant products or images from the basket to the Flatplanner.
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Dragging and Dropping from the Tree

You can drag and drop products and images directly from the Tree to the Flatplanner.

1. Inthe Tree, expand the Classification hierarchy or the Product hierarchy and locate the product or image you
want to use.

2. Drag and drop the relevant product or image from the Tree to the Flatplanner.

Dragging and Dropping from a Collection List
You can drag and drop products and images directly from a collection list to the Flatplanner.
1. Ensure that the editor is locked by checking the Thumb Pin icon & .

2. Inthe Tree, expand the relevant Collection hierarchy.

3. Drag and drop the relevant products or images from the collection list to the Flatplanner.

Dragging and Dropping from a Search Result

You can drag and drop products and images directly from a search result to the Flatplanner.

N

Ensure that the editor is locked by checking the Thumb Pin icon & .

In Search, define your search criteria and then click Search.

The search results are displayed in the Search Result window.

A w D

Drag and drop the relevant products or images from the search result to the Flatplanner.
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Changing and Reapplying Page Templates

When you first create a publication, you define which page template you want to use in the publication. However, it
is possible to change the page template later, and to add different page templates to different sections or spreads
in your publication.

You can also reapply a page template to a publication, section or spread.

To Change a Page Template

1. Inthe Tree expand the Publication hierarchy, and then expand the relevant publication.
2. Click the relevant publication, section or spread, and then click the Plan tab.

3. Right-click a white area in the Promotion Planner, and then select Set page template. The Choose a Page
Template dialog appears.

4. From the list of available templates, choose the preferred template, and then click OK.

If you have changed a page template and want to switch back to the original page template, you can reapply the
page template.

To Reapply a Page Template

1. Inthe Tree expand the Publication hierarchy, and then expand the relevant publication.

2. Click the relevant publication, section or spread, and then click the Plan tab.

3. Right-click a white area in the Flatplanner, and then point to Layout, and then select Reapply page template.

If you have changed the position of frames on a page and you reapply or change the template, the frames on the
page are positioned according to the frame positions of the page template.

While the position of a frame can change after changing the page template, the content of the frame remains the
same. If you have added additional frames with content, those frames will remain on the page as well. However,
frames without content are deleted.
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Applying Product Templates to Page Frames

You can apply different product templates to different products, and you can change the assigned product
template.

To Add or Change a Product Template

1. Inthe Tree expand the publication hierarchy, and then expand the relevant publication.
2. Click the relevant spread, and then click the Plan tab.

3. Right-click a product (a light blue area) in the Flatplanner, point to Layout, and then select Set product
template. The Choose a Product Template dialog appears.

4. From the list of available templates, choose the preferred template, and then click OK.

F" ™
E Choose a Product Template ﬁ

Select Template

emplate1

' Preview [ |

[ aK ][ Cancel ]

Note: All products must have a product template assigned, otherwise the products will not be mounted.

Itis also possible to add the same product template to all products on a page in one go.

To Apply the Same Product Template to all Products on a Spread

1. Inthe Tree expand the Publication hierarchy, and then expand the relevant publication.

2. Click the relevant spread, and then click the Plan tab.
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3. Right-click a white area in the Promotion Planner, point to Layout, and then select Set all product
templates. The Choose a Product Template dialog appears.

4. From the list of available templates, choose the preferred template, and then click OK.
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Removing Product Templates

You can remove the assigned product template from a Flatplan frame by following these steps:

1. Inthe Tree expand the publication hierarchy, and then expand the relevant publication.

2. Click the relevant spread, and then click the Plan tab.
3. Right-click a product (a light blue area) in the Flatplanner, point to Layout, and then select Clear layout. The
template is removed from the frame.
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Adding Notes and Free Text

Notes and free text can be added directly to planned pages (spreads) from the Plan tab. Notes and free text are
useful, for example, when you want to communicate with an art director or designer about the pages.

Notes can be added to planned page spreads in the Plan view andPreview view. They cannot be added in the
Sticker Book view.

m Flanned Page ” Flan Maotes ” References ” Skatus ” State Log " Tasks ]

@ Eg | —EH& LE |'|.’I.|':
Conf
18] 22
This 5 a Free text frame

To Add a Note to a Planned Page
In the Tree, expand the Publication hierarchy, and then click the relevant spread.
Click the Plan tab.

Right-click a frame or the white area of the spread, and then click Add Note. The Notes dialog appears.

Inthe New Message field, enter the text.

o k> 0N =

Click Add, and then click Close. The note is visible in the frame or in the white space.

Note: Notes can be added to planned pages in both the Plan view and the Preview view. Free text can be added
in the Plan view only.
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Add Free Text to a Frame on a Planned Page

You can only add free text to empty frames, and you cannot add products to frames that contain free text.

ok 0N =

To

To

In the Tree, expand the Publication hierarchy, and then click the relevant spread.

Click the Plan tab.

Double-click the free text frame, or right-click and select Set Text. The Add Text dialog appears.
Enter the text in the text field.

Click Add, and then click Close. The text appears in the frame.

Edit and Delete Free Text

To edit free text, follow the same steps as you would to add free text.

To delete free text, right-click the free text frame and select Remove Content.

Edit and Delete Notes From the Plan

To edit a note from the Plan, double-click on the relevant note and add text.
To delete a note from the Plan, right-click the relevant note, and then click Delete Note.

Instead of deleting a note, you may also mark it as Done. This allows you to keep the note while letting other
users know that no further action needs to be taken.

|| Notes (>

201511 04 16:45:13 DTPUSER:
Image haz been replaced

2015 10 09 16:25:57 USER:
Wrong image

Done:

[New Message

[ Add ” Close ]

Using the Plan Notes Tab

The Plan Notes tab enables the viewing, editing, and deletion of all planned page notes in one location. This tab is
accessible from the publication, section, and planned page level of publications. You can access all notesin a
publication from the publication level; all notes in a section from the section level; and all notes in a spread from the
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planned page level.

Edits made to notes from the Plan Notes tab will be reflected in the notes attached to the Flatplan. Likewise, edits
made to notes on the Flatplan will be reflected on the Plan Notes tab.

Editing notes on this tab is similar to editing notes on Flatplan frames—new text can be added, but existing text
cannot be edited. The Plan Notes tab will always display the most recent notes text.

Note: Notes cannot be added to planned pages from the Plan Notes tab, as there is no way to position them on
the page. Notes can only be added via a right-click action on page spreads.

Jpnng Wedding Catalog - Plan Notes

- ﬁ Publications + ||| publication || Plan || Version || Pages || Publication Planner |WAELLGICGEN | Financial Summary || AutcPage Publication Planner || Pagination Rules [_
g iy ﬁ Temzlat;s y Spread Title » Page * Top ¥ L ¥ User » Comment ¥ |Last edited > Done »
: Stal Publicati
~ 9 Starcard bt >Confeti 4 43.98mm 7B.89mm LSRR Pleasemove tisproducttopage 16 FriOct09 16:28:BEDT2015 ||
e ﬁ Autopage Publications - . _
: B ﬁ Fiatplanner Publications . » Confetti 4 50.85mm |154.85mm SER  Please correct typoin copy Mon Oct 26 11:04:56 EDT 2015 D
l ] &:mgl.'.ted:ig{:aldug » Confetti 4 108.56mm 49.06mm  USER  Meeds new image Thu Oct 15 14:3230 EDT 2015 [
G - il Halloween Catalog >Confeti 4 174.55mm 54.52mm USER  Replace with product EX-12345 Thu Oct 15 14:33:06 EDT 2015 7]
)
h 5 CrstnasCatog dConfeti 5 4u62mm M6.44mm USER  Wrongimage FriOct09 16:25:57EDT 2015 |7
- WebUlPublicationTypes ™
< m b » Confett 5 46.70mm  46.70mm  LSER Flease double check this copy Fri Oct 09 16:25:34EDT 2015 [

To Edit or Delete Notes From the Plan Notes Tab

1. Select the note that you would like to edit or delete by left- or right-clicking on the small gray arrow at the
beginning of the row.

2. Inthe popup menu, choose 'Edit note..." or 'Delete note(s)'. Multiple notes may deleted at once if multiselected.

Spring Wedding Catalog - Plan Notes

Publication || Plan || Version || Pages || Publication Planner |BEELNLIEEN [ Financial Summary || AutoPage Publication Planner || Pagination Rul

Spread Tile * |Page * Top »|User  * |Comment * |Last edited » [Done *
» Confetti 2 43.98mm [73.89mm USER Please move this product to page 16 Fri Oct 09 16:28:39 EDT 2015 ||
» Confetti 2 50.85mm (154.85mm LISER Flease correct typo in copy Mon Oct 26 11:04: 56 EDT 2015 |:|
2 ] LISER. MNeeds new image Thu Oct 15 14:32:30 EDT 2015 |:|
> Confetti Edit note... LISER Replace with product ABC-1234 Wed Oct 28 13:29:29 EDT 2015 ||
> Confett 3 Delete note(s) " 1niiseR Image has been replaced Wed Nov 04 16:45: 13 EST 2015
» Confetti 3 46.70mm 46, 70mm USER Please double check this copy Fri Oct 09 16:25:34EDT 2015 ||

Sorting and Filtering Notes
Notes can also be sorted and filtered on the Plan Notes tab. Example use cases include:
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« The placement of notes throughout a publication can be determined by filtering on Spread Title, then further
pinpointed by sorting on 'Left' and 'Top' (X/Y) coordinates.

« Allnotes that are marked as 'Done' can be identified by filtering the Done column on 'true'. The notes can
then be multiselected and deleted.

Spring Wedding Catalog - Plan Notes

Publication WW[@ Publication Planner Financial Summary || AutoPage Publication Planner || Pagination Rules

Spread Title > Page » [Top > L » |User > |Comment > Last edited
» |-All- v |-All- ¥ |-Al- v |- Al- » |-All- v |-Al- v |- Al-
» Confetti 3 168inches  5.77inches DTPUSER Image has been replaced ra'ledﬂnvﬂ‘llﬁ:ﬁ:lﬂﬁl'ml.'i
» Confetti 3 6.76inches  [1.12inches DTPUSER Mo further edits needed }ﬂedl"lmrﬂ‘r 16:50:51 EST 2015
>rlq:ki'ls 4 2.57inches  [1.90inches DTPUSER Mo further edits needed }mdﬂwuus:ss:mmms

ant 2 6.85inches  6.55nches  DIPUSER Mo further edits needed Wied oy 04 16:S5:04EST 2015
M Edit note..

Delete note(s)

Navigation to Spreads

Spread titles are hyperlinked in the 'Spread Title' column. Simply slick on a hyperlink to navigate directly to the
Planned Page.

| Publication [ﬁ] Wer
Spread Title  ~Page *
* Tabledoths 12
» [Tabledoths 12
* Mapkins 4
» Mapkins 4
» Mapkins 5
* Confett 2
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View Modes

Different viewing modes allows you to view the content and layout of planned and actual pages in different ways.

To Change the View Mode

1. Inthe Tree, expand the publication hierarchy, and then select a section or spread.

2. Onthe Plan tab, right-click in the white area, and then select the preferred view from the list.

View Mode Description

Show Plan Displays the allocated space and position for each type of object specified in the
template. The page is divided into colored squares where you can mount products or
images.

If you are using page templates created in InDesign, the frame types are
automatically converted into generic frame types that can be used for both images
and products.

Show Preview Displays a preview of how the product and images are positioned on the page based
on the product template applied to the frames.

The preview is created from the InDesign (DTP) server.

Show Sticker Book Displays products and images along with commercial data such as prices and sales
numbers. The commercial data is displayed as yellow sticky notes along with a
thumbnail image of the product.

If no commercial data is displayed, you must add the commercial data element to the
Sticker Book view.

Show Mounted Page | Displays how the actual pages look after the pages have been completed in the
InDesign and saved back to STEP.

This view is read-only.

Show Frame IDs Displays the frame id for each frame on the plan. You use the frame ids when the
importer is used to add objects to a frame.

Show Product Displays the product template that is assigned to each frame.
Template
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View Mode Description

Show Page Template | Displays the page template that is assigned to the page in the gray area above the
plan.

Show Page Spaces Displays how the page space is split and how the page spaces are assigned.

Highlight Differences | Is only active when preview mode is selected. Any differences between the current
Relative to Default layer and the default layer are highlighted by a gray box.
Layer
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Customized Views

You have a number of options to customize views so that they are more efficient for you to work with. You can add
additional content, choose whether a view is private or public, and you can filter the data that is displayed.

You can customize the following views.
» Basket view

« Financial Summary view

o Sticker Book view

Customized View Content
You can add or remove the following view content.

Content Description

Element

Commercial Enables you to select a specific term type to be included in the view. A term is a combination
Data of a value and a set of conditions.

Attribute On Displays the attribute values of the selected reference type.

Reference

Attribute Value Displays the value of the attribute.

Calculation Enables you to specify a calculated attribute formula. The result of the formula is then
displayed in the view.

ID Displays the IDs of the objects.

Image Displays a thumbnail of the image.

Name Displays the name of the objects.

On Pages Displays information about the pages the object is used on.

Product Count Displays information about the number of products in the view.

Space Usage Displays information about how much space a product takes up on a page.
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Adding View Content

1. Inthe Tree, expand the Publication hierarchy, then select a section or spread.

2. Onthe Plan tab, select Sticker View from the View list, click Show basket, or click the Financial Summary
tab.

3. Inthe upper right corner, click View Options, and then choose Edit. The Edit View dialog displays a list of the
current view content elements.

4. Click an element, right-click, point to Add, and then choose the element you want to add. The eight most
recently used elements are displayed. To view more content options, click Other ....

= Edit View e

| Element

e

Edit
Add ¥ Calculation

A

¥ Remove Commercial Data —

Space Usage
I Attribute Value
On Pages
Attribute On Reference
Product Count

Irmage

Cther ...

[ Ok H Cancel

5. Click OK, to save the view. By default, the view is saved as a private view and is not available to others.

Some content elements are added immediately and require no further action. However, for each of the following
elements, a dialog is displayed where you have to specify more information.

Attribute On Reference

« Fromthe Reference Type list, select the preferred reference type.

« From the Attribute list, select the attribute whose value you want to be displayed.
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Attribute Value

Click the ellipsis points (...), and then navigate to the preferred attribute.

Calculation

« Inthe Name field, enter a name for the calculation.
« Inthe Formula field, click the ellipsis button (...), and then specify the preferred formula.

For detailed information about calculations and how to specify functions, see Calculated Attributes and Function
Editor in the Attributes section of the System Setup guide.

Commercial Data
« Inthe Data Type list, select the preferred data type.

« Inthe Break No. field, enter the quantity break number of the quantity span that you want to be displayed.
o Fordetailed information, see commercial data

« Ifyour price list contains multiple prices for the same product covering different quantities and/or date spans
(also called quantity breaks), use the Group field to map the various price groups. Quantity breaks are
numbered from 1 and up.

Image

« Inthe Reference Type field, enter the type of image to be displayed.

« From the Size list, select the preferred image size.

Copying Views

In some cases it can be useful to copy an existing view before creating a new customized view. For example, when
you want to create a view that, with a few exceptions, is similar to an existing view. If you want to rename a view,
you also have to copy the view before you can rename it.

To Copy a View

1. Onthe plan tab,select Sticker View from the View list, or click Show basket or click the Financial Summary
tab.

2. Inthe upper right corner, click View Options, and then choose Copy. The Copy Column View dialog is
displayed.

3. Inthe Copy to ... field, enter the name of the new view, and then click OK. You can now select the view from
the view list.
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Deleting Views

1. Onthe plan tab, select Sticker View from the View list, or click Show basket or click the Financial Summary
tab.

2. Inthe upper right corner, click View Options, and then choose Delete. A dialog is displayed asking if you want
to delete the view. Click Yes.
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Filtering Views

Filters allow you to view a subset of data. Instead of viewing all data in Basket view or Financial Summary view,
you can choose which data you want to see at any given time.

To Filter Information

1. Onthe plantab, click Show basket or click the Financial Summary tab.
2. Right-click a column header, and then choose Filtering enabled. A row with filtering options is added.
3. Inacolumn, click the arrow « , and then choose the preferred filtering options. You have the following options.

Filter Options Description

All Displays all data.

Empty Values Displays only fields with empty values.

Non Empty Values Displays only fields with values.

< (less than) Displays only values that are less than the number you specify.

> (greater than) Displays only values that are greater than the number you specify.
Contains Displays only values that contain the string you specify.

Equals Displays only values that match the text you specify.

Begins with Displays only values that begin with the text you specify.

Ends with Displays only values that end with the text you specify.

Public and Private View Options

Views can be public or private. Public views are available to all users. Private views are only available to the user
who created them.
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To Make the Current View Public

1. Onthe plan tab, select Sticker Book from the View list, click Show basket, or click the Financial Summary
tab.

2. Inthe upper right corner, click View Options, and then choose Public or Private.

« When you select Public, all users can select the view from the view list in the upper left corner. A Public view
has "- Public" appended to its name.

« When you select Private, the view is only available to you from the view list in the upper left corner.

Restrict Users From Maintaining Public Views
Users may not create, edit, or delete public views of the basket, financial summary, publication planner, or sticker
book unless they have the privileges to do so. The following four user actions enable these privileges:

« Maintain public basket view

« Maintain public financial view

« Maintain public publication planner view

« Maintain public stickerbook view

 Acton et |

» Maintain GDSM publications

* Maintain GOSM registrations
» Maintain packaaging hierarchy

Maintain public basket view
Maintain public finandal view

Maintain public publication planner view

Maintain public stickerbook view

» Manage autopage objects

Users who are not granted these privileges will have the option to maintain individual private views only, thereby
blocking the possibility of a user saving a private view over a public view. Non-privileged (restricted) users may
copy a public view and configure this copy to their individual preferences, but this copied view will be Private and
only visible to the user who created it.

In a Public view, the following 'view options' commands are disabled for restricted users: Edit, Delete, Public, and
Private.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 98



StiboSystems

l Publication Section ]m[ Publication Planner " Financial Summary ]

Column View: I :Default - Public | - Copy
i * Mame Edit él
I-SalesTtem-1111 N 2C-YLISO0A .
I-SalesItem-1121 N 2\ C-XNPR 746 CG& i
[-Salesltem-1122 N C-YFXNGTS Delete | I
I-SalesItern-12111 B - JNG551- 168K 71 Pubkc
I-SalesItem-12112 PN 2o JN5551-168U _
[-SalesItem-12113 PN AC-JNG551-32BK Private § [
I-SalesItem-12114 M - JNG551-32BU
I-SalesItern-13111 B 2\C_P7000-55

In a Private view, Edit and Delete are enabled, but Public and Private remain disabled.

See the About Privilege Rules section of the System Setup / Super User documentation for more information
on the setup and configuration of user privileges.

Removing View Content

Just as you can add view content, you can remove view content as well.

1. Activate Basket view, Financial Summary view or Sticker Book view.

2. Inthe upper right corner, click View Options, and then choose Edit. The Edit View dialog displays a list of the
current content elements of the view.

3. Click the element you want to remove, right-click, choose Remove, and then click OK.

Sorting and Show Options in Basket View

By using the sort options, you can arrange the data in Basket view in ascending or descending order.

1. Onthe plantab, click Show basket or click the Financial Summary tab.

2. Right-click a column header, and then choose the preferred sort order.

« Sortascending: sorts alphabetically from A to Z or from the smallest to largest number of data.

« Sortdescending: sorts alphabetically from Z to A or from the largest to smallest number of data.

In Basket view, you can also choose to see where an object is used in the planned pages.

« In Basket view, right-click a column, and then choose Show in plan. The object is selected in the planned
page.
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Reusing Saved Layouts

When a document has been finalized in InDesign, and saved back to the STEP database, you can reuse the
layout of that document.

There are two ways of reusing layouts.

« Keeping the finalized layout of the actual page that matches the planned page.
« Using the layout of a different publication that has been saved back to the STEP database.

Keeping the Saved Layout of an Actual Page

When a document that has been finalized in InDesign is saved back to the relevant publication in the STEP
database, the product layouts of the planned pages are automatically picked up from the actual pages. This means
that the product layout defined for the mounted products on the planned pages is overridden.

« Todetermine if a product uses a saved layout, select Plan view, and then Show Product Templates view.
Keep Layout is displayed at the bottom of the frame instead of the name of the product template.

You can revert to the old layout of the planned pages because the old layout rules are overridden but not deleted.

To Revert to the Planned Layout

1. Inthe Tree, expand the publication hierarchy, and then click the preferred section or spread.
2. Onthe Plan tab, right-click the white area of a page or select a product frame and right-click the frame.

3. Pointto Layout, and then select Revert to Planned Element Layout.
The layout of the selected product or all products on the page reverts to the planned layout. When you view the
name of the product template, a T: is displayed.

To Switch Back to the Saved Layout

« Onthe Plan tab, right-click the white area or select a product, and then right-click the product.Point to
Layout, and then select Keep Saved Element Layout.

Using a Saved Layout from Another Publication

You can reuse layouts from all publications that have been saved back to the STEP database after having been
finalized in InDesign. This is called Pickup Layout. You can pickup both product and page layouts.

Finalized documents are located in the tree in a node called DTP Documents under the associated publication.

To Pickup a Saved Page Layout

1. Inthe Tree, expand the publication hierarchy, and then click the preferred section or spread.
2. Onthe Plan tab, right-click the white area, point to Layout, and then select Pickup Page Layout.
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3. Inthe Pickup Page Layout dialog, navigate to and expand the relevant publication and DTP Documents
folder, and then click the preferred page. A preview of the selected page is displayed.

Pickup page layout for: Faucet g

El OTP Documents i
==l 2 - Faucet
-----
..... E 2 _AP1 i
----- 2-Base B -FR All Al
| {1 T S oo 3 -BP1
----- 3-Base A -EN All Al
..... E 3-AP1
----- 3-Base B -FR All Al
----- 3-BP1

tH- [§8 Electrical artides ; [

m | »

m

-

(|

- 4 |00 I

P =N

[ Use selected H Cancel ]

i —

1. Click Use Selected to apply the layout to the planned page.

To Pickup a Saved Product Layout

In the Tree, expand the publication hierarchy, and then click the preferred section or spread.
On the Plan tab, select the frame that contains the object that you want to apply the layout to.
Right-click the frame, point to Layout, and then select Pickup Layout.

A wbd -

In the Pickup Layout dialog, navigate to and expand the relevant publication and DTP Documents folder,
and then click the preferred page. A preview of the selected page is displayed.

5. Click Use Selected to apply the layout to the product.

If you decide that you don't want to use the product or page layout that has been picked up, you can revert to the
planned layout as described previously.
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Finalizing Pages in InDesign

Pages created with the Flatplanner can be finalized in InDesign. You can use the standard InDesign tools in
combination with the STEP'n'design plug-ins. The STEP'n'design plug-ins enable you to connect to the STEP
database and work with InDesign documents as dynamic documents.

This has a number of advantages:

« You have access to approved text and images that are ready for layout
« You can view notes and comments added to the pages in the Flatplanner

« You can save finalized documents back to STEP

Overview of the STEP Menu in InDesign

« When the STEP'n'design plug-ins are installed in InDesign, a STEP menu is added to InDesign's menu bar.
The STEP menu gives you access to specific STEP'n'design functions and enables you to perform a range of
operations on the active InDesign page.

o The STEP palettes (also known as panels) are used for actual mounting of STEP data, including template
composition and image mounting. The STEP palettes consist of six different tabs: STEP Structure View,
STEP Template Content, STEP Template Frame, STEP Images, STEP Tasks, and STEP Publication View.
The tabs are used like other InDesign panels.

For more information, see the following STEP'n'design introductory topics:

« Installing STEP'n'design
« Description of the InDesign Interface
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Mounting Planned Pages

This section provides information about mounting planned pages and finalizing pages in InDesign when working
with STEP Flatplanner. It also contains a description of how to update planned pages and how to use a workflow
when using STEP Flatplanner.

This topic assumes the following:

« Products have already been linked to planned pages in the Flatplanner
« You have already logged into the relevant STEP system from InDesign using the STEP'n'design plugin

Note: Before mounting your pages, make sure that you are working in the correct publication version. The
current version is displayed at the bottom of the STEP Publication View panel (e.g., 'Spring Wedding Catalog /
English US"). For information on how to change your current version, see Working With Version Layers in the
STEP'n'design documentation.

Mounting Planned Pages Using a Stored Publication Template

If using a publication template already stored in STEP, there is no need to have an InDesign document already
open to mount your pages. In fact, there is no need to even have the templates saved on your local machine.

Follow these steps to mount a planned page in InDesign by using documents stored in STEP and not on your local
computer.

Note: When using this method, you should mount the left side of a spread first (the even-numbered page), then
the right side (odd-numbered) next.

1. InInDesign, navigate to the STEP Publication View panel by navigating to Window > STEP Publication View
from the InDesign application bar across the top of the InDesign interface.

2. Inthe STEP Publication View panel, navigate to the even-numbered page that you would like to mount, then
right-click and select Create document from plan. (You can also access Create document from plan by
clicking on the options dropdown menu in the upper right corner of the STEP Publication View panel.)
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| STER STEF STEF STEF ¢ STEP Publication View

g
= [ Flatplanner Publications
= [ Spring Wedding Catalog
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[ (@B Party Favors
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= [l Decorations
R 12 - Tablechoths
13 - Tablechoths
[ 14 - Ribbans

[ 15 - Ribbans

.....

111

FR17 - Sweames

URL ...

[» [ Cake Toppers Mount planned page
[ ESiHair Accesseries Mount on current page
[+ [ Drinkware

Create document from plan

[+ Bl Mapkins

Import notes

v Scroll to page
Refresh
Clear template document type
Show 4

Spring Wedding Catalog / English US |

In a few moments (depending on your system's speed), the InDesign page will generate in the background,
then automatically open with the mounted Flatplanner content. This page (the even-numbered one) will be a

single page.
. To mount the second page in the spread, right-click on the next page (the odd-numbered page) in the STEP
Publication View, then click Mount planned page.
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In a few moments (depending on your system's speed), the second InDesign page in the spread will generate
in the background, then automatically open as the right page of the spread, complete with its mounted

Flatplanner content.
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6. Make additional changes to the document as needed. These changes could include adding standalone
graphics, manually manipulating the layout of objects, or even dragging and dropping additional elements onto
the page from the STEP Structure View or STEP Images panels.

7. Save the document locally, then save itinto STEP. (See the Saving the Mounted Spread to STEP section
later in this topic for instructions.)

Mounting Planned Pages Using a Mounting Page

Even though a publication template is required to be stored in STEP in order to create publications and generate
proof views, designers will often choose to build pages using a document called a mounting page. A mounting
page is not generated using STEP'n'design, nor is it saved into STEP. However, it functions like a publication
template in that it contains all the paragraph styles, swatches, background elements, etc., that would typically be
included on a publication template.

Note: If you would like to mount metadata (description) attribute values from a publication, section, or planned
page object onto your InDesign page, the associated STEP'n'design tagging must be present on the publication
template and/or page template(s) that are stored in STEP and linked to your publication. This information cannot
be mounted to the InDesign page using a mounting page alone.

Follow these steps to mount a planned page in InDesign by using a mounting page that is saved on your local
machine:
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. With your mounting page open in InDesign, navigate to the STEP Publication View panel by navigating to
Window > STEP Publication View from the InDesign application bar across the top of the InDesign interface.

2. Inthe STEP Publication View panel, navigate to the page that you would like to mount.

3. Select the InDesign page (left or right side of your mounting page) onto which you would like to mount the

Flatplan.

. Right-click your page in the STEP Publication View panel and select Mount on current page. (You can also
access Mount on current page by clicking on the options dropdown menu in the upper right corner of the
STEP Publication View panel.)

Note: If the Flatplan mounts on the incorrect page, navigate to the Pages panel in InDesign (Window >
Pages) to ensure that the correct InDesign page is selected.

44 X

El El §| §| { STEP Publication View =

[» ﬁ Avtopage Publications o
- ﬁ Flatplanner Publications
w7 [l Sering Wedding Catzlog

[» March Exchsives
[» Party Fawvors
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111
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[ 14 - Ribbons
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F

- o URL..
b [l Cske To Mount planned page

b ([ Hair Acc Mount on current page
[+ (@ Drinkowas

Create document from plan
Import notes

|: v Scroll to page

Refresh

Clear template document type

Spring Wedding Catalog Show

. Follow the same steps for the other side of your spread.

. Make additional changes to the document as needed. These changes could include adding standalone
graphics, manually manipulating the layout of objects, or even dragging and dropping additional elements onto
the page fromthe STEP Structure View or STEP Images panels.

. Save the document locally, then save it into STEP. (See the Saving the Mounted Spread to STEP section
later in this topic for instructions.)
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Mounting Planned Pages Using a STEP Workflow

Flatplanner workflows can be configured with built-in functionality to automatically mount planned pages using an
InDesign server, which is linked to the STEP application server as a sidecar. When InDesign pages are
automatically built by an InDesign server, the workflow tasks performed by DTP users of Flatplanner workflows
involve opening pre-mounted pages and making layout adjustments to them before saving back to STEP.

For more information on how to open pre-mounted pages in InDesign in conjunction with the Flatplanner
workflow, as well as save these pages back to STEP once completed with the workflow task, see the Flatplanner

Workflows documentation.
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Saving Mounted Planned Pages to STEP

Once your planned page has been mounted in InDesign and all necessary changes have been made on the page,
the typical next step is to save it back to STEP.

Though it is optional to save mounted InDesign documents back to STEP, these documents must existin STEP in
order to take full advantage of STEP's publishing capabilities, such as extraction of product indexes and
calculation of space usage.

To save a mounted InDesign document back to STEP, follow these steps:

1. With your mounted document open in InDesign, first save it to your local computer.

Note: InDesign documents must first be saved locally before they can be saved to STEP.

2. Next, navigate to STEP > Save Document to DB from the STEP menu (which appears in the InDesign
application bar across the top of the InDesign interface). The Save Document to STEP Database dialog box
displays. The section folder from which you mounted your planned page should be automatically selected. (If
not, navigate to the correct section.)

Save Document to STEP Database
Structure Point

|7 @ Autopage Publications
- @ Flatplanner Publications
= [l Spring Wedding Catzlog
[ March Bxchisives
[ Party Favors
[+ [l Cards & Stationery
[ [E5) Cake Toppers
[+ [ERHair Accessories
[+ (@ Drinkware
[» {8 Napkins
I Hallowieen Catalog
I Chiistmas Catalog
I Mews Publication
I Acme Party Supplies
[ B WebUIPubicationTypes
[ [ TempwebUIPublications
V3 |_'_=|Pr'|mar\,r Product Hieraschy

111

1

Save Document and Page information -

|:| Close document and delete local copy

[ ok ][ Cancel |
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3. Fromthe dropdown list, select Save Document and Page Information (default) or Save Page
Information.

Choose Save Document and Page Information to save page information (such as page numbers and
space allocation) into STEP as well as the actual InDesign page itself. This option stores these documents in
the database for you and other users to access later.

Select Save Page Information if you would only like to save page information into STEP. This option will save
a thumbnail of your page to STEP but not the actual InDesign page itself. Some users may prefer this option in
order to save space on their STEP application server.

4. Check Close document and delete local copy if you would like to save the document to STEP, then have
the local copy automatically deleted from your computer.

5. Click OK. The document is saved back to STEP within the correct publication.

Note: Once mounted pages from a Flatplan are saved back into STEP, the frames on the Flatplanner page (in
the Plan view) now display 'Keep Layout' instead of the name of the product template that was previously applied
to the frame. If the planned page is mounted again, the layout from the saved actual page will be used instead of
the layout from the original product template. For more information about layout rules and reusing saved layouts,
see the Reusing Saved Layouts topic.

Viewing Mounted Actual Pages in STEP

Mounted InDesign pages that are saved back to STEP are linked back to their original Flatplans through
hyperlinks and can be viewed in multiple locations in STEP. The linking that exists between actual pages and
Flatplans enables easy toggling between the original plan and the actual page.

The following list shows how actual pages, once saved back to STEP, are linked to Flatplans:

1. Inthe Flatplanner, hyperlinked page numbers appear in the upper left- and right-hand corners in all Views
(Plan, Preview, Sticker Book, and Mounted Pages).
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2. Click one of these hyperlinked page numbers to go to the Page data tab of the actual page. Click the page
hyperlink below the actual page thumbnail to return to the Flatplan.
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3. With the actual page document selected in the Tree, hyperlinks to the Flatplan appear beneath the thumbnails
of the actual pages on the Pages tab.

[+ &) Autopage Publications a
I?]ﬁ Flatplanner Publications
=

€16 - Streamers rev.2.1 - Pages -

Document M References || Status
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G- Commercial Data
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=l DTP Documents I
=] 10 - Napkins
&l 12 - Confetti
=2 16~ Streamers —

#-[E8 Cake Toppers
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- E8 Drinkware v

Tl | »

Saving Empty Mounted Pages Back to STEP

Pages in Flatplanner spreads must sometimes be left empty in order to allow space for content outside of STEP.
Examples of content that designers may add from outside of STEP include full-page graphics or advertisements.
A spread with an empty page is saved back to STEP in the same fashion as if both pages in the spread contained

content.

Sometimes, however, an Error warning (outlined in the below screenshot) will appear when saving back an
empty page. This typically happens if the empty page was manually added to the spread in InDesign (or was
already present in the mounting page) and was not mounted from an empty Flatplan (i.e. a Flatplan that contains
frames but has no linked products).
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Save Document to STEP Database
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If you receive this error and ignore it, your empty actual page will be saved back to STEP but there will be no
hyperlinks connecting it to the Flatplan, as pictured below:
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If you receive this error and would like to have your empty actual page linked to a Flatplanin STEP, follow these
steps:
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1. Click on the ellipsis button next to the Error status (outlined with a red frame in the first screenshot in this
section). A Choose Plan dialog displays.

2. Inthe Choose Plan dialog, navigate to the Flatplan (planned page) to which you would like to link your actual
page, then click OK.
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3. The empty actual page is saved to STEP and contains a hyperlink to the selected Flatplan.
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Opening Mounted Flatplanner Pages in InDesign

If changes need to be made to mounted pages after they are initially saved in STEP, they should be opened from
within InDesign, not from your local computer.

When a page in STEP is opened from within InDesign and edited, saving this page back to STEP from within
InDesign will overwrite the page that was previously saved. If you make edits to a page from your local machine
instead, then save that document back to STEP, a new document will be created in STEP and this document will
not be linked to the original Flatplan.

To open mounted Flatplanner pages from the STEP Publication View panel, follow these steps:

1. InInDesign, open the STEP Publication View by navigating to Window > STEP Publication View from the
InDesign application bar across the top of the InDesign interface.

2. Next, make sure that you are working in the correct publication version in InDesign. Your publication version
will be displayed at the bottom of the STEP Publication View palette; for example, Spring Wedding Catalog /
English US.
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3. Ifthe displayed version does not match the publication that you are working with, navigate to STEP > Change
Version to change to the correct version.

Siep | B oo v | v
Connect to DB ...
Reload

Update Document Data ...
Layer Version Update ...
Check DB Update ...
Cleanup Mount Tags

Preferences ...

Change Version ...

Table Settings ...

Save Document to DB ...
Writeback to DB ...
Dump Document Data ...
Relink Assets

4. Inthe Change Version dialog that displays, select the correct publication version, then click OK.

Change Version

[ @Templahs -

[ [ Standand Publications

[ @ Autopage Publications

4 @ Flatplanner Publications

4 Spring Wedding Catalog

[E5Erclsh UK
[EgErcish Us
[ French FR

[» Hallowesn Catalog

[ Cheistmas Catalog

[ New Publication

[ Acme Party Supplies
[» [ WebUIPublicstionTypes
[» [ TempWebUIPublications

( oK ] [ cancel |

5. Inthe STEP Publication View, navigate to the Flatplan for the page that you would like to open. With the
page object selected, right-click and select Open actual page.
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5T| 5T\ 5T| 5T| & STEP Publication View

g
= [ Flatplanner Publications =
= [ Spring Wedding Catzlog
[ (E8 March Exchssives
[ (@B Party Favors
[ (@Bl Cards & Stationeny
= [l Decorations
R 12 - Tableckoths
R 13 - Tableckoths
[ 14 - Ribbons

111

Do URL ...
[+ [ Cake Toppers Create document from plan

I Open actual page

v Scroll to page
Refresh
Show r

6. The mounted page that was saved back to STEP will open. If the page was saved as part of a spread, both
pages in the spread will open.

7. Make any changes to the page as needed, then save it back to STEP by following the same steps outlined in
the first section of this topic.
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Updating Documents in Flatplanner

After a document has been saved back to STEP it is possible to update page cells from the STEP Publication
View palette.

Note: If a page needs to be updated, then a 'not equal' symbol #is shown in the Preview area of the STEP
Publication View.

1. Click the relevant page in the Preview area of the STEP Publication View.

M —m
- % |
| STER | STEF | STEF | STEF | = STEF Publication Yiew =

=7 [Hl Hatch 2306
= [EH Section 1

N
B fil

5 - Paga 4

@E -Page b

7 -Page B

3 - Page 8
79 - Page 2
(510 - Page 10
(11 - Page 10

512 - Page 12 |

Patch 230-6 [ English version

2. Expand the Options menu, and then click Update page celi(s).
The page cell is updated.
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Using the getinheritedPublicationValue Function in
Flatplanner

The calculated attribute function 'getinheritedPublicationValue' is used to pick up metadata (Description) attribute
values from section, publication, and publication group objects. Use cases for this function include the display of
publication-related metadata on mounted product objects, in Flatplanner Sticker Book views, and on Flatplanner
planned pages.

When valid for Flatplanner planned pages, calculated attributes using the 'getinheritedPublicationValue' function
can be used to mount publication metadata onto InDesign pages by way of InDesign tagging applied to the
publication template. This functionality allows users more dynamic control over content that exists as 'furniture’
(publication template elements) on page spreads. For example, a section-level description attribute that identifies
the 'theme’ of the Section could be displayed on side tabs or headers of mounted pages, reducing manual work on
publication templates and mounted pages.

The following steps describe how to use the 'getinheritedPublicationValue' function to pull metadata values from a
section, a publication, and a publication group onto an InDesign page mounted from a Flatplanner planned page.

Configuring the Calculated Attribute(s)

1. Create a calculated Description attribute using the 'getinheritedPublicationValue' calculated attribute function
by following these steps:

« After creating the attribute, right-click in the Value template field on the Attribute tab and select Edit
Function. The Function Editor will open.
« Click Insert Template, then expand the Publishing Functions section of the Default Templates.

« Select 'Find an attribute value in the publishing (green) hierarchy' and click OK. The Insert Template
window will close.

« Inthe Function Editor, replace ‘Attributeld’ with the ID of the metadata attribute that you would like to pull
onto the page.
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F-User Defined Templates

I'él--DEfauIt Templates

[+ Conditional Functions

--Text Functions

[+}-Attribute Value Functions

--Number Functions

--List Functions

--F‘.eferen::e Functions

--Dam Container Functions

--Hiv.=_~rar|::h1,-I Functions

-l Functions

--Address Formatting Functions

E}--Publishing Functions

--Find the first page number in the section

--Find the last page number in the section

--Find an attribute value for an offer in a location
--Find the value of a commerdal list and breakpeoint in a location

Description

Return the value of an attribute from within the
publishing hierarchy - looking up the hierarchy
until a value is found

~Find an attribute value in the publishing (green) hierarchy |
-Find an attribute value in the publishing (green) hierarchy for p

Template

(et the publication of the current page or section.

getInheritedPublicationvalue ' AttributeId")

Cancel

2. Make the attribute valid on Planned Page objects by following these steps:

« Under System Setup, navigate to Basic Object Types > Planned Page

« Onthe Object Type tab, click Add Attribute, then select the calculated attribute(s) that you would like to
place on your publication template. In this example, three calculated attributes have been created: one to
pick up values from Section objects (ID = GetlnheritedSectionValue ), one to pick up values from publication
objects (ID = GetlnheritedPublicationValue), and one to pick up values from publication group objects (ID =

GetInheritedPubGroupValue).
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< Planned Page - Object Type

References [m

@ Desaipfon
Mame | |Value

* D Flanned Page

* MName Flanned Page

* Last edited by 2015-09-23 09: 40:44 by USER

* Mame Pattern

* [D Pattern [id]

* con

* Dimension Dependencies

> Get Inherited Pub Group Valy # Acme Party Supplies - Since 1905

3 Get Inherited Publication Valy # SPring Wedding 2015

» Get Inherited Section Value | & MN/A

@ valdatibutes
D * |Mame

* GetInheritedSectionValue et Inherited Section Value

» GetInheritedPublicationValue Get Inherited Publication Value

» Eet[nheritedPuberpHalue et Inherited Pub Group Value

1 Add Attribute I
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« GetlnheritedSectionValue [using the formula getinheritedPublicationValue('SectionTheme')] will pick up
the value of the description attribute SectionTheme:
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Publication Section [ Plan ” Publication Planner
® Descripti

Mame * | > |Value
* 1D 108202
* Mame Party Favors
Object Type Section
» Revision 0.1 Last edited by LI
» Path Publications/Flatplan
» Gtart section on page 1
» Circulation 122
> Cover Photo Shot Due & 2015-09-17
» Effective Date Ex|
» Expiration Date En|
» Mail Date (same as Effective | &
Section Theme ahe Party Fawors
* Total Number of Items 123
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GetlnheritedPublicationValue [using the formula getinheritedPublicationValue('CatalogTheme')] will

pick up the value of the description attribute CatalogTheme:

[ Plan " Version ” Pages ” Publication Planner ]
& Descripti

MName | » |Value
> D 108199
» Mame Spring Wedding Catalog
Object Type Publication
» Revision 0.5 Last edited by USER. on Wec
» Path Publications/Flatplanner Publicat

W

Fages per spread

2

W

Auto page Document Level

1

W

Publication template

Wedding Pub Temp (109967)

* Dutput engine InDiesign
* DTP Queue

Catalog Theme abe Spring Wedding
» Circulation 123

GetlnheritedPubGroupValue[using the formula getinheritedPublicationValue('CatalogGroupTheme')]

will pick up the value of the description attribute CatalogGroupTheme:
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Publication Group [ Status l
® i

Mame * | > |Value
* 1D 108198
» Mame Flatplanner Publications

Object Type Publication group types
» Revision 0.1 Last edited by USER. on Wed Sep
» Path Publications/Flatplanner Publications
» Unit " inches

Catalog Group Theme abe ACmME Party Supplies - Since 1905 I

» Circulation 123

Navigate to a Planned Page object to confirm that the values are displaying correctly.

[+-Jjijj Entity Root

Plan [MEELRNTRELTEN | References || Status |State Log || Task
Eﬁ Publications

ﬁ Templates ¥

W

= Get Inherited Pub Group Vald £ #Acme Party Supplies - Since 1905
-] OTP Documents

[ [l Glassware
[+}[E8 Cards & Stationery
[#-[E8 Decorations

W

et Inherited Publication ValJ £ Spring Wedding 2016

W

Get Inherited Section Value | & Farty Favors

| Mame ¥| > |Value

o B} standard Publications

EI -} Autopage Publications * D 108309
— = [ Flatplanner Publications > Mame Confett

= Al 2 ;

) &30 Spring Weding Catalog > Revision 0.3 Last edited by USER on Wed Sep
m % Commerdal Data

ﬁ 1| Party Favors * Path Publications,Flatplanner Publications !
] : "

g ~ | phetasaliumbe 4

i ﬁ & - Napkins

[~}

Z

L)

i

E
z

Note: Calculated attributes related to publishing functions cannot be tested in the Function Editor, as

publication hierarchy [green] objects are not among the available options when selecting an object as the
Evaluation Node.

Configuring the Publication Template

1. Place the attributes on the publication template just as you would place attributes on a product template. Note:

attributes must be placed on the page spread, not the master spread.
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<STEPREF A="ObtainAttrvalueFromPublication” /=

A
~
§
S
e
o
=
g
£
£
¥
<
[T
wl
[
o
%

- [ =STEPREF A="ObtainAttvalueFromPublicationGroup™ /=

=STEPREF A="ObtainAttrvalueFrompPublicatio n”-.-f’T

<STEPREF A~ ObtainAttnvalueFramPublicationGronp” 2|

a
t=
[=]
:
e
|
z
5
:
8
X
[V
Ll
[+
b
7

2. The publication description attribute values will display on the mounted page in InDesign and the Flatplanner

Preview view.
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For More Information

See the Calculated Attribute Functions section of the System Setup / Super User documentation for general
information on calculated attribute functions.

See the following sections of the STEP’n’design documentation for more information on building and configuring
publication templates and product templates:

« Publication Templates

o Product Templates
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Generating PDFs in Flatplanner

When you have planned your pages in the Publication Planner, you can generate PDF proofs of the planned
pages to ensure that they look the way you want them to.

You can also generate a PDF that only includes pages that have already been completed in InDesign and saved
back to STEP.

To Generate a PDF from a Publication or Section

1. Inthe Tree, expand the Publication hierarchy, and then select the relevant section or spread.
2. Onthe Plan tab, right-click in the white area of the page, and then choose Generate PDF. The Generate PDF
dialog appears.

Note: Clicking on either the left-hand page or the right-hand page will generate a PDF of both pages in the
spread.

3
1
Set t late...
TR page template
Layout
View

Generate PDF I
Print planned pages...

Add MNote....

Insert frames on a grid

3. Inthe PDF Profile list, select the preferred profile.

E] Generate PDF ﬁ1

POF Profile: :Defaulti -

Only actual pages: [

Delivery Plugin: Default POF Delivery plugin - '

[ Ok ][ Cancel ]
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Note: PDF profiles are system dependent. Therefore, the PDF profile is set to Default if no special PDF
profiles have been configured for the system. For more information on creating new PDF Profiles for your
system, see the Setting up PDF Profiles (Presets) for the InDesign Server topic.

4. If youwantthe PDF to only include pages that have been completed in InDesign and saved back to STEP,
check Only actual pages.

5. Click OK.
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Printing Planned Pages

You can print planned pages from the Promotion Planner.

1. Inthe Tree, expand the publication hierarchy.
2. Click the relevant publication, expand the hierarchy and select the section or spread you want to print.

3. Onthe Plan tab, right-click the white area, and the choose Print planned pages. The print dialog appears.

[ E Print - @

Printer: Hiaarprint LCTOTE ]

Page size: | pq

-
Orientation:  |[portrait - |

Print:

i@ Pages
i ] i
N (") Spreads
i Copies: i 1
Pages: @ Al
i) From: 2 To: 5

[ Print H Cancel

From the Printer list, select the relevant printer.
From the Page Size list, select the relevant page size.

From the Orientation list, select the relevant page orientation.

N o o A

Select Pages if you want to print a page on each page or select Spread if you want to print a spread on each
page.

8. Inthe Copies field, enter the number of copies you want to print.

9. Select Allto print all pages or select From to define the range of pages you want to print.
10. Click Print.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 129



StiboSystems

Publication Planner

The Publication Planner is used to control the sections and pages of a publication. You can perform the following
tasks in the Publication Planner:

« Insert or remove pages and sections

« Reorder the sequence of pages and sections

Apply page templates to pages
« Startand stop workflows
« View information related to the plan page or frame contents

To View the Publication Planner

« Inthe Tree, select a publication or a section, and then click the Publication Planner tab.

Using the Publication Planner with Flatplanner Workflows

Using the Publication Planner with Flatplanner workflows is covered in the Flatplanner Workflows
documentation.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 130



StiboSystems

Configuring the Publication Planner Column View

The columns in the Publication Planner are configurable by using the Column View dropdown at the top of the
editor. The entries in the Column View dropdown are managed by the View Options dropdown at the top right of
the editor. For more information about creating a customized view, see the Customized Views documentation.

Customized View Content

You can add or remove the following view content within the Publication Planner.

Content Description

Element

Assignee* Displays the current user assigned to the spread

DTP update Displays the result of a previously performed comparison between the data held on an
needed actual page for the planned spread and that active in the step database

Frame Displays the frame ID

Group by Adds a tree like control for each section and groups the planned pages under them.
section

ID Displays the ID of the first page in the spread.

Name Displays the name of the spread

Next Milestone | Displays the next milestone date based on the milestone configuration and the workflow's
Date* next milestone.

Next Milestone | Displays the next milestone name as defined by the workflow business rule actions.
Name*

Page Attribute Displays the value of an attribute from the planned page (attribute is configurable).

Page note count | Display the number of notes applied to a page.

Page Number Displays the page number of the planned page
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Description

Page Template

Displays the page template assigned to the plan

Plan to Actual
update needed

Indicates if the plan has been updated since the actual page was last worked on and saved
to the database.

Product

Displays the Product assigned to a frame.

Section name

Displays the name of the section

Status Displays the currently workflow state

Thumbnail Displays a thumbnail of the actual page if one has been produced for the plan
Traffic Light Displays the name of the attribute calculated as the milestone date color
Name*

*Requires a STEP Workflow component license. The columns Next Milestone Date, Next Milestone Name and
Traffic Light Name are colored according to the current date, milestone date and duration / color settings. For
more information about how to configure Milestones and Traffic lighting, see the Publication Milestones
documentation. For general information on Flatplanner workflows, see the Flatplanner Workflows

documentation.

Sorting / Filtering

Right clicking on the Publication Planner column headers shows a menu that allows the contents to be sorted /
filtered and columns to be added / removed from the current view.
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Publication Planner Actions

The Publication Planner supports the following actions by right clicking with one or more rows selected. Some of
the mentioned actions are described in more details later in this section.

Action Description

Add Section in

Created a new section on specified level

Create new Section
from existing...

Creates a new section in the selected section by duplicating from another.

Add Pages Before Creates additional Flatplan pages

Selected Page

Add Pages After Creates additional Flatplan pages

Selected

Page/Section

Autonumber pages Renumbers the Flatplan pages

Set page template Sets the page template on the selected Flatplan pages

Remove pages

Deletes the selected spreads

View Plan

Changes the workbench view to show the selected Flatplan

Assign Pages™

Sets the merchandiser assigned to the pages (if workflow is not active for the pages)

Start Workflows*

Starts the workflow for the selected Flatplan pages

Stop Workflows*

Stops the workfow for the selected Flatplan pages

Return task to default

Releases a current task that has been claimed by a user to the default group

group assignment* assignment.
Go to workflow Go to the workflow process in the workflow tab.
process*
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Action Description

Create InDesign
Package from
flatplans

Initiates a process that creates an InDesign package for the Flatplans

Import InDesign

Initiates a process that imports an InDesign package

Package

Generate PDF Initiates a process that creates a PDF of the pages.

Check for update Initiates a process that compares the STEP data mounted onto the InDesign
needed... documents with that in the database and reports if a difference is found.

Update... Initiates a process that updates STEP data mounted onto the InDesign documents.

Update actual page
with plan changes

Initiates a process that adjusts the actual pages for changes made to the Flatplan
pages (e.g. product swapped between pages).

Copy table to
clipboard for Excel

Copies the data displayed in the publication planner so it can be pasted into a
spreadsheet for external purposes.

*Requires a STEP Workflow component license. For more information about how to work with the Flatplanner
workflow, see the Flatplanner Workflows documentation.
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Changing the Page Order in the Publication
Planner

You can reorder pages in the Publication Planner.

Inthe Tree, expand the publication hierarchy, and then click the relevant publication or section.
Click the Publication Planner tab.
Click the + sign next to the name of a section to view the pages of the section.

Click the row that contains the page that you want to move, and then hold down the left mouse button while you
drag and drop the page to its new position.

Ao Dd -

When a page is moved, the page numbers are automatically updated.
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Changing the Page Template in the Publication
Planner

In the Publication Planner, you can change the page templates that are used on the different pages.

Inthe Tree, expand the publication hierarchy, and then click the relevant publication or section.
Click the Publication Planner tab.
Click the + sign next to the name of a section to view the pages of the section.

Select the row of the preferred page, right-click, and then choose Set Page Template. The Choose a Page
Template dialog appears.

Ao Dd -

- B
Choose a Page Template ﬁ

Left Page Template ;Market Publishing Page Template -

Right Page Template |Market Publishing Page Template -

[ oK H Cancel ]

5. Fromthe Left Page Template list, select the preferred template. To use different templates on the left and
right, click the Padlock button to unlock it.

6. Click OK.
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Inserting Pages Into a Section in the Publication
Planner

You can use the Publication Planner to manage pages of a publication.

1. Inthe Tree, expand the publication hierarchy, and then click the relevant publication or section.
2. Clickthe Publication Planner tab.

3. Click the + sign next to the name of a section to view the pages of the section.

4

. Right-click the row of the section where you want to add pages, then choose either Add Pages before
selected Page or Add Pages After Selected Page/Section.

[ Publication ” Flan " Version ” Pages ][ Financial Summary " AutoPage Publication Planner ” Fagination Rules

Column View: | Default - Public -
Assignee » Thumbnail > Mame
» -] Party Favors
» |uger Crnfath
user = F 7| Add Section In | - *
Create new Section from existing...
> e Add Pages before selected Page
bt
i . Add Pages After Selected Page/Section
Autenurmber Pages
» [+] Glassware
» [+] Cards & Stationery Set page template
> BT A Remove Pages
» [ Cake Toppers
» [+ Hair Accessories View Plan

5. The New Pages dialog appears.

rE] Mew Pages M1

Pages

First pagenumber |4

Mumber of pages |2

Page Template

[ Create H Canicel
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6. Inthe Number of pages field, enter the number of pages you want to add.
7. Inthe Page Template dropdown list, select the template you would like to use for the new pages.

8. Click Create to insert the pages.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 138



StiboSystems

Inserting Sections in the Publication Planner

The Publication Planner is used to manage the sections within a Flatplanner publication.

1. Inthe Tree, expand the publication hierarchy, and then click the relevant publication or section.

2. Click the Publication Planner tab.
3. Select a section, and then right-click the arrow =] next to the section row. If you want to add a subsection to an

existing section, make sure that you have selected the preferred section.

Choose Add Section In, and then click either the publication or a section from the list. The New Section dialog
appears.

i B
MNew Section ﬁ

Object Type

(7 Sub Section

Fages

Section ID 770256

Section Mame
First pagenumber | 16

Mumber of pages |2

Select page template

Page template | Use =
GetTerms\WaPageTemplate
Market Publishing Page T... |«
test
[ Create ] [ Cancel

1. Select whether you want to add a Section or Sub Section.

2. Inthe Section Name field, enter the name of the section.
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. Inthe First page number field, enter the page number that is the first page number of the new section.

4. Inthe Number of pages field, enter the number of pages you want the section to have.

5. Inthe Select page template area, click the Use field next to the template you want to use. A green check

mark appears next to the selected template.

. Click Create to insert the section.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 140



StiboSystems

Removing Pages in the Publication Planner

You can use the Publication Planner to remove pages and sections from a publication.

Inthe Tree, expand the publication hierarchy, and then click the relevant publication or section.
Click the Publication Planner tab.

Click the + sign next to the name of a section to view the contents of the section.

Ao bd =

Right-click a page, and then choose Remove Pages. If you want to remove multiple pages, hold down the
SHIFT key while you select the pages.

5. A warning message appears asking you to confirm the deletion. Click OK to confirm the deletion.
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Exporting and Importing Flatplanner Publications

Three formats are available for the export and import of Flatplans and Flatplanner publications: Flatplan Excel,
Publication Excel, and STEPXML.

Using Excel and/or STEPXML files to export and import Flatplanner publications can help reduce the time spent
on manual publication-building tasks in the workbench, such as the manual drag and drop of products out of
Flatplanner baskets onto Flatplanner frames or the manual linking of product templates to Flatplanner frames. If all
product and asset objects are already mapped to Flatplan frames on an importable Excel sheet or STEPXML file,
there is not even a need to populate a Flatplanner basket.

The import of Flatplanner publications and Flatplans is suitable for users who prefer to plan their publications
before building out planned pages in STEP. For example, businesses that publish sales flyers may receive page
planning information from an upstream ERP system that predetermines item placement based on analysis of
historical pricing and sales data. In this use case, planning decisions do not need to happen in STEP; users can
skip directly to the DTP page building process once their Flatplanner publication is built in STEP with the import.

Even for users who prefer to manually plan and build their pages simultaneously in STEP, the ability to export and
import Flatplans and Flatplanner publications greatly simplifies the migration of publications from one STEP
system to another, reducing the number of manual steps needed to duplicate and/or rebuild these publications.

The following sections of this documentation explain the information included in the Flatplanner import / export
formats, the similarities and differences between them, and where the information contained in these files exists in
STEP.

« Exporting Flatplanner Publications in Excel

« Importing Flatplanner Publications in Excel

« Exporting and Importing Flatplanner Publications in STEPXML
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Exporting Flatplanner Publications in Excel

The typical first step in using a Flatplan Excel or Publication Excel sheet to import a Flatplanner publication or
Flatplan is to export a pre-existing Flatplanner publication or Flatplan. This exported Excel file can then be used as
a 'template’ sheet to import new Flatplanner publications and Flatplans.

The Flatplan Excel format is only available for Flatplanner publications and supports the export of section-level
Flatplanner information, i.e., Flatplans. A Flatplan—also known as a plan—is composed of planned pages (also
known as spreads) and the product and/or asset objects that are linked to the Flatplan frames on these pages.
Flatplan Excel sheets contain information about the page templates used on each page and the product templates
used on each frame. Additional frame-level information, such as X /Y coordinates and frame height and width, is
also included.

While the Flatplan Excel format is only available for Flatplanner publications, the Publication Excel format
supports all publication types: standard STEP'n'design (‘drag and drop'), Flatplanner, and AutoPage. When used
to export Flatplanner publications, additional columns with information specific to Flatplanner are included in the
sheet.

The Flatplan Excel and Publication Excel formats are nearly identical in structure and functionality, but with a few
notable differences. While the Flatplan Excel format only includes section-level plan information, the Publication
Excel format includes more in-depth information about the entire Flatplanner publication.

A Publication Excel sheet could later be used to build an entire Flatplanner publication on import, whereas the
Flatplan Excel must be used with an existing publication. The Publication Excel format also contains the
following Flatplanner information that is not present in a basic Flatplan Excel sheet:

« Publication-level information that could be used to later create an entire publication on import (e.g.,
Publication ID, Version ID, Publication Template ID, and Version ID)

« Publication hierarchy metadata (description) attribute IDs and attribute values
« Pagination rules

« Layer mapping configurations

» IDs and object types of Flatplanner basket contents

« Frame type information (i.e., galley or object)

« Free Text frame contents

Note: The Publication Excel format is only available when exporting from the publication level. It is not available
for exports from the publication group level or section level.

Sample Flatplanner Publication Excel Export Spreadsheet

The following screenshots show a sample Flatplanner Publication Excel export spreadsheet in three sections—
columnsA-1,J-R, and S - AG. Columns shaded light yellow appear in both the Publication Excel and Flatplan
Excel formats. Both formats allow only one object per row.
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121311 Acme Party Supplies  Default publication type 103967

21113 EnglishUS  Contextt Main

121163

Dac-dev page temp
dxd

3

Y Ry By Uy )
S e T e e e e e e o e e el e el ]
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J K L M N 0 p Q R
1 SectionLevel ~SectionlD  SectionName  SectionTypelD MetaDataAtiributelD MetaDataAttibuteValue RuleSettings ~ BasketObjectD BasketObjectType
2 <Action ID="PublicationTemplateSpreadindexAction” Ty
3 CatalogTheme Acme Party Supplies
4
5 121171 Product
6 21177 Product
7 121178 Product
8 121179 Product
9 121184 Product
10 121192 Product
11 121193 Product
12 121180 Product
13 121182 Product
14 121183 Product
15 121190 Product
16 121218 Product
17 121175 Product
18 121176 Product
19 121200 Asset

20

21

2

23

2%

2

%

27N 121314 PatyHats  Section

28 SectionTheme Party Hats

eags 121316  PatyHats  Section

30 SectionTheme Party Hats
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5 T U v W X Y I (MM A|D| A AF AG
1 Pageiumber Pageame PaeTempae)  PagePickupl MourObct MowtObecType Prodcempste FrameD X ¥ Wi Heght Famefype TeComent  Assipedlsed)
12 Party Hats 121163
i) "1 T 8 725 K9 B0 Galky
ik m Product
U T Product
% 1190 Product
% 121163
7 1 B 07 01 B U5 Galky
i 21193 Product
® ghlE: Product
4 M Product
f
1
It
“l Confetti ~ Doc-dey page temp OTPUSER
3 109954 Product 109954 w10 0 3% UE Objt
I 109955 Product 103964 Mmoo AR n B R Ob
i T Asset 10394 m o B %% UE Obj
1 109953 Product 109954 m 4R B % UE Obj
1 Mo 08 103 2% 09 Obect  Funforeveryone!
5 Confetti  Doc-dev page temp
51 1049 Product 109964 w0 0 3% UE Objt
] 1H0m7 Product 109964 M 4E 0 3% R Objt
53 10046 Product 109954 m 0 R % UE Objt
7! 10050 Product 103964 m xR % UE Obj
% Napkins 0 OTPUSER
5 109954 Product 21073 w0 0 s Ue Obj
i 119955 Product 21073 w4 b s Ue Obe
3 119951 Product 21073 Mmoo B % Ue Ob
5 109953 Product 121073 W 4R B8 3% UE Objt
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Exporting Flatplanner Publications in Publication
Excel

The typical first step in using a Publication Excel sheet to import a Flatplanner publication and/or flatplan is to
export a pre-existing Flatplanner publication and/or flatplan. This exported Publication Excel file can then be used
as a 'template' sheet to import new Flatplanner publications and flatplans.

A Flatplan—also known as a plan—is composed of planned pages (also known as spreads) and the product
and/or asset objects that are linked to the flatplan frames on these pages. Publication Excel sheets contain
information about the page templates used on each page and the product templates used on each frame.
Additional frame-level information, such as X /Y coordinates and frame height and width, is also included.

The Publication Excel format supports all publication types: standard STEP'n'design ('drag and drop'),
Flatplanner, and AutoPage. When used to export Flatplanner publications, additional columns with information
specific to Flatplanner are included in the sheet.

Advantages of Publication Excel over Flatplan Excel

The Publication Excel format has many similarities to the Flatplan Excel format but has far more robust
functionality. For example, the Flatplan Excel format only includes section-level plan information, whereas the
Publication Excel format includes more in-depth information about the entire Flatplanner publication. Additionally,
a Publication Excel sheet can be used to build an entire publication hierarchy, including new publications, whereas
a Flatplan Excel must be used with an existing publication.

The Publication Excel format contains the following information that is not present in a Flatplan Excel sheet:

« Publication-level information that can be used later to create an entire publication on import (e.g., Publication
ID, Version ID, Publication Template ID, and Version ID)

« |Ds of page templates stored at the publication level

« Publication hierarchy metadata (description) attribute IDs and attribute values
« Flatplanner pagination rules

« Layer mapping configurations

« |IDs and object types of Flatplanner basket contents

« Page pickup IDs

« Frame type information (i.e., galley or object)

« Free Textframe contents

« Unique keys, when used instead of IDs to identify objects that are linked to baskets and frames. Unique keys
are specialized values as provided by external resources. For more information on Unique Keys, see the
Unique Keys topic in the Data Quality documentation.

For information on the Flatplan Excel format, see the Exporting Flatplans in Flatplan Excel topic.
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Sample Flatplanner Publication Excel Export Spreadsheet

The following screenshots show a sample Flatplanner Publication Excel export spreadsheet in three sections.
Columns shaded light yellow appear in both the Publication Excel and Flatplan Excel formats. Both formats allow
only one object per row.

A B C D E F G H |
1
2 12131 Acme Party Supplies  Default publication type 103967
3
4 U213 EnglishUS  Contextt Main
5
b
i
i
9
10
11
12
13
14
15
16
17
18
19 121163
2 Doc-tev page temp
21 dxd
2 33
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J K L M N 0 p Q R
1 SectionLevel ~SectionlD  SectionName  SectionTypelD MetaDataAtiributelD MetaDataAttibuteValue RuleSettings ~ BasketObjectD BasketObjectType
2 <Action ID="PublicationTemplateSpreadindexAction” Ty
3 CatalogTheme Acme Party Supplies
4
5 121171 Product
6 21177 Product
7 121178 Product
8 121179 Product
9 121184 Product
10 121192 Product
11 121193 Product
12 121180 Product
13 121182 Product
14 121183 Product
15 121190 Product
16 121218 Product
17 121175 Product
18 121176 Product
19 121200 Asset

20

21

2

23

2%

2

%

27N 121314 PatyHats  Section

28 SectionTheme Party Hats

eags 121316  PatyHats  Section

30 SectionTheme Party Hats
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5 T U v W X Y I (MM A|D| A AF AG
1 Pageiumber Pageame PaeTempae)  PagePickupl MourObct MowtObecType Prodcempste FrameD X ¥ Wi Heght Famefype TeComent  Assipedlsed)
12 Party Hats 121163

i) "1 T 8 725 K9 B0 Galky

ik m Product

U T Product

% 1190 Product

% 121163

7 1 B 07 01 B U5 Galky

i 21193 Product

® ghlE: Product

4 M Product

f

1

It

“l Confetti ~ Doc-dey page temp OTPUSER
3 109954 Product 109954 w10 0 3% UE Objt

I 109955 Product 103964 Mmoo AR n B R Ob

i T Asset 10394 m o B %% UE Obj

1 109953 Product 109954 m 4R B % UE Obj

1 Mo 08 103 2% 09 Obect  Funforeveryone!

5 Confetti  Doc-dev page temp

51 1049 Product 109964 w0 0 3% UE Objt

] 1H0m7 Product 109964 M 4E 0 3% R Objt

53 10046 Product 109954 m 0 R % UE Objt

7! 10050 Product 103964 m xR % UE Obj

% Napkins 0 OTPUSER
5 109954 Product 21073 w0 0 s Ue Obj

i 119955 Product 21073 w4 b s Ue Obe

3 119951 Product 21073 Mmoo B % Ue Ob

5 109953 Product 121073 W 4R B8 3% UE Objt

The BasketObjectKeylD and MountObjectKeyID columns (not pictured in the above screenshots) also appear in
the Publication Excel sheet to enable the use of unique keys as object identifiers in baskets and on your Flatplans:

SupplierPartMumber 121171 Product
SupplierParttMNumber 121178 Product
SupplierPartMumber 121177 Product
SupplierPartMumber 12345678 Product
SupplierPartMumber 121205 Asset
SupplierPartMumber lllustrationRoot  Classification
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| MountObjectKeylD | MountObjectlD MountObjectType

SupplierPartNumber 121171 Product
SupplierPartNumber 121177 Product
SupplierPartNumber 121190 Product
SupplierPartNumber 121193 Product
SupplierPartNumber 121178 Product
SupplierPartNumber 121179 Product

Steps for Exporting a Flatplanner Publication Excel Sheet

The steps to export a Flatplanner publication in the Publication Excel format are nearly identical to those of
exporting a standard 'drag and drop' publication except some additional information is included for Flatplanner
publications, such as pagination rules and the identifiers used for linking objects to baskets and Flatplanner frames
(STEP ID and/or unique key values). For more information on what is included in the export, see the Contents of
Flatplanner Publication Excel Exports topic.

Note: The Publication Excel format is only available when exporting from the publication level. It is not available
for exports from the publication group level or section level.

1. Follow the initial steps for exporting a Publication Excel sheet as outlined in the Exporting a Publication
Excel Sheet topic in the STEP'n'design documentation.

2. Onthe Select Format screen of the Export Manager, choose Publication Excel from the dropdown list. If
you are not using unique keys to identify the objects (typically products) that are linked into the baskets and
Flatplanner frames, click Next.

32 Export Manager

Steps Select Format
1. Select Configuration Publication Excel .y
2. Select Objects —
2. Seleck Fo Exports Publication to excel format.
4, Map Data Indude Unigue Keys as IDs  |pg "
5. Advanced

6. Select Delivery Method

Back Mext Finish Cancel

« If you are using unique keys to identify the objects linked into the into the baskets and Flatplanner frames,
select 'Yes' from the 'Include Unique Keys as IDs' dropdown list, then click Select Unique Keys.
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3% Export Manager

Steps Select Format
1. Select Configuration Publication Excel v
2. Select Objects
2. Select Format Exports Publication to excel format.
4, Map Datz Indude Unique Keys as IDs | &as P
5. Advanced |Mi
6. Select Delivery Method Select Unigue Keys

Back Mext Finish Cancel

« Onthe Select Unique Keys dialog, all active keys in your STEP instance are displayed. Check the box(es)
for the unique key values that should be included in the export, then click Select.

3% Select Unique Keys

[ Al

[Jkey 3
Supplier Part Number!

Select Cancel

4. Since data does not need to be mapped for the Publication Excel format, the Map Data screen is skipped.

5. Onthe Advanced screen, choose a Context if you have dimension-dependent data section names or page
names and need to see them in a particular language. All other settings may be ignored. Click Next.
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33 Export Manager

Steps Advanced
1. Select Configuration [] Tag conversion Coupon
2. Select Objects

[ ] Locale conversion from context

3. SelectF t
erma Resolve Inline References
4, Map Data
- () Export Only Local Inline References
Advanced
6. Select Delivery Method (@) Export Inherited Inline References

Indude Calculated Attribute Values

Waorkspace | Main e

Context |English LIS [

Select version used to resolve tables | English US

Back Mext Finish Cancel

6. Choose File as the Delivery Method in Step 6, then click Finish.

7. Onthe Save Export Configuration screen, check 'Save Options' if you would like to save the Export
configuration.

8. Click OK, then retrieve the Excel file.

Considerations and Limitations

« Though multiple publications may be exported in a single Publication Excel file, multiple publications may not be
imported in the Publication Excel format. To import multiple publications at once, the STEPXML format must be
used. For information on importing publications in STEPXML, see the Exporting and Importing
Publications in STEPXML topic.

« Support for Publication Excel export is currently unavailable in the Web UI.

« All pagination rules are exported in a single cell. If the exported publication has numerous rules, the character
count can grow into the thousands. If the pagination rules character count exceeds of 32,767 characters, an
error will occur. If the system property publicationExcelExport.OneRulePerCell=true isadded to the
sharedconfig.properties file, then only one rule will display per row.
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Exporting and Importing Flatplans in Flatplan
Excel

The Flatplan Excel format is exclusively for use with existing Flatplanner publications. Through importing, it can
be used to create or update sections and flatplans, which are the planned pages (spreads) within the sections.

The typical first step in using a Flatplan Excel sheetto import a flatplan is to export a pre-existing flatplan from a
Flatplanner publication. This exported Excel file can then be used as a 'template’ sheet to import new flatplans.

The Flatplan Excel format supports the export of section-level Flatplanner information, i.e., flatplans. A flatplan—
also known as a plan—is composed of planned pages (also known as spreads) and the product and/or asset
objects that are linked to the flatplan frames on these pages. Flatplan Excel sheets contain information about the
page templates used on each page and the product templates used on each frame. Additional frame-level
information, such as X /Y coordinates and frame height and width, is also included.

Note: Because the Flatplan Excel format only includes section-level plan information and does not contain
Flatplanner information such as baskets, pagination rules, and frame types, the Publication Excel format is
typically recommended when exporting and importing flatplans. For more information on using the Publication
Excel format with Flatplanner publications, see the Exporting Flatplanner Publications in Publication Excel
topic.

Sample Flatplan Excel Spreadsheet

The following screenshot shows a sample Flatplan Excel sheet.

A B T D E F G H | J K L M N 0
1 SectonD SectonName  SectonTypeD Pagelumber PageName PageTemplteD MountObjectD MountObjeciType ProduciTempiatelD FrameD X Y Width Height  AssignedUserD
2 M2857  ChapeaudeFéte Section h Party Hats 121163
3 R fi21183
4 (1 Galley Page "121163
5 k5 fi21183
6 M128535  PatyFavewrs  Section 1 Confetis  Doc-dev page te 109954 Product M2138 ) fo hm s Te oTRUsER
7 " 09955 Product fi21385 P01 i i B e
8 "1 09951 Product "1 09964 2 e Ee B e
g 109953 Product "1 09964 3 i Ee N im
10 k5 Confeti  Doc-dev page ter 10049 Product " 9064 ) s s hs e
11 B10047 Product " 09964 P01 ix i B e
12 110046 Product "1 09964 2 s Ee hx e
13 110050 Product "1 09964 3 s Ep N im
14 '!5 Serviettes 09954 Product ) o o hm e
15 " 09955 Product P01 i i B e
16 "1 09951 Product 2 e Ee B e
17 109953 Product 3 i Ee N im
18 P4 B hm hm hw
19 7 Napkins  Doc-dev page ter 121176 Product 09964 pil e o hm e
20 fi21200 Asset 2 s e ke e
bl f21178 Product 09964 Upperleft 075 s B e

© Stibo Systems - Confidential - STEP Trailblazer 8.3 154



StiboSystems

Steps to Export a Flatplan Excel

1. Right-click on a publication or section object and select Export Data Below, or go to File > Export > Data.
Choose a publication if you want to export all flatplans from the entire publication. Click on a section to export
the flatplans from that section only.

2. Nothing else needs to be done on the Select Objects screen, as all other options are grayed out when
Publication Objects is selected for export. Click Next.

Note: Though the option exists on this screen to choose a publication Version, there is no need to do so since
the sheet contains information that applies to all versions in the publication.

& Export Manager

Steps Select Objects
1, Select Configuration D > Name > (Object Type » [Version > Path >
2. Select Objects » 208213 Spring Wedding Catalog  Publication  EnglishUS  Publications/Spring Wedding Catalog
4, Map Data
5. Advanced
6. Select Delivery Method
Only export selected objects
Only export leaf objects Export: | Publication Objects
Indude object types <All object types»
Back Mext Finish Cancel

3. Onthe Select Format screen, choose Flatplan Excel from the dropdown list, then click Next.

8 Export Manager

Steps Select Format

1. Select Configuration Flatplan Excel [
2. Select Objects

3. Select Format

4, Map Data

5. Advanced

6. Select Delivery Method

Exports Publishing hierarchy to excel format.

Back Mext Finish Cancel

4. Since data does not need to be mapped for the Flatplan Excel format, the Map Data screen will be skipped.
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5. Onthe Advanced screen, choose a Context if you have dimension-dependent section names or page names
and need to see them in a particular language. All other settings may be ignored. Click Next.

32 Export Manager

Steps Advanced
1. Select Configuration [] Tag conversion Coupaon
2. Select Objects

[] Locale conversion from context

3. Select Format
Resolve Inline References
4, Map Data
- () Export Only Local Inline References
6.5 Delivery Met (®) Export Inherited Inline References

Indude Calculated Attribute Values

Workspace |Main e

Context |English LIS |

Select version used to resolve tables | English US

Back Mext Finish Cancel

6. Choose File as the Delivery Method on the Select Delivery Method screen, then click Finish.

7. Onthe Save Export Configuration screen, check 'Save Options' if you would like to save the Export
configuration.

8. Click OK, then retrieve the Excel file.

Importing a Flatplan Excel Sheet

Flatplan Excel sheets can be imported either at the publication or section level.

1. Right-click on the publication or section object into which you would like to import your sheet. Select Import
Plan.
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»

ﬁ Publications ‘
ﬁ Templates
@ Standard Publications| 8 Mew Publication Section...
ﬁ Autopage Publications

Create new Section from existing...

=1 Flatplanner Publicatior
E| Spring Wedding C Import Plan... I
-5 Commerdial Di Link product
G+ @l Party Favors Link asset
ﬁ Cards & Static Reapply page template(s)..

[+ B8 Decorations
G- (@l Cake Toppers Update plan frorm actual page...
-- Hair Accessor

[+ [E8 Drinkware Cut
- @l Halloween Catalo Copy
- @ Christmas Catalog Paste
[+ & WeblUIPublicationType .
e . YF Paste Link
[+ [l TempWebUIPublicatio

2. The Select Excel File dialog displays. Navigate to your Flatplan Excel import sheet and click Open.

3. The Save Import Configuration dialog displays. Click OK. Though you have the option to save your import
configuration on this screen, there is no real need to do so, as no mapping is required for a Flatplan Excel
import.

4. The import process will begin automatically. Click Go to process on the Starting process Importing dialog
if you would like to monitor the import Background Process as the Plan imports.
Considerations and Limitations

« Flatplan Excel files cannot be imported using File > Import > Data. Flatplan Excel sheets must be imported
by a right-click action on either publication or section objects.

« Frame sizes and X /Y coordinates cannot be altered with Publication Excel or Flatplan Excel imports. Frame
sizes will remain the same size as specified by the page template that is linked to the page.
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Contents of Flatplanner Publication Excel Exports

The following table outlines the contents of both Excel formats available for Flatplanner Publication Excel
exports—Publication Excel and Flatplan Excel—in the order that the columns appear:

Column Header Description Publication Flatplan
Excel Excel

PublicationID STEP ID of exported publication X
PublicationName STEP Name of exported publication X
PublicationType Object type ID of exported publication X
PublicationTemplatelD STEP ID of publication template linked to the exported X

publication
PubPageTemplatelD STEP ID of page template(s) linked to the exported X

publication
VersionID STEP ID of the publication version(s) of the exported X

publication
VersionName STEP Name of the publication version(s) of the X

exported publication

VersionContextlD STEP ID of the context(s) used in the publication X
version(s) of the exported publication

VersionWorkspacelD STEP ID of the workspace(s) used in the publication X
version(s) of the exported publication

SectionLevel A number that represents whether the section is a top- X
level section (1) or a subsection (2, 3, 4, etc.)

SectionID STEP ID of the exported publication section(s) X X

SectionName STEP Name of the exported publication section(s) X X
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Column Header Description Publication Flatplan
Excel Excel

SectionTypelD Object type ID of the exported publication section(s) X X

MetaDataAttributelD STEP ID of metadata (description) attributes linked to X

the publication or section (column will not appear in the
export if there are no values populated for the metadata
attributes)

MetaDataAttributeValue | Value of metadata (description) attributes linked to the X
publication or section (column will not appear in the
export if there are no values populated for the metadata
attributes)

RuleSettings Pagination rules used in the publication(s) and sections X

Example: <Action
ID="PublicationTemplateSpreadindexAction"
Type="PublicationTemplateSpreadindexAction"
parametertemplateSpreadindex="1"> <Condition
ID="AlwaysCondition" /> </Action>

BasketObjectKeylD If using unique keys instead of STEP IDs to identify X
objects linked to the basket, this column will contain the
ID of the unique key associated with the object.

For more information on unique keys, see the Unique
Keys topic in the System Setup / Super User Guide
documentation.

BasketObjectID STEP ID of the product(s) and/or asset(s) linked into the X
Flatplanner basket. If using unique keys instead of
STEP IDs to identify objects linked to the basket, this
column will contain the value of the unique key.

BasketObjectType Value will either be 'Product,’ 'Asset,' or 'Classification,’ X
depending on whether a product object, asset object, or
classification object is linked to the Flatplanner basket.
'Product,’ 'Asset,' and 'Classification’ are generic terms
referring to the object supertypes and do not specify the
exact object types.
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Column Header Description Publication Flatplan
Excel Excel
PageNumber Page number of the planned page X X
PageName STEP Name of the planned page X X
PageTemplatelD STEP ID of the page template linked to the planned X X
page
PagePickuplD STEP ID of the actual page that was picked up as the X

layout for the planned page

MountObjectKeylD If using unique keys instead of STEP IDs to identify X
objects linked to the Flatplanner frame, this column will
contain the ID of the unique key associated with the
object.

For more information on unique keys, see the Unique
Keys topic in the System Setup / Super User Guide
documentation.

MountObjectID STEP ID of the product or asset object linked to the X X
Flatplanner frame. If using unique keys instead of STEP
IDs to identify objects linked to the frame, this column
will contain the value of the unique key.

MountObjectType Value will either be 'Product,’ 'Asset,' or 'Classification,’ X X
depending on whether a product object, asset object, or
classification object is linked to the Flatplanner frame.
'Product,’ 'Asset,’ and 'Classification’ are generic terms
referring to the object supertypes and do not specify the
exact object types.

ProductTemplatelD « Inthe Publication Excel format, this column X X
contains the STEP ID(s) of the product template(s)
linked to the exported publication and each
individual Flatplan frame

« Inthe Flatplan Excel format, this column only
contains the STEP ID(s) of the product template(s)
linked to each individual Flatplan frame
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Column Header Description Publication Flatplan
Excel Excel

FramelD STEP ID of the Flatplanner frame X X

X X coordinate of the Flatplanner frame on the planned X X
page

Y Y coordinate of the Flatplanner frame on the planned X X
page

Width Width of the Flatplanner frame X X

Height Height of the Flatplanner frame X X

FrameType Value will either be 'Object' or 'Galley', depending on X

whether the Flatplanner frame contains a product,
asset, or free text ('Object’) or is a Galley text frame

('Galley")
TextContent Free text content of the Flatplanner frame X
AssignedUserl|D STEP user who is currently assigned the planned page X X

in the Flatplanner workflow
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Location of Flatplanner Publication Export
Information in STEP

The following sections use a sample Flatplanner publication to illustrate where the information included in
Flatplanner Publication Excel and Flatplan Excel exports resides in the STEP Workbench.

The information in this topic is also applicable for STEPXML exports, but the 'tags' listed in this topic are the
column headers that appear in Publication Excel files. For more information on STEPXML exports of Flatplanner
publications, see the Exporting and Importing Flatplanner Publications in STEPXML topic.

Publication Tab

1. The PublicationID and PublicationName columns will contain the STEP ID and STEP Name of the
publication, respectively.

2. The PublicationType column will contain the object type ID of the publication.
3. The PublicationTemplatelD column will contain the STEP ID of the publication template.

4. The MetaDataAttributelD and MetaDataAttributeValue columns will contain the STEP ID(s) and STEP
Names(s) of populated metadata attributes that appear on the publication and section(s). Note thatifa
publication (or section) has linked metadata attributes but these attributes do not contain values, the
MetaDataAttributelD and MetaDataAttributeValue columns will not appear on the exported sheet.

5. The ProductTemplatelD column will contain the STEP ID(s) of the product template(s).
6. The PubPageTemplatelD column will contain the STEP ID(s) of the page template(s).

7. The LayerMappingTemplate column will contain the name of the layer in the templates (publication, product,
and InDesign-created page templates); LayerMappingDocument will contain the name of the corresponding
layer in the Publication Document (mounting page); and LayerMappingOwner will display whether the
publication version to which the layer is mapped is the owner of the layer—value of 'true’ or 'false.' In the
following screenshot, 'English US' (displayed in bold) is the owner of the 'Images' layer.

Note: When exporting a 'model' Flatplanner publication in order to use the resulting publication Excel sheet as a
template for later Flatplanner publication imports, it is recommended to populate at least one metadata attribute
on the publication (and each section) with a 'dummy’ value. This ensures that the MetaDataAttributelD and
MetaDataAttributeValue columns appear on the 'template' sheet and will not have to be manually inserted later.
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Acme Party Supplies - Publication
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Version Tab

1. The VersionID column will contain the STEP ID(s) of the publication version(s).
2. The VersionName column will contain the STEP Name(s) of the publication version(s).

3. The VersionContextID column will contain the STEP ID(s) of the context(s) to which each publication version
is linked. (Note: The context name is displayed in the workbench.)

4. The VersionWorkspacelD column will contain the STEP ID of the workspace to which each publication
version is linked (will either be '‘Main' or 'Approved').

< Acme Party Supplies - Version =

| Fage Inspector | Status || State Log | Tasks

[ Pages H Publication Planner ” Plan Motes H Financial Summary ]

AutoPage Publication Planner
| Publication ” Flan l

§ Version Description

Pagination Rules

ID * |Name * |Context * |Workspace > |Availak
» 1181250 o English UK 9 English UK 9 Main a
* 121313 English US English US Main
* 1181251 French FR French FR Main
* | Add version

Sections and Planned Pages

1. The SectionLevel column will contain a number that represents whether the section is a top-level section (1)
or a subsection (2, 3, 4, etc.).

2. The PageNumber and PageName columns will contain the page number and name of planned pages.

3. The SectionlD, SectionName, and SectionTypelD columns will contain the STEP IDs, STEP Name, and
STEP object type of all sections and subsections.

B[] Adme Party Supplies

i % Commerdal Data Publication Section [ Plan ” Publication Plani
E} (8 Party Hats? @ Description
= i Party Ha Mame *| » |value
IR 2 -Party Hats (T 121316
-] . OTP Documents
. OTP Documents | Mame 9 Party Hats
E} i Farty Favors l Chject Type Section
R 4- C“”Fe'b > Revision 0.1Last edited
ﬁ & - Mapkin
EEI-- DTP Documents * Path Publications Fla

Plan Tab — Basket
1. The BasketObjectID column will contain the STEP ID of the objects linked into the Flatplanner Basket
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2. The BasketObjectType column will contain 'Product' or 'Asset' depending on whether a product object or an
asset object is linked to the Flatplanner Basket.

Acme Party Supplies - Plan

AutoPage Publication Planner || Pagination Rules | Page Inspector || Status || State Log || Tasks

Publication m[ Wersion " Pages " Publication Planner " Plan Mokes " Financial Summary

Basket maintained locally

Column View: | Default - Public .|
i i 0 * Mame * PrimaryProductimage * On Pages
| ( S
121182 ™ Blue Wizard Baloon Hat -
121183 N pink & Blue Giraffe Party Hat E
121190 N Dog Party Hats Assortment i&ﬁ‘-« 2
121213 N pink & Blue Owl Party Hat
121175 a Mardi Gras Mask - Green
— E
121175 [ﬁ Mardi Gras Mask - Gold 7
121200 I 'w|[pog Party Hats Assortment i&ﬁ‘-« 7 i

a4 | m | b

Plan Tab — Page Information
1. The PageTemplatelD column will contain the STEP ID of the page template used on the Flatplan page.
(Note: The page template name is displayed in the Plan view in the Workbench.)

2. The MountObjectID column will contain the STEP ID of the object linked to the Flatplanner frame. (Note: The
object name is displayed in the Plan view in the Workbench.)

3. The ProductTemplatelD column will contain the STEP ID of the product template linked to the Flatplanner
frame. (Note: the product template name is displayed in the Plan view in the workbench.)

The FramelD column will contain the STEP ID of the Flatplanner frame.
The X and Y columns will contain the X and Y coordinates of the Flatplanner frame.

The Width and Height columns will contain the dimensions of the Flatplanner frame.

N o o bk

the TextContent frame will contain the content of Free Text frames.
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EQEO

Confetti

@) | Darerd Coverd

i

201

|

0 Frame ID:

b X pos:

Y pos:

Width:
Fun for evenyons!

0 Height:

9 [T : Party Product Ternplate

Layer:
| T : Party Produ

E] FrNuperﬁs

20

4,52 inches

0.75 inches

3.25inches

4,62 inches

Red Heart Co

202

-

8. The MountObjectType column will contain 'Product’ or 'Asset' depending on whether a product object (left) or
an asset object (right) is linked to the Flatplanner frame.

|Bhse Wizard Baloon Hatl

[T : Party Product Ternplate

[M 1 Ma termplate assigned
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9. The PagePickuplD column will contain the STEP ID of the Actual Page that was picked up as the layout for
the planned page. (Note: The link to the actual page is displayed in the tooltip text in the Plan view.)

Napkins

q==]

|
Page pickup from: /Flatplanner Publications/Spring Wedding Catalog/Party Favors/2 - Confettif2|

nfetti et | & Whte

10. The FrameType column will contain either 'Object' or 'Galley' depending on whether a standard page template
(blue frames) or Galley page template (green frames) is used on the page. Pictured below is a Galley page
template as viewed in the Plan view.

Galley Page
4  DocDev_PAGE Template_GALLEY Doc-Dey_PAGE Template_GALLEY 5

Publication Planner Tab

The AssignedUserlD column will display the User who has been assigned the page in the Flatplanner workflow.
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Fublication || Plan || Wersion || Pages |BMEIHIELORAETTTIMN | Plan Ne

Column View: Default
~

ssignee » [Thumbnail
ts

F Party Hats/Party Hats

DTPUser I

= e
= I8
preil__d

> MfA

Pagination Rules Tab

STEPXML code for Pagination Rules linked to the publication and/or sections will be included in the
RuleSettings column. The screenshot below shows a pagination rule set at the top level of the publication. Note
that if a publication has no pagination rules, the RuleSettings column will not appear on the exported sheet.

Note: When exporting a 'model' publication in order to use the resulting Publication Excel sheet as a template for
later publication imports, it is recommended to manually set up the desired pagination rules first. This ensures that
the RuleSettings column appears on the 'template’ sheet and will not have to be manually inserted later.

Acme Party Supplies - Pagination Rules

AutoPage Publication Planner |REEELEEEEN S Page Inspector || Status || State Log || Tasks
Publication ” Plan ] Version [ Publication Planner " Plan Mokes ” Financial Surmmary ]
' Object Layout
Condition > Action » Defined At >
N Default condition Iise product template Party Product Template  Acme Party Supplies
Add Rule
' Set publication template spread index
Condition » Action » Defined At >
N Default condition Set publication template spread index 1 Acme Party Supplies
Add Rule
[ AddRule Group :

Unique Keys

Unique keys can be used instead of STEP IDs to identify objects linked to Flatplanner baskets and Flatplanner
frames. Keys are stored in System Setup > Keys.
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System Setup

+-ff Table

s GDSM Key

,% Key 1

L S Key 2

52 Simple

w% Supplier Part Mumber
-l Event Queues

[#-[B Component Models

1. The BasketObjectKeylID column will contain the ID of the unique key used to identify the object being linked to
the basket.

2. When a unique key is used to identify objects linked to baskets, the value of the unique key will display in the
BasketObjectID column.

3. The MountObjectKeylID column will contain the ID of the unique key used to identify the object being linked to
the Flatplanner frame.

4. When a unique key is used to identify objects linked to frames, the value of the unique key will display in the
MountObjectID column.

For more information on unique keys, see the Unique Keys topic in the System Setup / Super User Guide
documentation.
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Importing Flatplanner Publications in Publication
Excel

Entire Flatplanner publications can be created or updated with the import of a Publication Excel spreadsheet.
For existing Flatplanner publications, the Flatplan Excel format can be used to create or update sections and
Flatplans, which are the planned pages (spreads) within the sections.

The typical first step in importing a Flatplanner publication and/or flatplan is to export a pre-existing Flatplanner
publication. The resulting Publication Excel or Flatplan Excel file can then be used as a 'template’ sheet for new
Flatplanner publications or Flatplans, i.e., existing information on the export sheet will be replaced with new
information for the subsequent import.

For more information on exporting Flatplanner publications in either Excel format, see the Exporting Flatplanner
Publications in Excel topic.

Importing a Flatplanner Publication Excel Sheet

The steps to import or update a Flatplanner publication using a Publication Excel sheet are nearly identical to
those of importing a Publication Excel for any other publication type, with the exception of the additional
Flatplanner-specific columns needed for Flatplanner publications.

While some fields may be left blank on the Publication Excel sheet to successfully create a new Flatplanner
publication (e.g., PublicationName, MetaDataAttributelD, and RuleSettings) all Flatplanner-specific fields on the
Publication Excel sheet must be filled out if your intention is to update an existing Flatplanner publication. If you
want to create a new Flatplanner publication or Flatplan—and you have configured the STEP IDs to autogenerate
for your publication, section, and version object types—then the ID fields for these object types should be left
blank.

For step-by-step Publication Excel import instructions, see the Importing a Publication Excel Sheet section
of the STEP'n'design documentation.

Mandatory and Optional Information for Flatplanner Publication Excel Imports

A comprehensive list of mandatory and optional information for Publication Excel imports is listed in the Importing
Publications in Excel section of the STEP'n'design documentation. The below table addresses the
Flatplanner-specific fields.

Though many columns are not mandatory to create the publication itself, leaving these fields blank means that any
missing information will have to be manually created after the import, thus negating much of the purpose of
creating the publication by import.
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PubPageTemplatelD

Description

STEP ID of page template(s) linked to the exported
publication

StiboSystems

Mandatory?

No, butitis strongly
recommended to provide
this information.

If not provided in the import,
a page template must be
manually linked to the
publication before it can be

used for production.
RuleSettings Pagination rules used in the publication(s) and sections | No
Example: <Action
ID="PublicationTemplateSpreadindexAction"
Type="PublicationTemplateSpreadindexAction"
parametertemplateSpreadindex="1"> <Condition
ID="AlwaysCondition" /> </Action>
BasketObjectKeylD If using unique keys instead of STEP IDs to identify No
objects linked to the basket, this column will contain the
ID of the unique key associated with the object.
For more information on unique keys, see the Unique
Keys topicin the System Setup / Super User Guide
documentation.
BasketObjectID STEP ID of the product(s) and/or asset(s) linked into No
the Flatplanner basket. If using unique keys instead of . .
STEP IDs to identify objects linked to the basket, this (Yesif you have provided a
column will contain the value of the unique key. BasketObjectKeyID)
BasketObjectType Value will either be 'Product,' 'Asset,' or 'Classification,' | No
depending on whether a product object, asset object, or . .
classification object is linked to the Flatplanner basket. | (Yes if you have provided a
'Product, 'Asset,' and 'Classification’ are genericterms | BasketObjectD, as the
referring to the object supertypes and do not specify the | Possibility exists that a
exact object types. product object could share
the same STEP ID as an
asset or classification
object)
PageNumber Page number of the planned page No
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Column Header Description Mandatory?
PageName STEP Name of the planned page No
PageTemplatelD STEP ID of the page template linked to the planned No
page
PagePickupID STEP ID of the actual page that was picked up as the No
layout for the planned page
MountObjectKeylD If using unique keys instead of STEP IDs to identify No
objects linked to the Flatplanner frame, this column will
contain the ID of the unique key associated with the
object.
For more information on unique keys, see the Unique
Keys topicin the System Setup / Super User Guide
documentation.
MountObijectID STEP ID of the product or asset object linked to the No
Flatplanner frame. If using unique keys instead of _ _
STEP IDs to identify objects linked to the frame, this (Yes if you have provided a
column will contain the value of the unique key. MountObjectKeyID)
MountObjectType Value will either be 'Product,' 'Asset,’ or 'Classification,” | No

depending on whether a product object, asset object, or
classification object is linked to the Flatplanner frame.
'Product,’ 'Asset,’ and 'Classification' are generic terms
referring to the object supertypes and do not specify the
exact object types.

(Yes if you have provided a
BasketObjectID, as the
possibility exists that a
product object could share
the same STEP ID as an
asset or classification
object)

ProductTemplatelD

This column serves a dual purpose for Flatplanner
publications. It contains the STEP ID(s) of the product
template(s) linked to the entire publication and to each
individual Flatplan frame

No, butitis strongly
recommended to provide
this information.

If not provided in the import,
a product template must be
manually linked to the
publication before it can be
used for production.
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Column Header Description Mandatory?
FramelD STEP ID of the Flatplanner frame No
X X coordinate of the Flatplanner frame on the planned No
page
Y Y coordinate of the Flatplanner frame on the planned No
page
Width Width of the Flatplanner frame No
Height Height of the Flatplanner frame No
FrameType Value will either be 'Object’ or 'Galley', depending on No
whether the Flatplanner frame contains a product,
asset, or free text ('Object’) or is a Galley text frame
('Galley")
TextContent Free text content of the Flatplanner frame No
AssignedUserID STEP user who is currently assigned the planned page | No
in the Flatplanner workflow

Considerations and Limitations

Frame sizes and X /Y coordinates cannot be altered with Publication Excel imports. Frame sizes will remain the
same size as specified by the page template that is linked to the page.
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Exporting and Importing Flatplanner Publications
in STEPXML

Flatplanner publications can be exported and imported using the STEPXML format.

This topic explains the manual process for exporting Flatplanner publications in STEPXML using the Export
Manager in the STEP Workbench, the outbound parameters available for Flatplanner publications, a sample XML
file, and a description of the tags inside the resulting STEPXML file.

This topic details the most common tags that will appear in a STEPXML export of a Flatplanner publication. For a
comprehensive list of STEPXML tags, refer to the STEPXML XSD file located in the STEP APl documentation,
which is accessible from the WebStart page of your STEP instance.

Importing a Flatplanner Publication in STEPXML

Product, asset, and/or classification objects can be linked to the frames of Flatplanner planned pages by importing
a STEPXML file. This same file can also be used to create the publication structure, the publication, and to link the
relevant publication template, page templates, and product templates to the publication, the planned pages, and
the page frames, respectively. An example of a STEPXML file that can be used to import a Flatplanner publication
is provided later in this topic in the 'File Example' section.

Instructions on how to import the STEPXML file itself are not detailed in this topic since the steps are the same as
those for importing any other type of data into STEP using STEPXML. Flatplanner publications can be imported
manually using the Import Manager or automatically using an inbound integration endpoint (IIEP).

For more information, see the Import Manager and Inbound Integration Endpoints sections of the Data
Exchange documentation.

Exporting a Flatplanner Publication in STEPXML

The steps to export a Flatplanner publication in STEPXML are the same as those for exporting any other type of
publication (standard 'drag and drop' or AutoPage), except a few additional Flatplanner-specific options are
chosen when selecting the STEPXML outbound parameters.

1. Toinitiate the export, follow the initial steps outlined in Exporting and Importing Publications in STEPXML
in the STEP'n'design documentation.

2. Onthe Select Format screen (step 3), after choosing STEPXML from the dropdown list, navigate to the
publication options pictured below and choose the relevant publication information that you want to include in
your export. All other default options can be left as-is (for example, 'Include Products = Minimum).
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33 Export Manager

Steps Select Format
1, Select Configuration STEPXML o
2. Select Objects
Exports data in a STEP Product Information XML format, Mote that this format ...
3. Select Format
4, Mzp Data Pubilishing &
5, Advanced o
Include Publication Groups o ] ..
6. Select Delivery Method
Indude Publications Mo -
Indude Publication Sections Mo -
nclude Planned Pages Mo V
Include Autopage References Mo V
ndude Baskets Mo -
ndude Pagination Rules Mo -
Include Actual Page Data Mo V
w
Back Mext Einish Cancel

Note: The only options available for publication parameters are 'Yes' or 'No.' You may need to experiment
with the combination of objects selected in the Select Objects step and the 'Yes' settings chosen in the Select
Format step to ensure that you do not get too much or too little information in your export. For instance, if you
export from a publication object and select "Yes' for 'Include Publication Groups' but 'No' for 'Include
Publications,’ the export will include all publication groups that exist in your STEP system as well as the single
publication selected, even though 'No' was selected for publications.

« The following parameters are relevant for all types of publications (standard STEP'n'design, Flatplanner,
and AutoPage). Information on these parameters and the resulting tags in the STEPXML file are detailed in
the Exporting and Importing Publications in STEPXML topic in the STEP'n'design documentation.

« Include Publications

« Include Publication Groups

« Include Publication Sections

« Include Actual Page Data: relevant if you have saved mounted DTP documents into your publication
« The following options are valid for Flatplanner publications.

« Include Planned Pages

« Include Baskets

« Include Pagination Rules
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3. Select Yes for Data Objects > Include Keys as IDs if you are using unique keys to identify objects linked to
your baskets and/or Flatplanner page frames.

Incude Keys as IDs Wos

Do

Select Unigue Keys

« To select the desired unique keys to use for this process, click the 'Select Unique Keys' link. The 'Select
Unique Keys' dialog shows all active keys in the STEP system. Choose the key(s) to export, then click
'Select.’

3% Select Unique Keys

[ ]an
[Key 3

Supplier Part Number:

Select Cancel

« The selected Unique Keys will be shown in the Export Wizard.

Include Keys as IDs o

|5up|:|lier Part Mumber |
Select Unigue Keys

4. Select Data Objects > Include Workflow Tasks if you are using a Flatplanner workflow. This parameter will
return the ID of the user to whom the Flatplanner planned page is currently assigned. 'Include Planned Pages'
must also be set to All to return this information. For more information on Flatplanner workflows, see the
Flatplanner Workflows documentation.

Include Workflow Tasks o

5. The Map Data step is skipped as with any other STEPXML export, since data is not mapped in the STEPXML
format.

6. The options in the Advanced step and the Select Delivery Method step are the same as those available for any
other type of STEPXML export. See Export Manager - Advanced and Export Manager - Select Delivery
Method in the Export Manager documentation for more information.

Note: Though the Select version used to resolve tables option references publication versions, this
setting is only relevant if the 'Include Tables' parameter is set to 'Yes' in the Select Objects step. This setting
has no impact on publication-only exports. For more information, see the Exporting Resolved Tables topic
in the Tables documentation.
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File Example

The following STEPXML sample shows an export from a Flatplanner publication that contains two versions, a
basket, pagination rules, one section with one planned page, and metadata attributes on the publication, section,
and planned page objects.

Note: The content inside the <PaginationRules> tag in the below file sample has been abbreviated for illustration
purposes, and as such is not valid for importing pagination rules in an actual publication import.

<STEP-ProductInformation ExportContext="Contextl" ContextID="Contextl"
WorkspaceID="Main" UseContextLocale="false">

<PublicationGroups>

<PublicationGroup UserTypelID="Publication group root" ParentID="Publication
hierarchy root" ID="108198" UnitID="inches">

<Name>Flatplanner Publications</Name>

<Publication UserTypeID="Default publication type"
MasterDocumentID="109967" PagesPerSpread="2" DefaultPageTemplateID="121163"
DTPType="InDesign" ParentID="108198" ID="128523">

<Name>Acme Party Supplies</Name>
<MetaData>
<Value AttributeID="CatalogTheme">Acme Party Supplies</Value>
<Value AttributeID="LastPageNumber" Derived="true">0</Value>
</MetaData>
<Version ContextID="Context2" WorkspaceID="Main" ID="204372">
<Name>French FR</Name>
</Version>
<Version ContextID="Contextl" WorkspaceID="Main" ID="128525">
<Name>English US</Name>
</Version>
<Basket>
<ProductBasketLink ProductID="121193"/>
<ProductBasketLink ProductID="121180"/>
<ProductBasketLink ProductID="121182"/>
<ProductBasketLink ProductID="121183"/>
<ProductBasketLink ProductID="121190"/>
<ProductBasketLink ProductID="121218"/>
<AssetBasketLink AssetID="121200"/>
<ClassificationBasketLink ClassificationID="IllustrationRoot"/>

</Basket>
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<PaginationRules><!--Abbreviated--
>PD94bWwgdmVyc21lvbj0iMS4wIiBlbmNvZGluZz0idXRmLTgiPz4KPFJ1bGVzIFZ1lcnNpb249IjMiPg
0gIDxXQYWdpbmF0aWouUnVszUdyb3VwPgogICAg=</PaginationRules>

<PageTemplateLink PageTemplateID="2x2"/>
<PageTemplateLink PageTemplateID="4x4"/>
<PageTemplateLink PageTemplateID="3x3"/>
<ProductTemplateLink ProductTemplateID="123670"/>
<ProductTemplateLink ProductTemplateID="109964"/>
<ProductTemplateLink ProductTemplateID="121385"/>
<PublicationSection ID="128535" UserTypelD="Section">
<Name>Party Favors</Name>
<MetaData>
<Value AttributeID="SectionTheme">Party Favors</Value>
<Value AttributeID="FirstPageNumber" Derived="true">4</Value>
<Value AttributeID="LastPageNumber" Derived="true">9</Value>
</MetaData>

<PaginationRules><!--Abbreviated--
>PD94bWwgdmVyc21lvbj0iMS4wIiBlbmNvZGluZz0idXRmLTgiPz4KPFJ1bGVzIFZ1lcnNpb249IjIiPg
0gIDxQYWdpbmF0aWouUnVszUdyb3VwPgogICAg=</PaginationRules>

<PlannedPage PageNumber="4" ID="128536" User="DTPUSER">
<Name>Confetti</Name>
<MetaData>

<Value AttributeID="GetInheritedSectionValue"
Derived="true">Party Favors</Value>

<Value AttributeID="GetInheritedPubGroupValue"
Derived="true">Acme Party Supplies - Since 1955</Value>

<Value AttributelID="GetInheritedPublicationValue"
Derived="true">Acme Party Supplies</Value>

</MetaData>
<TemplateLayout TemplateID="2x2"/>
<PageContents>

<Frame ID="200" X="1.0" Y="0.75" Width="3.25" Height="4.63"
ZOrder="0" UnitID="inches">

<ProductElement ProductID="109954">
<TemplateLayout TemplateID="121385"/>
</ProductElement>

</Frame>
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<Frame ID="201" X="4.52" Y="0.75" Width="3.25" Height="4.62"
ZOrder="1" UnitID="inches">

<ProductElement ProductID="109955">
<TemplateLayout TemplateID="121385"/>
</ProductElement>
</Frame>

<Frame ID="202" X="1.0" Y="5.62" Width="3.25" Height="4.63"
ZOrder="2" UnitID="inches">

<ProductElement ProductID="109951">
<TemplateLayout TemplateID="109964"/>
</ProductElement>
</Frame>

<Frame ID="203" X="4.52" Y="5.62" Width="3.25" Height="4.63"
ZOrder="3" UnitID="inches">

<ProductElement ProductID="109953">
<TemplateLayout TemplateID="109964"/>
</ProductElement>
</Frame>

<NoteFrame ID="1490212610420" X="1.79" Y="1.97" Width="0.59"
Height="0.59" ZOrder="4" UnitID="inches" Status="true">

<NoteRecord Username="USER4" Timestamp="Wed Mar 22 15:56:50 EDT
2017">This is approved</NoteRecord>

</NoteFrame>
</PageContents>
</PlannedPage>
</PublicationSection>
</Publication>
</PublicationGroup>
</PublicationGroups>

</STEP-ProductInformation>

Flatplanner Information Included in the Export

The following sections explain the Flatplanner information included in the STEPXML file.
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Include Publications

Full details on the information included in the <Publication> tag is provided in the Exporting and Importing
Publications in STEPXML topic. Highlighted below are the two additional XML attributes included for
Flatplanner publications.

<Publication UserTypell="Default publication type" I-Iaste:DDcumentID=“1U996'?“IPagesPe:Sp:ead=“2“|
IDefaultPageTemplateID=“121163”ID’I‘P'I‘;-‘pe="InDesign" ParentID="108198" ID="128523">

Tag Description

<Publication> | Returns the following additional information for Flatplanner publications:

« PagesPerSpread: The default number of pages used for spreads in the publication
(valid values are 1 and 2)

« DefaultPageTemplatelD: The default page template used for planned pages in the
publication
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Include Planned Pages

<PlannedPage| PageNumber="5" ID="128537">
<Name>Confetti</Name>
<MetaData>
<Value AttributeIl="GetInheritedSectionValue" Derived="true">Party Favors</Value>
<Value Attributell="GetInheritedPubGronpValue" Derived="trus":Acme Party Supplies - Since 1955</Value>
<Value AttributeIl="GetInheritedPublicationValue" Derived="true">Acme Party Supplies</Valuex
</MetaData>
<Templatelayout TemplateID="Doc-dev page temp"/>
<PageContents>»
<Frame ID="200" X="0.75" ¥Y="0.75" Width="3.25" Height="4,63" Z0rder="0" UnitID="inches"»
<ProductElement ProductID="110045">
<Templatelayout TemplateID="109964"/>
</ProductElement>
«</Frame>
<Frame ID="201" X="4,25" Y="0.75" Width="3.23" Height="4,62" Z0rder="1" UnitIl="inches">
<ProductElement ProductID="110047">
<Templatelayout TemplateID="109964"/>
</ProductElements>
</Frame>
<Frame ID="202" X="0,75" Y="5.62" Width="3.25" Height="4,63" Z0rder="2" UnitIl="inches"»
<ClassificationElement ClassificationIl="IllustrationRoot">
<Templatelayout TemplateID="109964"/>
</ClassificationElement>
«</Frames
<Frame ID="201" X="4,38" Y="0.75" Width="3.28" Height="4.63" Z0rder="3" UnitID="inchez">»
<hzsetElement LzsetID="121205"/>
<HNoteFrame ID="1490212610420" X="1,79" Y="1,97" Width="0,59" Height="0.59" Z0rder="4" UnitIl="inches"
Status="trus">
<NoteRecord Username="USER4" Timestamp="Wed Mar 22 15:56:50 EDT 2017">This is approveds</NoteRecordsr
</NoteFramex>
</PageContenta>

</PlannedPage>

Description

<PlannedPage> Parent tag for all planned page information included in the export. Returns the
following information:

« PageNumber: Page number of the planned page
« ID: STEP ID of the planned page

<Name> Returns the STEP name of the planned page
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Tag Description
<MetaData> Parent tag for metadata <Value> tags
<Value> Returns the ID (AttributelD) and value of the description (metadata) attributes

linked to the planned page. If an attribute is calculated, Derived="true".

<TemplateLayout> Returnsthe STEP ID (TemplatelD) of the page template used on the planned page
<PageContents> Parent Tag for <Frame> tags
<Frame> Returns the following information about the Flatplanner frame:

» ID: STEP ID of the frame

« X: The X coordinate of the frame on the planned page

« Y:TheY coordinate of the frame on the planned page

« Width: The width of the frame

» Height: The height of the frame

o ZOrder: The layering order of the frames

o UnitID: STEP ID of the unit used in the frame measurements

<ProductElement> Returns the ID (ProductlD) of the product object linked to the frame

<ClassificationElement> | Returns the ID (ClassificationID) of the classification object linked to the frame

<AssetElement> Returns the ID (AssetID) of the asset linked to the Flatplanner frame

<TemplateLayout> When nested inside the <ProductElement> tag, returns the ID of the product
template attached to the frame

<NoteFrame> Returns the following information about the Flatplanner note:

« ID: STEP ID of the note

« X: The X coordinate of the note on the planned page
« Y:TheY coordinate of the note on the planned page
« Width: The width of the note frame

« Height: The height of the note frame

« ZOrder: The layering order of the note frame.
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Tag Description

o UnitID: STEP ID of the unit used in the note frame measurements

« Status: Whether or not the note has been marked 'done.' Returns 'true' if the
note has been marked done and 'false' if it has not.

« <NoteRecord>: Nested tag that returns the content of the note as well as the
following information:

« Username: STEP ID of the user that created the note

« Timestamp: Date and time that the note was created

Include Baskets

<Basket>
<ProductBasketLink ProductID="121171"/>
<ProductBasketLink ProductID="121178"/>
<ProductBasketlink ProductID="121177"/>
<ProductBasketLink ProductID="121184"/>
<ProductBasketLink ProductID="121192"/>
<ProductBasketLink ProductID="121218"/>
<ProductBasketlLink ProductID="121178"/>
<ProductBasketLink ProductID="12117&"/>
<hssetBasketLink LssetID="121200"/>
<hssetBasketlink LssetID="121205"/>
<ProductBasketLink ProductID="121179%"/>
<ClassificationBasketLink ClassificationID="IllustrationRoot" />

< /Basket>

Tag Description

<Basket> Parent tag for objects contained in the Flatplanner basket
<ProductBasketLink> Returns the STEP ID of the product object linked to the basket
<AssetBasketLink> Returns the STEP ID of the asset object linked to the basket

<ClassificationBasketLink> | Returnsthe STEP ID name of the classification object linked to the basket
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Include Pagination Rules

<PaginationRules3>
FD94bbwgdnVyeZlvhj0iMS4wliBlbmvEZGluZz0i dXBnLTgi Pz4KPFJ1bGVzIFZlenliph24 9T 711 PgoglD
XOYWdpbmF0aWsalUnVsZ2U0dyb3VwPgogIl CAgPFBhE2 1Y Rpbh2 55dWx 1 IFRScGUS I 1 Byb2R1Y SRUZW1whGFD
ZUF)dGlvbiIgT3ZlendpZGR1b ] 0iMTALAM I AY LTEL IE1 KPS TxMDgyMD I tMST+C1i AgI CAgTIDxDb 2 SkaXRph2
S5zPgogICAgICAgIDxDEL2 5kaXRpb24gSU09TkFsd2FScONvbnRpdGlvhi I+C1 AgTCAQICAgQICABUGFy YW1 1
AGVyoyE+C1L1AgICAQICAQPCIDb2 5kaRph2 44+ C1 AgTCAQTIDww2 9nZGl 0aWinezdEICAgICAgPEFjAG1vbn
M+ CiAgICAQICAgPEFJAGLlvbiBJRDOiUHIJvZHV)AFR1bXB=YHR1 QWHDaWInIiBUeXBl PSJOcm 9k dWHOVGVE
oGxhdGVBY 3Rph241 PgoglCAgTICAQTICAgPFEBhemFEZXR1 onM+Ci AgT CAgT CAgT CAGIDxOY L IThEWVOEX T gsT
QATnRIBXBsYXR1ST01i PmNvbhS52dGliby5ib3J1l LnBl cnlpo3R1bmM] Lk SvEGVO Ty 0yMDg2HDA=PC QY. Th
PWVOZXI+C1 AgICAqQICAgICAgI DY X ThbWVIZXIgSUQS InR1 X BYXR1IVGLOLGT1 P1dl ZGRphbnegUHIvEC
BUOZW1lwPCOOY X ThbWVIZXI+CiAgICAgICAgICAS L1 BhemFEZER] ocnM+Ci AgI CAgQT CAgPCOBY 3Rph2 4+Ci Ag
ICAQIDwwOWHDaWIncz 4 KICAGIDwvIGFnaWihdGlvbh 1l J1bGU+C1 AgPCI0YWdpbmFDaWsalnVs Z0dyb3VwPg
oBL1J1bGVzPg—<,/FaginationRules>

Pagination rules are included in encrypted strings in STEPXML files. As such, no additional information is
available. However, pagination rule strings are consistent, and as such can be copied and pasted between files for
reimport.

Include Workflow Tasks

<PlannedPage PageMumber="2" :D=“1U8315“IUSE:=“DTPUSER“>|

If Data Objects > Include Workflow Tasks is chosen as an outbound parameter in the Select Format step of the
Export Manager, the STEP ID of the user to whom the planned page is currently assigned in the Flatplanner
workflow will be returned within the <PlannedPage> tag.

Include Keys as IDs

When using Include Keys as IDs, the KeyValue tag will show the Key with the Key's ID on the frame it is mount to
aswell as if it's in the basket.

Frames

<Frame ID="281" X="4.38" ¥="@.75" Width="3.28" Height="4.63" ZOrder="1" UnitID="inches">
¢ProductElement ProductID=""3
|<KeyValue KeyID=”SuppliEPPaPtNLmher”>SPH—2@8@6<IkeyValue>|
¢Templatelayout TemplateID="1@7821"/>
</ProductElements
</Frame>
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<ProductElement>

StiboSystems

Description

Normally, this tag returns the STEP ID of the linked product object (for example,
ProductiD="12345"); however, when a unique key is used instead ofa STEP ID,
no value is returned (ProductID="").

<AssetElement>

(Not pictured in above
screenshot)

Normally, this tag returns the STEP ID of the linked asset object (for example,
AssetlD="12345"); however, when a unique key is used instead of a STEP ID, no
value is returned (AssetID="").

<ClassificationElement>

Normally, this tag returns the STEP ID of the linked classification object (for
example, ClassificationlD="12345"); however, when a unique key is used instead

(Not pictured in above ofa STEP ID, no value is returned (ClassificationID="").

screenshot)

<KeyValue> Returns the ID of the unique key being used to identify the linked object (KeylD)

along with the key value, which is inside the tags for the object.
Baskets

Tag Description

<ProductBasketLink> Normally, this tag returns the STEP ID of the linked product object (for example,
ProductlD="12345"); however, when a unique key is used instead ofa STEP ID, no
value is returned (ProductIiD="").

<AssetBasketLink> Normally, this tag returns the STEP ID of the linked asset object (for example,

] _ ProductiD="12345"); however, when a unique key is used instead ofa STEP ID, no
(Not pictured in above | \qjye is returned (ProductiD="").
screenshot)

<ClassificationBasketLink>

Normally, this tag returns the STEP ID of the linked classification object (for
example, ClassificationlD="12345"); however, when a unique key is used instead of

(Not pictured in above a STEP ID, no value is returned (ClassificationID="").
screenshot)
<KeyValue> Returns the ID of the unique key being used to identify the linked object (KeyID)

along with the key value, which is inside the tags for the object.
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Creating a Financial Report

To analyze the data that is available in the Financial Summary view, you can create an Excel-based Financial
Report. You can create the report from two levels within the publication hierarchy—the publication level and the

section level.

To Create a Financial Report

. Inthe Tree, expand the publication hierarchy. Right-click the relevant publication or section, and then choose
Financial Report. The Financial Reports dialog appears.

£¥] Financial Report @

i

Column View: :Default - Public v:
Show summary for: Actual pages -
Section Levels: 3 v |

Include product/classification information

Include page information

’ Ok ” Cancel

. Fromthe Column View list, select the preferred column view. The available views correspond to the views
that are available in Financial Summary view.
. Fromthe Show summary for list, select either Basket, Planned pages or Actual pages.

« Basket provides the data from Basket view
« Actual pages provides the data for DTP pages that have been saved back to STEP.

« Planned pages provides the data for the planned pages. If available, space usage data is extracted from
the actual pages.

. Fromthe Section Levels list, select the number of levels you want to include in the report. The level is relative
to the level you have clicked in the Tree.

For example, if you have selected a publication node in the tree, the publication is level 1, the version is level 2,
and the section is level 3.

5. Toinclude product names, check Include product information.

6. To view the financial data per page, check Include page information.

7. Click OK. Excel opens and displays the report.
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Space Usage in Financial Reports

Space usage provides information about how much space a product presentation takes up on a page. This
information is useful, for example, to analyze sales per square inch or millimeter for a product. This in turn helps
you decide how much space to give a product in the next catalog or where to place the product.

NCE Acme Party Supplies - Financial Summarv

ﬁ Flatplanner Publications ~ Publication || Plan || Version || Pages || Publication Planner || Plan Motes || BELELGEEITHGETRS | AutoPag:
[l christmas Catalog Column View: | pefadit chom o
=8
4:-l _g_g Commercial Data * Image Reference * PrimaryProductimage - Caption * Availability * Price Space Usage >
Ei ﬁ Party Hats Party Hats 0 0 302109, 31mm?
P ﬁ 2 - Party Hats Farty Favors 0 0 217753.91mm?
F3
..... ﬁa} Galley Page PaperIHats_... 0 0 263427, 47mm .
EI ) OTP Documents L1 0 $0 783290.65mm
-] 2 - Party Hats

To include space usage information in a financial report, do the following.

« Verify that space usage handles the white space of a product presentation the way you want it to.
« Add a Space Usage column to the Financial Summary view.

Space Usage Setup

The standard space usage setup calculates the space usage for a product presentation based on the raw data on
a page. It does not include the white space of the product presentation in the calculation.

For example, if you increase the font size of a product title, the space usage increases. However, if you increase
the size of a frame without increasing the size of the content of the space, the space usage does not increase.

To Include White Space in Space Usage Calculations

If you want to include the white space of a product presentation in the calculation as well, you have to set this up in
System Setup.

1. In System Setup, click Users and Groups.

2. Onthe System Settings tab, locate the DTP Settings area.

3. Click the value field of Enable calculation of border rectangle space usage for actual page.

@ DTP Settings
MName » [Value
* Use Publication Mame prefix when naming DTP documents i

Eﬁinable calculation of border rectangle space usage for actual pages I i
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The space usage now includes the white space of a product presentation from the upper left corner of the product
presentation to the lower right corner.

Note: You can only change this setting if you are a member of the Super User group.

Add Space Usage to Financial Summary View

If you want a financial report to include space usage information, you have to add the column Space Usage to the
Financial Summary view.

1. Inthe Tree, expand the Publication hierarchy, select a section or spread.

2. Onthe plan tab, click the Financial Summary tab.

3. Inthe upper right corner, click View Options, and then choose Edit. The Edit View dialog displays a list of the
current view content elements.

4. Click an element, right-click, point to Add, and then choose Space Usage. If Space Usage is not listed, click
Other ....

5. Click OK.
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Flatplanner Workflows

A STEP Flatplanner workflow links together all of the tasks involved in the process of planning and approving the
pages that comprise Flatplanner publications.

Unlike other STEP workflows, the Flatplanner workflow is integrated with InDesign through the STEP'n'design
plugin. This integration allows DTP (desktop publishing) users (also referred to as designers) to accept
Flatplanner workflow tasks from within InDesign without ever having to log in to the workbench.

STEP Flatplanner workflows typically involve tasks such as planning pages, approving planned pages, routing
planned pages to designers who carry out layout tasks in InDesign, and approving finalized pages. The object type
that moves through a Flatplanner workflow is the Planned Page.

Configuring a Flatplanner Workflow

Instructions on how to configure specific elements of a Flatplanner workflow that are unique to the Flatplanner
workflow are covered in the Configuring Flatplanner Workflows documentation. These unique elements
include the configuration of the STEP Tasks dialogs in InDesign as well as the options available in the
Publication Planner.

Sample Flatplanner Workflow

A sample Flatplanner workflow, which details the tasks involved in accepting tasks, planning a page, and
approving a page, is detailed in the Flatplanner Workflow Example documentation.

As with any STEP workflow, Flatplanner workflows are customized according to specific customer requirements.
This is merely a 'how to' example that serves as a walkthrough of a simple Flatplanner workflow.

Publication and Section Object Workflows
Workflows for publication and publication section objects may also be implemented in addition to a Flatplanner
workflow.

Publication and section workflows enable the assignment of tasks such as:

o Importing prices
« Publication planning, where information such as dates and styles are defined
« Linking of products to sections

« Population of metadata attributes on publication and section objects

Unlike Flatplanner page spread workflows (which require use of the Publication Planner), publication and section
workflows function like standard STEP workflows used for classifications, products, and assets. Also, a
Flatplanner license is not required to use a publication or section workflow. However, even with a Flatplanner
license, DTP users cannot pick up tasks related to publication and section objects in InDesign.
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Note: Publication objects and section objects cannot share the same workflow. Each object type must have its
own standalone workflow.

Publication and section workflows are created by the same methods as any other workflow in STEP. For
instructions, see the Getting Started with STEP Workflows section of the STEP Workflows documentation.
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Configuring Flatplanner Workflows

A Flatplanner workflow is built and configured like any other workflow in STEP, though it has a few features that
are unique to it, such as:

« The ability to send planned pages through a workflow

« The ability to stop and start workflows from the Publication Planner

« The ability to color-code workflow states in the Publication Planner

« The ability to set milestone / 'traffic light' colors in the Publication Planner, to give users a visual indicator of
how far along a Planned Page is in a particular state. See the Publication Milestones topic for more
information.

« The ability for desktop publishing (DTP) users to pick up workflow tasks in InDesign when changes need to
be made on actual pages

« Automated generation of InDesign pages using a background process, enabling DTP users to pick up
mounted InDesign pages in InDesign as part of the Flatplanner workflow process without having to manually
mount the pages themselves

The available options for a Flatplanner workflow will vary depending on how the workflow has been configured
and will vary from user to user.

General workflow topics such as configuring workflow states, transitions, views, etc., are not covered in this topic,
as they are not unique to the Flatplanner workflow.

Note: If you are using a Flatplanner workflow for the first time on a STEP system that is version 8.0 or higher, the
following property must be added to the sharedconfig.properties file on your application server:
Workflow.FlatPlanner.SelfContained=true. Forusers who have upgradedto STEP 8.0 but need to
continue using an existing (pre-STEP 8.0) Flatplanner workflow, this property should either be omitted from the
sharedconfig.properties file altogether or set to false. Contact Stibo Systems if you need assistance with this
configuration.

Creating the Workflow

A Flatplanner workflow is created by the same method as any other workflow in STEP. For instructions, see the
Getting Started with STEP Workflows section of the STEP Workflows documentation.

Flatplanner workflows must be made valid for the Planned Page object type.

Note: Only one object type is available in STEP for Planned Pages. Additional Planned Page object types cannot
be created.
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STEP Workflow Editor Log | Status

== valid for Attribute Types

&= valid for Classification Types
®-valid for Entity Types

&= valid for List of Values Types
®-valid for Asset Types
®-valid for Product Types

|© valid for Publication Tvoes

% valid for Publication Planned Page Types

ag

==Valid for Publication Section Types

StiboSystems

In addition, at least one state must be configured for use by DTP users in InDesign. See the Configuring DTP
Task Views for InDesign topic for more information.

Configuring Status / Workflow State Colors

In Flatplanner workflows, workflow states can be configured with color coding that displays in the

Publication Planner, on planned pages, and on actual pages. This color coding gives workbench users a quick
way to obtain an overview of which states each planned page is currently in.

The following screenshot shows how these state colors display in the Publication Planner.

Note: If the Status column is not visible in your Publication Planner view, it must be added. See the
Configuring the Publication Planner Column View topic for more information.

I Publication Section ” Plan ] Publication Planner [ Plan Motes “ Financial Summary ]
Column View: -Default - View Options
Thumbnail * Name * |Page Number Siaby i1y * |Assignee
o
> J Napkins 42, 43 Review (EN) 35477 Super user
Il a4, 45 PIGHNING (BN 135962 Super user
=
> j 46, 47 DTP (EN) 135995 Super user
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Each status may be assigned a custom color. These status colors are configured by adding an RGB value to an
On Entry business action for each state that should receive a color code. This is achieved by setting the value of a
workflow variable called STATE_COLOR in the following business rule:

node.getWorkflowInstance (workflow) .setSimpleVariable ("STATE COLOR", "217,241,253");

In this example, 217,241,253 is the RGB value of the light blue Review state shown in the previous screenshot.

Note: The Assigned status cannot be assigned a color by this method, since it is not a workflow state. If you
require a different color for the Assigned status, contact Stibo Systems.

Configuring State Color Business Actions

To configure the business rules that set status colors, follow these steps:

1. Locate the Flatplanner workflow in System Setup that you would like to edit, then right click and select Edit
STEP Workflow. The STEP Workflow Designer displays.

2. Inthe Workflow Variables/Attachments area, click the Add icon and select Add Workflow Variable.

File Edit View
Workflow Properties

D FPusingGroup
Name |Flatplan group assignment

Workflow Variables/Attachments

B SIS

Validation er]

Add Workflow Attachment
Add Workflow Variable

m STEP Workflow Designer - FPusingGroup*

[} Flatplan group assignme

~Entering planning (1}
R
B GP-hounit Doz ForPlarg (1

bop

Plan_Changes

bgp.sugceeded

s
| I E Review (1)

3. Inthe Add Workflow Variable dialog that displays, enter the ID STATE_COLOR, then click OK. The

variable is created.

£23 Add Workflow Variable ==
D STATE_COLOR
Attribute ()
Expression

oK Cancel
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Next, in the STEP Workflow Designer, double click on the workflow state for which you would like to specify

a state color. The State Editor dialog displays.

In the State Editor, navigate to the On Entry tab and click Add new Business Action, then click on the Edit

Operation icon on the Operations tab.

Sl

E] State Editor

Edit
_‘.ﬂU[ Screen Mapping I

Mandatory Attributes

State | On Entry | On Exit | Assignee | Deadline/Escalation | Comments
Business Rule (Local business rule to be save|...| |‘E
MName
Description
Type Action
Scope Local
Run as privileged [
Opeggions | Dependencieslhpplies if
LT

Merge into

Add new Business Action

[ Show Edited State ]

In the Edit Operation dialog that displays, click the dropdown list in the upper left-hand corner and select
Execute Javascript. The Execute Javascript options now display in the Edit Operation dialog.

E] Edit Operation

Ex5

[ | Execute Javasoipt ;]

Binds: ? Binds

[variable name

> |Binds to

=

§ Messages

Messages:

Variable name > |Message

» [Translations

=

Javascript: |

Edit externally

< | 1

[ 3

’ Save ” Cancel

© Stibo Systems - Confidential - STEP Trailblazer 8.3

194



10.

11.

StiboSystems

Click the edit button (%]) under the Binds flipper. The Edit Binds dialog displays.

Click the green plus sign Add Bind button (). Type node in the Variable name field, then select Current

Object from the Binds to dropdown list.

Click the green plus sign Add Bind button () again. Type workflow in the Variable name field, then select

Workflow > Current Workflow from the Binds to dropdown list.

Your Edit Binds dialog should now look like the following screenshot. When finished, click OK to close the

dialog.
E]Edit Operation | x |
I | Execute Jzvasonipt ;]
Binds: % Binds
[variable name > |Binds to
Messages: ¥ M E] ol ii. @
IW Variable name Binds to Parameters
node [Current Object -
Javascript:
P workflow [Current Workflow -
Add Bind
Edit externall
4
[ OK ] [ Cancel ]
|

In the JavaScript field, copy and paste the following code:

node.getWorkflowInstance (workflow) .setSimpleVariable ("STATE COLOR", "217,241,253");

E] Edit Operation

x5

[ | Execute Javasoipt ;]

Binds: % Binds

Variable name

Binds to

node

Current Object

workflow

Current Workflow

bS]

Messages: ¥ Messages

Variahle name

> |Message

» [ Translations

JavaSeript: | node. getWorkt lovInstance (workflow) .setSimpleVariable ["STATE COLOR", "217,241,253");

Edit externally

Save Cancel
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12. To customize the RGB value, replace the three numeric values with the RGB values of the preferred color.

13. Click Save to close the Edit Operation dialog. The business action is configured.

Viewing State Colors in Locations Other Than the Publication Planner

State colors for Flatplanner workflows also appear in the workbench in the following locations:

» Below Planned Pages on the Plan tab:

Planned Page

Flatplanner
WBEEQ‘%‘ |—E”7( Y |W: H: }ViewiPIan 'i -
Napkins
2 43

T
|Red Heart Con [ [Pink Heart Co

1
[Streamers - Bl [ [Streamers - H

Review (EM)

« Below actual pages on the Pages tab:
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Tree € 42 - Nankins rev.4.0 - Pages
~[@ Promotions - Document m References || Status

~{g Publications

-l Templates

B Standard Publications

&) Autopage Publications
=& Flatplanner Publications
=@ Spring Wedding Catalog
G+ Commercial Data
- @@ New March 7
[+ Party Favors_1
--ﬁ Party Favors_2
[+ Cards & Stationery
&l Decorations
F#-E@ Cake Toppers
[ Hair Accessories
[ 8 Drinkware
=8 Napkins

----- 42 - Mapkins

m

- @ Halloween Catalog

» Below actual pages on the Page data tab:

42 - Page data

2 geEorgtions : Motes || References || Status
ake Toppers
[ Hair Accessories i
#- @0 Drinkware Name »|» Value >
= @@ Napkins > D 135943
(2 42 - Napkins
H-— >
=-E DTP Documents AT =
E-EL42 - Mapkins > Created Mopg Mar 07 17:18:06 EST 2016
. Status Review (EN)
""" ? Fagenumber =¥3
‘@ Halloween Catalog .
‘@ christmas Catalog > [Is Overset Mo

« Below actual pages on the Details tab:
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Tree 42 - Details
-l Templates + ||| Page data MNotes || References || Status

& Standard Publications ——
ﬁ Autopage Publications Spring Wedding calalog

=& Flatplanner Publications L metie e e —
=@ Spring Wedding Catalog
G- Commercial Data
--ﬁ New March 7 -
[+ Party Favors_1 z
--ﬁ Farty Favors_2 SEhm o A il 0 el Htne ot 1 12 s
[ @8 Cards & Stationery
[ Decorations

[#-E@ Cake Toppers
[ Hair Accessories

[ @8 Drinkware

=8 Napkins

»

m

111

Fazances Bluc & drange #meamers Harglhg

i Wk 00 et 0 P I ki1 0 T
Bz o & oA D im gogal awk dl

bl

Halloween Catalog il
Christmas Catalog

Mew Publication 7 4l = E|

| 1] | »

Bl

For More Information on RGB Values

Though RGB values must be entered manually in the JavaScript string to configure state / status colors, an Add
Color dialog exists in STEP that could be used as a guide when deciding on a color. This guide displays the
numeric values for RGB colors, which could be copied and pasted into the relevant area of the JavaScript string.
For information on how to access the Add Color dialog, see the Defining Table Colors in STEP section of the
STEP Tables documentation.
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|§watches|ﬂsu1HSiE| REBHIM

1 217

Hl 2

253

Preview

D Sample Text Sample Text

Has

255

==

Color Code DIF1FD

| ok |[ cancel
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Configuring DTP Task Views for InDesign

DTP users accept STEP Workflow tasks in InDesign from the STEP Tasks palette. This palette is also where
DTP users return these tasks—in the form of actual pages—back to STEP after completing work on the page.

Note: This topic describes the functionality of the STEP Tasks palette in the context of how to use it with a
Flatplanner workflow. For a detailed explanation of all menu items on the palette, see the STEP Tasks topicin the
STEP'n'design documentation.

[E 44 (Party Accept Task

[ Publication:Hallo Show Details
Refresh
Goto in Structure View

Goto in Publication View
Open document
3ITasks Filter

_ Show Tasks for Current Publication Only

When DTP users click Accept Task from the STEP Tasks panel, an Accept Task dialog displays.

Accept Task
DTP {en_UIS) - 50
In Flatplan group assignment process "Wedding Candy” started by on 30/03/16 06:30

Plezse process the pageispre... -

Comments Please add background graphics to right page

[] Open document [] Goto in Publication View [ Accept | [ Cancel |

Enabling the Accept Task Action in the STEP Tasks Panel

To enable the Accept Task action in the STEP Tasks panel in InDesign, at least one Component column using
the DTPTaskInfoProvider component must be added to the View for the DTP workflow state. This is configured
as follows:

1. In System Setup, navigate to the desired Flatplanner workflow, then right click and select Edit STEP
Workflow. The STEP Workflow Designer displays.
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2. Inthe STEP Workflow Designer, navigate to Edit > Edit Workbench Views and Mappings. The View
Editor displays.

3. Ifnoviews or mappings are already present, create them according to the steps outlined in the Views and
Mappings for Workflows section of the STEP Workflows documentation.

4. Rightclick the View for the DTP workflow state, then select Add Column > Component.

£33 view Editor
Edit
Editor | xmL

=& Vview: DTP -
- View: Wao Add Column * Attribute

Attribute Group
Aspect

Move Down

Delete Component

5. Select DTPTaskInfoProvider from the Component dropdown list, then insert the desired text (which you
would like the DTP operator to see) in the Title field. The following screenshot shows the standard
configuration for the required DTPTaskInfoProvider component column.

£%3 View Editor s
Edit

Editor|xm

B' View: DTP Compaonent

----- El® [Column:Please process the page/spread: (DTPTaskInfoProvider)]

_____ < Aspect: id \ Title |Please process the page/spread:
| Aspect: name Read Only

~EE Column:Comments (DTPTaskInfoProvider)
~ [ Column:Comments (WorkflowVariable) [] Mandatory
& view: Workbench r ]
----- 15 Mapping : Entering planning->Workbench Component  DTPTaskinfoProvider x|
----- 5 Mapping : Review->Warkbench

----- 5 Mapping : DTPPageWork->DTP

----- E Mapping : HandleBGPError-=Workbench

This column will not appear in the Workbench
View. When applicable the Variable value will be
send as Task info to a DTP system. The Variable
ID will be used for value-name and the column
Title will be description.

Variable vi

Adding Additional Fields to the Accept Task Dialog

To add additional fields to the Accept Task dialog in InDesign, additional columns using the
DTPTaskInfoProvider component may be added to the View in conjunction with workflow Variables.

The following example shows the column configuration for a Comments field. It uses the DTPTaskinfoProvider
component in conjunction with a workflow variable called COMMENT:
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£33 view Editor
Edit

Editor|xm

=5

=HE& view: DTP
& Column:Please process the page/spread: (D1

----- EE Column:Comments (WorkflowVariable)
& View: Workbench

----- 5 Mapping : Entering planning->Workbench
----- 5 Mapping : Review->Waorkbench

----- E Mapping : DTPPageWork->DTP

----- E Mapping : HandleBGPError-=Workbench

E [Column:Comments (DTPTaskInfoProvider)] N

Component
Title

N\

Cumponent:

Comments

[] rRead Only

[] mandatory
DTPTaskInfoProvider v:

This column will not appear in the Workbench
View. When applicable the Variable value will be
send as Task info to a DTP system. The Variable
ID will be used for value-name and the column
Title will be description.

Variable

COMMENT v

The Comments field appears in the Accept Task dialog in InDesign:

Accept Task
DTP (en_US) - 50

Dlecos prr=cs the nzmalzoes

In Flatplan group assignment process “Wedding Candy’ started by on 30/03/16 05:30

Commeants
Comment:

s Please add background graphics to right page

[] Open document

Goto in Publication View

[ Accept | [ Cancel |

This same Comments field can also be viewed in the workbench and populated with content before DTP users
pick up the task in InDesign. This is accomplished by adding a Component column to the View of another
workflow state that is viewable in the workbench. This should be a state that the Planned Page passes through

before it is routed to InDesign.

In this example, the component is WorkflowVariable and the variable is COMMENT (the same variable used to
generate the Comments field in the Accept Task dialog). The following screenshot shows this configuration for a

sample View called "Workbench':
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£33 view Editor
Edit

Editor | xmL

Sl

=B view: DTP

iﬁ Aspect: id
Aspect: name

-~ EE Column:Comments (Workflow\Variable)

=B view: Workbench

-~ EE Column:Preview (WorkflowFlannedPage)
Aspect: name

- BE [Column:Comments (WorkflowVariable)]
~EE Column:Notes (WorkflowNoteColumn)
----- E Mapping : Entering planning->Workbench
----- & Mapping : Review->Workbench

----- E Mapping : DTPPageWork->DTP

----- E Mapping : HandleBGPError->Workbench

< | 1 |

- B Column:Please process the page/spread:

- B Column:Comments (DTPTaskInfoProvider)

iﬁ Aspect: id
B Column:Claim (WorkflowTaskColumn)

(D

Compoanent

Title | Comments

[ ] Read only
[ | mandatory

Component :Workﬂow‘.r'ariable

Variable | COMMENT

This is how this column looks in the workbench:

STEP Workflow Items

LR LTSIV BEENEN [ Plan || Planned Page || Plan Notes || References || Status || State Log || Tasks

Preview * [Name *|Claim Comments ¥
= = Flease add background
¥ ) . .
‘ 1 B l graphics to right page
Wedding Candy *[* Wedding Candy 135991 a2
Ly

Fields in the Task Completed Dialog

Any columns added to the Accept Task dialog in InDesign using the DTPTaskInfoProvider component also
appear in the Task Completed dialog (also accessed from the STEP Tasks panel in InDesign). The Task
Completed dialog displays when D TP users have completed working with the page in InDesign and return it to

STEP.

The following screenshot shows how the Comments 'column’ looks in the Task Completed dialog. DTP users
may overwrite the incoming comments, which will display in the workbench when the page is returned to STEP:
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Task Completed
Sl el Save Documnent and Page information -
In Flatplan group assignment process "Wedding Candy” started by on 30/03/15
i [ B Standard Publications .
Please process the pagelsore.., - [ ﬁ Autopage Publications
ICor'r'ems Page is complete I = [E0 Flatplanner Publications @
= [l Sering Wedding Catalog
[l March Exchusives
: -
Mote: |
Save document to STEP [ | Close and delete local copy [ Completed | Cancel

£ STEP Workflow Items
VRV LTS GVRENEN | Plan || Planned Page || Plan Motes || References || Status || State Log || Tasks
> |ID

Preview * [Mame > |Claim Comments >
= = Page is complete

Y &
Wedding Candy > Wedding Candy 135991 &)
b g
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Flatplanner Workflow Example

This topic serves as a 'how-to' primer for working with a sample Flatplanner workflow and illustrates some
common tasks that are performed as a Planned Page moves through the various workflow states. The example is
simple but is examined on a state-by-state basis to provide you with a working knowledge of how a Flatplanner
workflow actually functions, not just how to configure one.

The following screenshot shows a very simple Flatplanner workflow configuration in the STEP Workflow
Designer. This is the example used in this tutorial.

m STEP Workflow Designer - FlatplannerWF @
File Edit View
Workflow Properties @ FlatplannerWF (FlatplannerWr) @&

D Flatpl WF

Name |FlatplannertvF

|
Waorkflow Variables/attachme... Retry

'STATE_COLOR! abe: i B .
BGP-MountDocForPlan |1 @

Plan_Changes -
bap-failed

Validation errors: bop sudceeded ManuaMouint

=~ — " { pTPPagework
- '| Review ([} .

OTP-reiwork

Accepted

Cone (1

=

This topic does not explain how to create or configure a Flatplanner workflow and assumes the following:

« The Flatplanner workflow is already created in STEP. If not, refer to the Configuring Flatplanner
Workflows topic for more information.

« The Planned Page has already been initiated into the workflow. If not, refer to the Starting and Stopping
Flatplanner Workflows topic for more information.

Note: As with any STEP Workflow, individual user requirements will determine the exact configurations. This
sample merely illustrates some standard uses of Flatplanner workflows in general.
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Planning the Page

The first state of our example workflow is named Entering Planning. The name that displays on the STEP
Workflow tab under Tasks is determined by locale. In this instance, the Entering Planning state is named
Planning (EN) since we are working with an English version of STEP.

m Localize State Names and Events @

| State Names§| E\rent5|
1D * Name * |Danish * |English * |Spanish * |French >

» [PlanningTask Entering planning Planning (EM) Planning (SE) Planning (FR)

» [BGP-MountDocForPlan

» [Reviews Review (EM) Review (SE) Review (FR)

» |[Done Done (EN) Done (SE) Done (FR)

» [DTPPageWork DTPPageWork DTF (EM) DTP (SE) DTF (FR)

» HandleBGPError

The typical task performed during this state is for a workbench user—for example, a merchandiser who
determines product placement in catalogs—to plan the Flatplan pages. The central task of planning a page
involves linking products into frames on a Flatplanner page spread (Planned Page). Page planning can be done
without using a Flatplanner workflow, but the workflow enables you to receive your page planning assignments as
tasks.

If you are a page planning user, follow these steps to plan a page in conjunction with our sample Flatplanner
workflow:

1. Todetermine if you have been assigned a page planning task, click the STEP Workflow tab, and then click the
Tasks tab.
2. Navigate to the relevant Flatplanner workflow, then click the Flipper icon ® to view the tasks for the workflow.

3. Inthe Tasks list, click the first state, Planning (EN), to view the pages that are in the Planning state. Unless the
task has been assigned directly to you, you will need to click on the 'Show all items' or 'Show all items assigned
to me or any group | am a member of' icon [outlined below in red frame] in order to view all available tasks to
your User Group.

4. To claim atask and make it unavailable to other users in your User Group, click on the Claim icon.

5. Inthe Preview column, click on the page spread that you would like to plan.
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{ STEP Workflow Items -

P o Prafile STEP Workflow Items NI =sfivg
N all
TH | ~!| & FlatplannerWF 0 - [Preview »|D » |Name » |Claim
™ n ' =P .
SHE ? .lﬂ""erwﬂfﬂ"ﬂw Party Hats >.l 135953 Party Hats o)
5 ik 9 2 'l 135954 &
= ) - - Tl
pll  — |Filter by Collection E]: Party Napkins >.l @ 135962 Party Napkins | &%) E
3 Planning (EN m
2% | HandleBGPError 0
Fl| 8 | Review (EN) 2
<8 { i 3
S & TP (EN) 0
w ;
3| !

6. The planned page spread displays in the Flatplanner on the Plan tab. Plan your page, and then click the

Saveicon in the toolbar to save the changes.

7. Click on the Tasks tab to navigate to the Tasks view.

I STEFP Workflow Itermns ]m[ Planned Page ” Plan Motes “ References ” Status “ State Log [ Tasks ]

Flatplanner
E HEE - |—q‘:{ \E ‘w: H: |ViewiPIan 'i Y
Party Mapkins
8 22 22 9
treamers - Mult tar Confett

[T : Wedding Product Temj

[T+ Wedding Product Ternpl

[T+ Wedding Product Ternpl

[T+ Wedding Product Tern]

[Streamers - Hanging|

[Streamers - Blue & Oranod

Pink Heart Confett

[T : Wedding Product Temj

[T+ Wedding Product Ternpl

[T+ Wedding Product Ternpl

[T+ Wedding Product Tern]
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8. Onthe Tasks tab, click Submit to move the spread to the next workflow state. A Submit items dialog displays
where you can enter information about the page if you wish, but this is optional.

9. Click Submit Now. The page moves along to the next state in the workflow, a 'hidden' state named BGP-
MountDocForPlan.

Auto-generation of the Actual Page

Inthe BGP-MountDocForPlan state, a background process calls the InDesign server. The InDesign server then
generates (mounts) the actual pages based on the information linked to the Flatplanner page spread. When
completed, the InDesign server saves these actual pages into STEP.

Note: An InDesign server (sidecar) must be connected to your STEP system in order for this background process
to run. For more information on the deployment of an InDesign server, contact Stibo Systems.

Once the InDesign server saves the actual pages to STEP, the actual pages are routed to the Review state.

If the background process fails (for reasons that could include the InDesign server being offline), and the actual
pages are not generated by the InDesign server, then business rules may be put in place that will route the
planned pages into the DTPPageWork state in order for a DTP (Desktop Publishing) operator to manually mount
the Flatplan onto actual pages in InDesign.

Reviewing the Actual Page

In a typical page reviewing state, you will look at the mounted actual pages to determine if the pages are OK as-is
or if they need additional layout work performed in InDesign.

1. Todetermine if you have been assigned a page reviewing task, follow steps 1 - 4 as outlined in the previous
section, except this time click on the Review (EN) state.

2. Inthe Preview column, click the page spread that you want to review.

STEP Workflow < STEP Workflow Items
Profile Multi Editor

- Discontinued State - Preview > |ID > |Name » |Claim
& Entity Workflow i
&= FlatPlanner i =
- FlatplannerTB ) ’ | .

Goodie bags » ' 135414 Goodie bags |
& FlatplannerWr 9 & | o om 9 ¢
§ Flatplanner Workflow

es sl -
Filter by Collection B b =
Planning (EN) 2
HandleBGPError 0
3
0

Napkins > 9 [135477 Mapkins &3

Review (EN)
DTP (EN)

4 1
B Hat Workflow

el Accepted EN v.m
o - Accep |_submit_|

3. The actual page displays in the Flatplanner on the Plan tab in the Mounted Pages view.
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Party Napkins - Plan
lan Motes || References || Status || State Log | ptead
STEP Worlflow Items ]m Planned Page

Flatplanner

. oy . r -1 - |
.@ L |Er|)(: AE ‘W: H: View Mounted Pages ¥ U
Party Napkins
Fpeing W ey Catalizy Saning Wi blivey o iy
U S - Sl & A Fiee Haan C2rtin R Haart Coavand W
E =
= &
= =1
] ]
=z z
Srewrmn . Pupn Ziwarwn =Ma | TrmaTE Nangir Ziw CaTeld
" R )
._.13 e ‘%g-.‘:‘-f: ]
SR SN
T e 2 .
L _
SRR IRALE N W AT b S ARt T SRR ATTA  T TORIP 2 AT - W T
LT F e Lot hathg e
e
- Aumelily teps ko D 1Y IRTRL P ITES PRI TS 1Y an

Review (EN)

4. Ifyou wish to generate a PDF of the actual page, right click anywhere on the displayed page and select
Generate PDF. The system will call the InDesign server and a PDF of the page will generate and open
automatically.

Mapkins
45
Savings Wi ke el
PimE Haen Lot Faed Hean Cariard o
A=
Ficl = vy
=
i . =
sl =
Set page template...
Layout
; View
[ i Generate PDF
i Print planned pages...
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5. When you have finished reviewing the page, the following Submit options are available in our sample
workflow:

I

ccepted e~ subm |
Accepted EN

DTF EN
Plan Change EN

« Accepted EN: The page is approved and is sent to the Done state of the workflow, at which point it is
removed from the workflow.

o DTP EN: The page needs some manual work performed on it by a DTP operator in InDesign. The page will
be sent to the DTPPageWork state [DTP (EN)], which is a state in which the task must be accepted in
InDesign.

« Plan Change EN: The Flatplan needs more planning work performed in the workbench. The page will be
returned to the Planning (EN) state.

Accepting a DTP Task in InDesign

If the page reviewer chose the DTP EN transition from the Review state in the workbench, the page is routed to
the DTPPageWork state [DTP (EN)] in our sample Flatplanner workflow. Tasks in the DTPPageWork state must
be accepted from within InDesign.

To accept a Flatplanner workflow task from within InDesign, follow these steps:

1. Open InDesign and log onto the relevant STEP system.

2. Navigate to Window > STEP Tasks. The STEP Tasks panel displays.

>

3. Clickthearrow ™ nextto the relevant publication to expand all tasks that are available for that publication.

STEP Strul STEP Tem| STEP Imag STEF Tasks | STEP
7 Publication:Spring Wedding Catalog (2/2)
[ 44 (Party Napkins) - DTP (en_US)

[ Publication:Halloween Catalog (1/1)

|

3/3Tasks

4. Right-click on the relevant page, then click Accept Task. The Accept Task dialog displays.
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Accept Task
DTP (zn_US) - 50
In Flatplznner Workflow process "Goodie bags’ started by on 05/03/16 03:23

'spre...

5 T
i

]

ES58 Pro0ess the page/

g

[/] Open document

Goto in Publication View (

Cancel |

) |

Accept

. Click Accept to simultaneously open the document and the STEP Publication View panel, where the

accepted page will be highlighted.

Spring Wedding Catalog

Pink Heart Confetti

Q [} - -
W wTE R
Ot x|
P & STE STE STE STE & STEP Publication View =
]
|- - [ (B {135977) "
. 7 [l Party Favors_2
a W . =
M T -
' [
H T g DJ - Goodie bags
4 - Party Hats
oW YouLr [ER4 - pany
Bz - Party Hass
e - Gonfers =

Spring Wedding Catalog / English US

Note that Open document and Goto in Publication view are checked by default in the Accept Task dialog.
Uncheck Open document if you would like to finish claiming the task but open the document later. Uncheck
Goto in Publication View if you do not want the STEP Publication View panel to automatically display when

the page is opened.

. Once you have finished work on the pages, return to the STEP Tasks panel. Right-click the page that you
were just working on (which is distinguishable by no longer being in bold text), then click Task Completed.

The Task Completed dialog displays.
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Task Completed
DTP {en_US) - 50 - -
. : — e , o Save Document and Page information -
In Flatplznner Workflow process "Goodie bags’ started by on 0%/03/16 03:50
.
- [» [l Cards & Stationeny

[+ [l Decorations

[+ [E8 Cake Toppers
[» [l Hair Accessories
[» ([l Drinkware =

111

Mote: Page has been remounted with plan updates

[/] Save document to STEP [ | Close and delete local copy [ Completed | [ Cancel |

7. To save the finished document back to STEP (which is the most common action at this stage of the workflow),
check the Save document to STEP box, then click Completed. The Section folder where the actual pages
should be saved in STEP is highlighted automatically. Optionally, you may leave a comment in the Note field
(and/or Comments field, if present, depending on your workflow's configuration).

If you prefer to not save your documents locally and only save them in STEP, then check Close and delete
local copy before clicking Completed.

Note: The page must first be saved locally, regardless, before it can be saved back to STEP.

8. Inour sample workflow, the actual page will now be routed back to the Review state for final signoff by a page
reviewer (e.g., the merchandiser).

Canceling a DTP Task in InDesign

If, after you claim the task in InDesign, you determine that you need to release it back to your user group so
another user can claim it, you may cancel the task. To cancel the task, follow these steps:

1. Inthe STEP Tasks panel, right-click on the page and select Cancel Task. The Cancel Task dialog displays.

Cancel Task
DTP {en_US) - 50
In Flatplznner Workflow procsss "Goodie bags' started by on 05/03/16 D4:51

[ cancel Task | [ Cancel |

2. Click Cancel Task to reject the task, enabling another user from your group to claim it. The task will remain in
the STEP Tasks panel and return to bold text.
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If your workflow has been configured with a Comments variable, you may optionally leave a comment in this
field. For more instruction on how to configure the Tasks view in InDesign, see the Configuring Flatplanner
Workflows section of the Flatplanner documentation.

Final Review

When the InDesign page has been completed, or if it never needed to be updated in the first place, the page will be
in the Review state of our sample Flatplanner workflow. To complete the journey of the page, follow these steps:

1. Follow the same steps as outlined in the previous Reviewing the Actual Page section of this topic.

2. When happy with the page, select Accepted EN to route the page to the Done state. Typically, an on-entry
business rule action will be applied to the state to automatically remove the page from the workflow.

I

accepted en__<][ subm |
Accepted EN

DTF EN
Plan Change EN
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Starting and Stopping Flatplanner Workflows

Planned Pages (also known simply as pages or spreads) can be initiated into a Flatplanner workflow both
manually and automatically. By either method, planned pages can be initiated into a workflow on a one-at-a-time
basis or in bulk actions where multiple pages are initiated at once.

Pages can be initiated manually from both the Publication Planner and Tree, and automatically upon their
creation when the primary Flatplanner workflow is set to initiate automatically.

Planned Pages can be manually removed from a Flatplanner workflow from the same two locations where they
can be manually initiated: the Publication Planner and the Tree.

Starting the Workflow Manually

If your Flatplanner workflow has not been configured to initiate automatically, you will need to manually initiate
your Planned Pages into the workflow. Planned Pages can be initiated into a Flatplanner workflow from two
locations: the Publication Planner and the Tree.

Method 1 - Publication Planner

To manually initiate a Planned Page into a Flatplanner workflow from the Publication Planner, follow these steps:

1. Inthe Tree, expand the Publication hierarchy, and then select the relevant publication or section. The
Publication Planner is accessible from both locations.

2. Click onthe Publication Planner tab.
3. Onthe Publication Planner tab, click the plus + sign next to the relevant section to view the Planned Pages

within the Section. If your Publication Planner view has not been configured with the 'Group by section’ view
option, the Section name and + sign will not appear.

4. Planned Pages that are not already in a workflow will show a status of Assigned in the Publication Planner.
Assigned means that the planned page will automatically be assigned to a User Group once the page is
initiated into the workflow.

< Party Favors - Publication Planner

-

""" [0 GDSN Receiver data pools + ||| AutoPage Publication Planner State Log || Tasks
&[0 Promations | Publication Section H Plan [ Plan Notes H Financial Summary

= Publications

I

- ) Templates Column View: | Default -
- Standard Publications : i 1
- Autopage Publications Thumbnail > IName > |Page Number | [Status o > i » |assignee
=& Flatplanner Publications & - Party Favors
- Christmas Catalog Import~ Party Hats 2,3 1B5412 N/A
=@ Spring Wedding Catalog Goodie bags 4,5 185414 /A
__ -6 Commercial Data Confetti 6,7 165420 N/A
(9 Party Favors Candy 8, 9 185424 N/A
¥ Cards & Stationery Napkins 10, 11 15427 N/A
588 Decorafions Noisemakers 12,13 15429 N/A
. E-ER Cake Toppers
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5. Select the Planned Page spread or spreads that you would like to initiate into a Flatplanner workflow. Spreads
may be multi-selected by holding Ctrl or Shift while making selections.

6. Right click and select Start Workflows. The Start Workflows dialog displays.

I Publication Section H Plan ] Publication Planner Flan Motes H F
Column View: .Default =
Thumbnail > [Name » Page Number > [Status > [ID

* =l Party Favors

Goodie bags g 2,3, Assianed 135414 |
Party Hats 4,5 \ Add Section In v
Confetti 6,7 \ |®m Create new Section from existing... B
Candy 89 |\ Add Pages Before Selected Page L
Napkins 10, 11 \ Add Pages After Selected Page/Section -
Noisemakers 12,13

Autonumber Pages B

Set page template
Remove Pages

View Plan

Assign Pages
Start Workflows 0
Stop Workflows

7. Inthe Start Workflows dialog, select the relevant workflow from the Workflow to start dropdown list, then
click OK. Optionally, you may enter a process note in the Process note field.

E’ Start Workflows

D Workflow to start iEFIathanner Workflow! vi

Process note

[ oK H Cancel

8. The Planned Page is initiated into the initial state of the selected Flatplanner workflow.

I Publication Section H Plan l Publication Planner Plan Notes

Column View: -Default -
Thumbnail * [Name * |Page Mumber Status D
» =l Party Favors
> Goodie bags 2,3
> Farty Hats 4, 3
> Confetti 6, 7
> Candy 8,9
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Note: Once a Planned Page (spread) has been initiated into a Flatplanner workflow, it may not be initiated into
another Flatplanner workflow.

Method 2 - Tree

To manually initiate a Planned Page into a Flatplanner workflow from the Tree, follow these steps:

1. Inthe Tree, navigate to the Planned Page(s) that you would like to initiate into the workflow.

2. Right-click and select Initiate in STEP Workflow. Multiple Planned Page spreads may be chosen at once by
holding Ctrl or Shift while making selections.

& Flatplanner Publications

@@ Christmas Catalog Import Test
=@ Spring Wedding Catalog

-5 Commercial Data

@R Party Favors |_|
----- {7117 - Gondie hans

V@@ Initiate in STEP Workflow

""" Remave from STEP Workflow

m 12 - Noisemakers
=& DTP Documents

3. Inthe Start Workflows dialog, select the relevant workflow from the Workflow to start dropdown list, then
click OK. Optionally, you may also enter a process note in the Process note field.

4. The Planned Page is initiated into the initial state of the selected Flatplanner workflow.

Note: Once a Planned Page has been initiated into a Flatplanner workflow, it may not be initiated into another
Flatplanner workflow.

Start All Workflows Option in Publication Planner

As outlined in the steps in the previous two sections, multiple Planned Pages can be initiated into a workflow by
multi-selecting them in the Tree or Publication Planner. A third option also exists to submit Planned Pages into a
workflow at once: the Start All Workflows button in the Publication Planner.

| AutoPage Publication Planner " Pagination Rules || Page Inspector || Status " State Log ” Tasks ]

| Publication Section “ Plan ] Publication Planner I Plan Motes Financial Summary ]
Column View: | Default - View Options
> Mame * |Page Mumber * |Status > ID
Party Masks 8,9
Mapkins 10, 11
Confetti 12,13
Moisemakers 14, 15

4 1 [

Start All Workflows Update l
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Clicking Start All Workflows is essentially the same thing as multi-selecting all Planned Pages in the Publication
Planner, right-clicking, and selecting Start Workflows. This button merely provides the convenience of a one-
click operation to achieve the same outcome.

Starting the Workflow Automatically

If the Flatplanner workflow is set to auto-initiate, new spreads will automatically appear in the initial state in the
Publication Planner.

In order to allow Planned Pages to initiate automatically in the workflow, follow these steps, which are the same as
for any standard STEP workflow:

1. In System Setup, navigate to the relevant Flatplanner workflow.

2. Onthe STEP Workflow Editor tab, check the Initiate automatically box.

3. New Planned Pages will automatically initiate into this workflow when created.

Note: Though STEP systems of version 8.0 and above allow the existence of more than one Flatplanner
workflow, only one Flatplanner workflow at a time should ever be set to auto-initiate. Allowing Planned Pages in
more than one workflow at once can cause conflicts if more than one user is working on the same page at the
same time, as STEP provides no version control to prevent multiple users from saving over each other's work.

Stopping the Workflow

Planned Pages may be manually removed from workflows in the same two locations where they can be started
manually: in the Publication Planner and in the Tree.

Method 1 - Publication Planner
To remove a Planned Page from a Flatplanner workflow from the Publication Planner, follow these steps:

1. Inthe Tree, expand the Publication hierarchy, and then select the relevant Publication or Section.

2. Onthe Publication Planner tab, click the plus + sign next to the relevant Section to view the Planned Pages
within the Section.

3. Right click the relevant spread(s) and click Stop Workflows.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 217



Publication Section

“ Plan ]I Plan Motes “ Financial
-~

Set page template
Remave Pages

View Plan

Assign Pages
Start Workflows
| Stop Workflows |
Return task to default group assignment

4. The Stop Workflows dialog appears. Click Yes.

5. The spread is now removed from the workflow.

Method 2 - Tree

Column View: | Default E
Thumbnail > [Name > |Page Number * [Status >[I [Ac
e | | I
' = K Add Section In

> Napkins B Create new Section from existing... S

Add Pages Before Selected Page

Add Pages After Selected Page/Section
> Autonumber Pages 5t
> N

StiboSystems

To manually remove a Planned Page from a Flatplanner workflow from the Tree, follow these steps:

Navigate to the Planned Page(s) that you would like to remove from the workflow.

Right-click and select Remove from STEP Workflow.

In the Remove from STEP Workflow dialog, select the workflow that the spread is in, then click OK.
(Typically, spreads are only in one workflow.) Optionally, you may also add a Process Note.

E] Remove from STEP Workflow @

| (@) Fiatplanner Workfiow [startedi ‘

Process Note

[ OK H Cancel ]

4. The spread is now removed from the workflow.
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Publication Milestones

The Component Model Publishing - Milestone Settings enables monitoring of Flatplan workflow progress in
the Publication Planner via the Next Milestone Date/Next Milestone Name and Traffic Light Name columns.

The model allows you to:

« Select the object types where milestone dates can be entered—normally publication but can also be
publication section and publication group

« Select the object types where traffic lights can be defined—normally publication group

« Select the attribute that is used to hold the date when the workflow starts and up to 20 additional attributes to
hold the subsequent milestone dates

« Up tofive traffic light colors can be defined—each of which requires a numeric attribute to store the
'percentage of working time remaining' and a second attribute to store the traffic light color

Component Model 'Publishing - Milestone Settings' Example

Milestone date and period / color configuration in Publication with Milestones component model

Name Example Value Validation Type

Publication Types defining milestone dates | Publication

Publication Types defining traffic lights Publication Group

Workflow Start Start Date ISO Date and Time

Milestone Date #01 Attribute Plan Page ISO Date and Time

Milestone Date #02 Attribute Plan Approved ISO Date and Time

Milestone Date #03 Attribute DTP Page Approved ISO Date and Time

Period #01 Normal Period Number

Period #01 Colour Normal Colour Regular Expression: [0-9a-f]{6}
Period #02 Warning Period Number
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Milestone date and period / color configuration in Publication with Milestones component model

Name Example Value Validation Type

Period #02 Colour Warning Colour Regular Expression: [0-9a-f]{6}
Period #03 Late Period Number

Period #03 Colour Late Colour Regular Expression: [0-9a-f|{6}

For more information on regular expression, see the Regular Expression topic in System Setup / Super User
Guide documentation.

The other configuration option that effects the milestones is the definition of the working week. Unless modified the
default setting is Monday to Friday from 09:00 to 17:00. Please contact Stibo if you need another definition of a
working week. When entering the milestone dates for a publication it is advisable that they are set to be during
working time.

Milestone Configuration Example on Publication Level

The attributes that are configured in the Component Model 'Publishing - Milestone Settings' must have values on
publication group, publication, or section level. The example below shows how the attributes might be configured
for a particular publication.

Attribute values at a publication

Attribute Example value Description
Start Date 2013-08-20 09:00:00 | Tuesday
Plan Page 2013-09-02 09:00:00 | Monday
Plan Approved 2013-09-10 09:00:00 | Tuesday

DTP Page Approved | 2013-09-20 09:00:00 | Friday

Normal Period 100 If the remaining working time is 100% then...

Normal Colour 'green’ ... the traffic light is green
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Attribute values at a publication

Attribute Example value Description

Warning Period 40 If the remaining working time is 40% then...
Warning Colour ‘amber’ ... the traffic light is amber

Late Period 0 If the remaining working time is 0% then...
Late Colour red’ ... the trafficlight is red

The milestone and traffic light information shown in the Publication Planner for a given page is calculated in the
following way:

« The workflow variable MILESTONE contains the Attribute ID of the next milestone date applicable to that
flatplan workflow. This variable is set by the business rules attached to the states within the workflow.

« The name of this attribute is displayed in the Next Milestone Name column of the Publication Planner

« The Next Milestone date is the value of the attribute obtained from the first publication/publication group
above the Flatplan with a value.

« The duration of the current task is then calculated as the amount of working time between the next milestone
date and the milestone prior to that date.

» The amount of remaining working time is then calculated as the difference between the next milestone date
and the current date and time.

« The percentage of remaining time is the amount of remaining working time as a percentage of the duration of
the current task. This can be greater than 100% and can also be negative if the next milestone date is in the
past.

« The traffic light is selected based on the percentage of remaining working time. From the above example:
percentages of 0% or less will show as red, 40% to 1% as amber, and everything else as green.

« The Traffic Light Name is the name of the attribute defining the traffic light color.

Monitoring of Flatplan workflow progress in the Publication Planner Example

Assuming that a publication has been created with the example dates and colors shown in the table above, and
that the current time is Friday 2013-09-06 09:00:00, then this is how the traffic light colors would be calculated.
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Flatplan page-workflow and traffic light status with current date/time 2013-09-06 09:00:00

Page Workflow Colour Explanation
MILESTONE
1 Plan page red’ The next milestone date is (Plan Page) 2013-09-02
09:00:00

The previous milestone date is (Start Date) 2013-08-20
09:00:00

The duration of the current task is therefore 8 working days

The current date/time exceeds (Plan Page) 2013-09-02

09:00:00 by 6 working days.
-6 as a percentage of 8 is -78% and so the corresponding
coloris 'red'
2-3 DTP Page 'green’ The next milestone date is (DTP Page Approved) 2013-09-
approved 20 09:00:00

The previous milestone date is (Plan Approved) 2013-09-10
09:00:00

The duration of the current task is therefore 8 working days

There are 10 working days from the current date/time until
the next milestone date

10 as a percentage of 8 is 125% and so the corresponding
coloris 'green’

4-5 Plan Approved | 'amber The next milestone date is (Plan Approved) 2013-09-10
09:00:00

The previous milestone date is (Plan Page) 2013-09-02
09:00:00

The duration of the current task is therefore 6 working days

There are 2 working days from the current date/time until
the next milestone date

2 as a percentage of 6 is 33% and so the corresponding
color is 'amber’
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